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บทคัดยอ 
 
  การวิจัยเรื่อง องคประกอบท่ีมีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
ครั้งนี้ โดยมีวัตถุประสงคเพื่อ 1) เพื่อศึกษาความสัมพันธระหวางสมรรถภาพทางสมอง แรงจูงใจ
ภายในของตนเอง ลักษณะนิสัย และการรับรูความสามารถของตนเองกับความสามารถในการเรียน
วิชาคอมพิวเตอรกราฟกส และ 2) เพื่อสรางสมการพยากรณความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกส ของนักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัย
เทคโนโลยีราชมงคลพระนคร กลุมตัวอยางไดแก นักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรม
คอมพิวเตอร มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน ซึ่งไดมาโดยการสุมกลุม
ตัวอยางแบบเจาะจง (Purposive Sampling) เครื่องมือท่ีใชในการเก็บรวบรวมขอมูลในครั้งนี้
ประกอบดวย 1) แบบทดสอบสมรรถภาพทางสมอง 2) แบบวัดแรงจูงใจภายในของตนเอง 3) แบบ 
ทดสอบวัดลักษณะนิสัย 4) แบบวัดการรับรูความสามารถของตนเอง และ 5) แบบทดสอบวัดความ 
สามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส สถิติท่ีใชในการวิเคราะหขอมูล ไดแก คาเฉล่ีย คา
รอยละ สวนเบ่ียงเบนมาตรฐาน และการวิเคราะหคาสัมประสิทธิ์สหสัมพันธแบบพหุคูณ ผลการวิจัย
พบวา 
 1. ตัวแปรท่ีสัมพันธทางบวกกับความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสของ
นักศึกษา อยางมีนัยสําคัญทางสถิติท่ีระดับ .01 ยกเวนการรับรูความสามารถของตนเองท่ีไมมี
ความสัมพันธกับความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
  2. ตัวแปรพยากรณท่ีดีกับตัวแปรเกณฑโดยใชการทดสอบเอฟ (F-test) ท่ีมีนัยสําคัญทางสถิติ
ท่ีระดับ .01 อยู 3 ดาน คือ การรับรูความสามารถของตนเอง สมรรถภาพทางสมองดานมิติสัมพันธ 
และสมรรถภาพทางสมองดานภาษา โดยมีอํานาจในการพยากรณความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกสได และตัวแปรเกณฑท่ีมีนัยสําคัญทางสถิติท่ีระดับ  .05  อยู  1  ดาน คือ 
สมรรถภาพทางสมองดานความจํา   
  3. ตัวพยากรณท้ังหมดมีอํานาจในการพยากรณไดรอยละ 16.10 มีคาสัมประสิทธิ์สหสัมพันธ
พหุคูณเทากับ .402 คาความคลาดเคล่ือนมาตรฐานในการพยากรณ เทากับ  9.985 คาคงท่ีของ
สมการพยากรณในรูปคะแนนดิบเทากับ -2.623 และไดสมการพยากรณพยากรณในรูปคะแนนดิบ
และคะแนนมาตรฐาน  ดังนี้ 
 สมการในรูปคะแนนมาตรฐาน 
   Y  =  .206X14 + .227X4 + .171X1 - .052X5 – 2.623 

สมการในรูปคะแนนดิบ 
  Z  =  .192ZX14 + .207ZX4 + .165ZX1 - .115ZX5  
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บทที่ 1 
บทนํา 

 
ความเปนมาและความสําคัญของปญหา 
  การศึกษาในกลุมคอมพิวเตอร เปนกลุมวิชาท่ีความหลากหลายและมีการเปล่ียนแปลงตาม
เทคโนโลยีและความตองการของสังคมอยางรวดเร็ว ครอบคลุมท้ังดานทฤษฎีและปฏิบัติต้ังแต
ฮารดแวร ซอฟตแวร เครือขาย ขอมูล และบุคลากรดานคอมพิวเตอร กลุมวิชาชีพดังกลาวจึงเปนอีก
สาขาหนึ่งท่ีมีกําหนดมาตรฐานผลการเรียนรูของผูเรียน เพื่อใหความมั่นใจแกสังคมไดวา ผูเรียนทุกคน
มีความรูความสามารถท่ีเพียงพอในการทํางานอยางมีประสิทธิภาพและประสิทธิผล โดยการสอนควร
เปนไปในลักษณะท่ีเนนผูเรียนเปนสําคัญ มีการบรรยายถึงเนื้อหาหลักของแตละวิชาและแนะนําให
ผูเรียนทําการคนควาหรือทําความเขาใจประเด็นปลีกยอยดวยตนเอง นอกจากนี้ การสอนควรเนนการ
ไดมาซึ่งทฤษฎีและกฎเกณฑตาง ๆ ในเชิงวิเคราะห และช้ีใหเห็นความสัมพันธระหวางทฤษฎีกับ
ปรากฏการณตาง ๆ ในธรรมชาติ ใหผูเรียนไดทําการทดลองปฏิบัติการจริงและมีโอกาสใชเครื่องมือ
ดวยตนเอง ในกระบวนการเรียนการสอน มีการมอบหมายงานเพื่อใหผูเรียนไดมีการฝกฝนทักษะดาน
ตาง ๆ รูจักวิเคราะหและแกปญหาดวยตนเอง (กระทรวงศึกษาธิการ, 2552: 13) 
 วิชาคอมพิวเตอรกราฟกสเปนอีกหนึ่งวิชาท่ีมีความสําคัญในกลุมวิชาคอมพิวเตอร เนื่องจาก
เปนวิชาท่ีผูเรียนสามารถนําความรูเกี่ยวกับฮารดแวร ข้ันตอนวิธี และซอฟตแวรของคอมพิวเตอร
กราฟกส การสรางเสน การแปลงรูปสองมิติและสามมิติ เทคนิค การดัดสวนเกินของเสนและรูปหลาย
เหล่ียมตางๆ การมองภาพในระบบ สามมิติ การแทนเสนโคงและพื้นผิวแบบจําลองทรงตัน พื้นผิวแฝง 
การใหแสงและการแรเงา ธรรมชาติของสี เรยเทรสซิ่ง การสรางภาพเคล่ือนไหว (หลักสูตรครุศาสตร
อุตสาหกรรมบัณฑิต แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร, 
2550) เพื่อท่ีจะนําความรูและกฎเกณฑตาง ๆ ไปใชใหเกิดประโยชนในชีวิตประจําวันใหมากท่ีสุด 
และเพื่อเปนพื้นฐานท่ีจะเลือกเรียนวิชาคอมพิวเตอรช้ันสูงตอไป ซึ่งในการจัดการเรียนการสอน
เกี่ยวกับพื้นฐานทางการศึกษาวิชาคอมพิวเตอรกราฟกสนี้ ยืน ภูวรรณ (2533: 118 -120) กลาววา 
การศึกษาทางดานคอมพิวเตอร ผูเรียนตองใหความสนใจวิชาท่ีมีคณิตศาสตรเกี่ยวของโดยตรง เชน 
วิชาเรขาคณิตวิเคราะหท่ีกลาวถึง รูปสองมิติ สามมิติ การหมุนของรูป การเปล่ียนรูป และทฤษฎีความ
นาจะเปนพื้นฐาน เปนตน นอกจากนี้การท่ีจะเปนนักคอมพิวเตอรกราฟกสท่ีดีก็จะตองศึกษาทางดาน
วิชาอื่น ๆ อีก เชน วิชาการใชทักษะทางภาษา ซึ่งผู เรียนตองเรียนรูการสรางทักษะในการ
ติดตอส่ือสารกับบุคคลกลุมตาง ๆ ควรมีความสามารถในการเขียน และจัดทําเอกสารท่ีเกี่ยวของกับ
งานคอมพิวเตอรนอกเหนือจากการเขียนโปรแกรม และท่ีสําคัญคือทักษะในการนําเสนอดวยวาจา 
(Oral Presentation)  
  แตอยางไรก็ตามในการใหการศึกษา ควรคํานึงถึงความแตกตางระหวางบุคคลเปนสําคัญ 
เชน ความแตกตางดานสมรรถภาพสมอง (Mental Ability) บุคลิกภาพ (Personality) เจตคติ 
(Attitude) ตลอดจนความสนใจและพฤติกรรมดานอื่น ๆ (Bingham, 1937: 25-26) ดังนั้น นักเรียน
แตละคนจะเลือกเรียนรู หรือศึกษาวิชาใดวิชาหนึ่งนั้น จะตองคํานึงถึงความสามารถทางสติปญญา
หรือความถนัดของตนเองเปนประการสําคัญ  
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 จากเหตุผลดังกลาวมาแลว ผูวิ จัยจึงมีความสนใจท่ีศึกษาองคประกอบท่ีมีสงผลตอ
ความสามารถในการเรียนวิชาคอมพวิเตอรกราฟกส โดยมุงศึกษาดานสมรรถภาพทางสมอง ลักษณะ
นิสัย แรงจูงใจภายในของตนเอง และการรับรูความสามารถของตนเอง เพื่อนําผลท่ีไดไปเปนแนวทาง
ในการจัดการเรียนการสอนวิชาคอมพิวเตอรกราฟกส ซึ่งจะทําใหนักเรียนมีทักษะทางการเขียน
โปรแกรมคอมพิวเตอร ทักษะทางดานความคิดมากยิ่งข้ึน สามารถนําความรูไปใชเปนพื้นฐานในการ
เขาศึกษาตอในระดับสูงตอไป หรือการเลือกอาชีพในอนาคต และยังเปนการนําไปสูการพัฒนา
บุคลากรทางดานคอมพิวเตอรตอไป 
 
วัตถุประสงคของการวิจัย 
 1. เพื่อศึกษาความสัมพันธระหวางสมรรถภาพทางสมอง ลักษณะนิสัย แรงจูงใจภายในของ
ตนเอง และการรับรูความสามารถของตนเองกับความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
 2. เพื่อสรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส ของ
นักเรียนสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร  
 
ขอบเขตของการวิจัย 
 1. ดานประชากรและกลุมตัวอยาง 
 1.1 ประชากร ไดแก นักศึกษาสาขาวิชาไฟฟา คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัย
เทคโนโลยีราชมงคลพระนคร จํานวน 200 คน 
 1.2 กลุมตัวอยาง เปนนักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะ       
ครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ภาคเรียนท่ี 2 ปการศึกษา 2555 
ซึ่งไดมาโดยการสุมกลุมตัวอยางแบบเจาะจง (Purposive Sampling)  
 2. ตัวแปรท่ีศึกษา แบงออกเปน 2 ประเภท ดังนี ้
  2.1 ตัวแปรอิสระ (Independent Variables) มี 4 ตัว ดังนี ้
  1. สมรรถภาพทางสมอง มี 7 ดาน ไดแก 
   - ดานภาษา 
   - ดานการใชคํา 
   - ดานตัวเลข 
   - ดานมิติสัมพันธ 
   - ดานความจํา 
   - ดานการสังเกตรับรู 
   - ดานเหตุผล 
  2. ลักษณะนิสัย มี 5 ดาน ไดแก 
   - ดานความมีวินัย 
   - ดานความอดทน 
   - ดานความกระตือรือรน 
   - ดานความต้ังใจ 
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   - ดานความรับผิดชอบ 
  3. แรงจูงใจภายในของตนเอง 
  4. การรับรูความสามารถของตนเอง 
 2.2 ตัวแปรตาม (Dependent Variables) ไดแก ความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส 
 
นิยามศัพทเฉพาะ 
  1. สมรรถภาพทางสมอง (Mental Ability) หมายถึง ความสามารถของบุคคลท่ีแสดงออกมา
จากการไดรับประสบการณ หรือการเรียนรูและมีการส่ังสมไวมากจนเกิดเปนทักษะพิเศษท่ีเดนชัด 
และพรอมท่ีจะแสดงออกมาไดอยางมีประสิทธิภาพและชัดเจน ซึ่งสมรรถภาพทางสมองมี 7 ดาน 
ไดแก 
   1. ดานภาษา (Verbal Abilities) หมายถึง ความสามารถดานความเขาใจในศัพท
ขอความหรือเรื่องราวตาง ๆ และเลือกใชภาษาในการส่ือสารความหมายไดอยางถูกตองและเหมาะสม 
  2. ดานการใชคํา (Word Fluency Abilities) หมายถึง ความสามารถในการเรียงคํา
ท่ีกําหนดใหข้ึนมาใหม เพื่อใหขอความมีความถูกตองเหมาะสม 
  3. ดานตัวเลข (Number Abilities) หมายถึง ความสามารถของบุคคลในการ
พิจารณาหาความสัมพันธของกลุมตัวเลขอนุกรมแตละชุดท่ีเรียงกันไวอยางมีระบบไดอยางถูกตอง 
และรวดเร็ว 
  4. ดานมิติสัมพันธ (Space Abilities) หมายถึง ความคิดในการสรางจินตนาการให
เห็นสวนยอย และสวนผสมของวัตถุตาง ๆ สามารถหาความสัมพันธของรูปทรงเมื่อเปล่ียนตําแหนง
หรือหมุนภาพนั้นไปจากเดิม 
  5. ดานความจํา (Memory Abilities) หมายถึง ความสามารถในการระลึกหรือ
จดจําเหตุการณหรือเรื่องราวตาง ๆ ไดอยางแมนยํา ถูกตอง 
  6. ดานการสังเกตรับรู (Perceptual Abilities) หมายถึง ความสามารถดานการ
มองเห็นความรายละเอียดความเหมือนหรือความแตกตางระหวางตัวเลข ตัวอักษรตาง ๆ อยาง
รวดเร็วและถูกตอง 
  7. ดานเหตุผล (Reasoning Abilities) หมายถึง ความคิดอยางมีวิจารณญาณแลว
สามารถจัดประเภท เปรียบเทียบอุปมาอุปไมย และสรุปความไดอยางถูกตอง 
 2. ลักษณะนิสัย (Habits) หมายถึง พฤติกรรมตาง ๆ ท่ีบอกถึงแนวโนมท่ีตอบสนองตอ
ความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส ซึ่งลักษณะนิสัย มี 5 ดาน ไดแก 
  1. ดานความมีวินัย (Discipline Habit) หมายถึง การแสดงพฤติกรรมตาม
กฎระเบียบขอตกลงท่ีกําหนดไว 
  2. ดานความอดทน (Restrain Habit) หมายถึง ความสามารถของรางกาย ความคิด
และจิตใจท่ีทนตอการปฏิบัติกิจกรรมตาง ๆ ได เชน การทํางานทุกอยางใหสําเร็จโดยไมคํานึงถึง
อุปสรรค 
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  3. ดานความกระตือรือรน (Enthusiastic Habit) หมายถึง พฤติกรรมท่ีบอกถึง
ความคลองแคลววองไว ความเอาใจใสตอกิจกรรมตาง ๆ ท่ีตองทํา 
  4. ดานความต้ังใจ (Bedetermined Habit) หมายถึง ความมุงมั่นท่ีผลักดันให
บุคคลพยายามประกอบกิจกรรมอยางใดอยางหนึ่ง เพื่อใหบรรลุจุดมุงหมายท่ีต้ังใจไว เชน การทํางาน
อยางเปนระเบียบ 
  5. ดานความรับผิดชอบ (Plead Guilty Habit) หมายถึง ลักษณะของบุคคลท่ีแสดง
ถึงความเอาใจใส จดจอและรับเปนภาระตอหนาท่ีการงาน การดําเนินชีวิต การเปนอยูของตนเอง 
และผูอยูในความดูแลตลอดจนสังคม พยายามทําหนาท่ีตาง ๆ อยางเต็มความสามารถ 
  3. แรงจูงใจภายในของตนเอง (Intrinsic Motivation) หมายถึง ความตองการ และความพึง
พอใจของบุคคลท่ีแสดงพฤติกรรมตาง ๆ ท่ีเกิดข้ึนจากการเสาะแสวงหาของตนเอง โดยปจจัยท่ีซอน
เรนอยูภายในงาน เชน งานท่ีนาสนใจ แปลกใหมและทาทาย เปนแรงผลักดัน ไมตองอาศัยรางวัล
ภายนอก หรือกฎเกณฑภายนอกเปนขอบังคับ 
 4. การับรูความสามารถของตนเอง (Self Efficacy) หมายถึง การท่ีบุคคลรูถึงความสามารถ
ของตนเองวามีความสามารถในการ  วางแผน  ระบบการทํางาน  องคประกอบของคอมพิวเตอร
กราฟก  การผลิตและการเผยแพรผลงานคอมพิวเตอรกราฟก 
 5. ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส หมายถึง ความสามารถของบุคคลใน
การ วางแผน  ระบบการทํางาน  องคประกอบของคอมพิวเตอรกราฟก  การผลิตและการเผยแพร
ผลงานคอมพวิเตอรกราฟก 
 
ประโยชนท่ีคาดวาจะไดรับ 
 1. ทราบองคประกอบท่ีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส เพื่อนําไป
พัฒนาการจัดการเรียนการสอนวิชาคอมพิวเตอรกราฟกส และเปนคุณลักษณะท่ีพึงประสงคในการรับ
นักศึกษาเขาศึกษาตอในระดับปริญญาตรี แขนงวิชาวิศวกรรมคอมพิวเตอร   
  2.  ผูสอนวิชาคอมพิวเตอรกราฟกส สามารถนําองคประกอบตาง ๆ ไปออกแบบและหรือ
พัฒนาชุดการเรียนการสอนใหมีประสิทธิภาพมากยิ่งข้ึน เหมาะสมกับคุณลักษณะของผูเรียน   
 
 
  
 
 
 
 
 



บทที่ 2 
เอกสาร ตาํราและงานวิจยัที่เก่ียวของ 

 
การวิจัยเรื่อง องคประกอบท่ีมีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 

ผูวิจัยไดศึกษา คนควา เอกสาร แนวคิดทฤษฎี และงานวิจัยท่ีเกี่ยวของ โดยนําเสนอเปนหัวขอดังนี้ 
1. สมรรถภาพทางสมอง 
2. ลักษณะนิสัย 
3. แรงจูงใจภายในของตนเอง 
4. การรับรูความสามารถของตนเอง 
5. งานวิจัยท่ีเกี่ยวของ 
6. กรอบแนวความคิด 

 
สมรรถภาพทางสมอง 
  ความหมายของสมรรถภาพทางสมอง 
  นักจิตวิทยาและนักการศึกษาหลายทานไดใหความหมายของสมรรถภาพทางสมอง (Mental 
Ability) ไวหลายประการ ดังนี ้
  ฟรีแมน (Freeman, 1966: 431) ไดใหความหมายวาเปนผลของคุณลักษณะตาง ๆ ท่ีใหเห็น
ความสามารถของแตละคนในการท่ีไดมาซึ่งความรู ทักษะ หรือการตอบสนอง 
 ครอนบัช (Cronbach, 1970: 200) ไดใหความหมายวา เปนกลุมความสามารถทางสมองท่ี
รวมกันทํางานเพื่อเพิ่มพูนความสําเร็จในกิจกรรมทางปญญา 
 บาวน (Brown, 1970 อางใน ลวน สายยศ และอังคณา  สายยศ, 2541: 15) ใหนิยามวา 
เปนพลังงานในการเรียนรูท่ีทํางานหนักได และยังเปรียบเทียบวา ความสามารถ (Ability) เกี่ยวของ
กับสภาพปจจุบัน และการมองภาพในอนาคต 
 สโนว (Snow, 1980 อางใน ลวน สายยศ และอังคณา  สายยศ, 2541: 15) มองวาเปน
โครงสรางและเปนคุณลักษณะทางจิตวิทยาของแตละบุคคลท่ีมีความโนมเอียงในการพยากรณความ
แตกตางของส่ิงท่ีเรียนรูมาแลว ภายใตเงื่อนไขการเรียนการสอนเฉพาะอยาง 
 ชลา แพรัตกุล (2543: 1) ไดใหความหมายของสมรรถภาพทางสมองวา เปนขีดระดับ
ความสามารถข้ันสูงสุดของบุคคล ท่ีเขาอาจมีไดตอการเรียนรู และฝกฝนในวิทยาการตลอดจนทักษะ
ตาง ๆ ถาหากเขาไดรับการฝกและไดรับประสบการณท่ีเหมาะสม นอกจากนี้ยังไดเสนอความหมาย
ของสมรรถภาพทางสมองไว 5 ประการ 
 1. สมรรถภาพทางสมองไมหมายถึงความรู คือ ไมตองการวัดวาเขาเรียนรูอะไรมาบางมาก
นอยเพียงใด แตตองการวัดวานักเรียนสามารนําเอาความรูมาแกปญหาเฉพาะหนาท่ีแตกตางไปจาม
เดิมหรือไม 
  2. สมรรถภาพทางสมองไมหมายถึงความเร็ว คือ มองท่ีความยุงยากของงานเปนหลักในการ
พิจารณาตัดสิน หมายความวา ถาใครสามารถทํางานท่ียากและซับซอนไดถูกตองมากก็เรียกเจาของ
สมองนั้นวาเปนคนฉลาดมาก 
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 3. สมรรถภาพทางสมองไมไดหมายถึงกรรมพันธุนั้น ไมไดหมายความวาลูกจะตองเกง และมี
ความสามารถทางสมองเหมือนพอแมเสมอไปพอแมบางคนมีการศึกษาดีแตลูกมีพัฒนาการทางสมอง
ตํ่าก็มี 
 4. สมรรถภาพทางสมองไมไดหมายถึงความสามารถเพียงดานเดียว เพราะสมองมนุษย
ประกอบดวยความสามารถหลาย ๆ ดานและความถนัดในดานใดก็ตาม นอกจากข้ึนอยูกับระดับ
ความสามารถแตละดานแลว ยังข้ึนอยูกับสัดสวนของความสามารถเหลานั้นดวย 
  5. สมรรถภาพทางสมองไมไดหมายถึงพรหมลิขิต นั่นคือ มนุษยเราสามารถหลอหลอฝกฝน
ความสามารถทางสมองของเราได สังเกตไดจากการเปล่ียนแปลงพฤติกรรมอุปนิสัยขณะเปนเด็กและ
ตอบเปนผูใหญ เปนตน 
 ลวน สายยศ และอังคณา  สายยศ (2541: 17-18) ไดใหความหมายไววา เปนความสามารถ
ท่ีบุคคลไดรับจากประสบการณในการฝกฝนตนเอง และมีการส่ังสมไวมากจนเกิดเปนทักษะพิเศษ 
แสดงเดนชัดดานใดดานหนึ่ง และพรอมท่ีจะปฏิบัติกิจกรรมดานนั้นเปนอยางดี 
 สามารถสรุปไดวา สมรรถภาพทางสมอง หมายถึง ความสามารถของบุคคลท่ีไดรับจาก
ประสบการณหรือการเรียนรู และไดมีการส่ังสมไวจนเกิดเปนทักษะพิเศษท่ีเดนชัด พรอมท่ีแสดงออก
เพื่อตอบสนองเฉพาะอยาง ซึ่งอาจถือวาเปนศักยภาพของบุคคลนั้น 
 ทฤษฎีสมรรถภาพทางสมอง 
  นักการศึกษาตางยอมรับกันวา การจัดการศึกษาท่ีดีตองคํานึงถึงความแตกตางระหวางบุคคล
เปนสําคัญ เพราะธรรมชาติของเด็กแตละคนมีบางส่ิงบางอยางแตกตางกัน เชน ความแตกตางดาน
สมรรถภาพสมอง  ทัศนคติ  ตลอดจนความสนใจ ซึ่งมีผลตอการเรียนร ู  การฝกฝนในวิทยาการและ
ทักษะตาง ๆ ของผ ูเรียนแตละคน (สุรศักด์ิ  อมรรัตนศักด์ิ อางในจิตวิทยาการศึกษา : 21) 
  1. ทฤษฎีเกี่ยวกับเชาวปญญาของการดเนอร 

แนวคิดเกี่ยวกับเชาวปญญา (Intelligences) ท่ีมีมาต้ังแตเดิมนั้น จํากัดอยูท่ีความสามารถ
ดานภาษา ความสามารถทางดานคณิตศาสตร และการคิดเชิงตรรกะหรือเชิงเหตุผลเปนหลัก การวัด
เชาวนปญญาของผูเรียนจะวัดจากคะแนนท่ีทําไดจากแบบทดสอบทางสติปญญา ซึ่งประกอบดวยการ
ทดสอบความสามารถท้ัง 2 ดานดังกลาว คะแนนจากการวัดเชาวปญญาจะเปนตัวกําหนดเชาวปญญา
ของบุคคลนั้นไปตลอด เพราะมีความเช่ือวา องคประกอบของเชาวนปญญาจะไมเปล่ียนแปลงไปตาม
วัยหรือประสบการณมากนัก แตเปนคุณลักษะท่ีติดตัวมาแตกําเนิด การดเนอร (Gardner, 1983 อาง
ใน ทิศนา แขมมณี, 2545 : 86) ใหนิยามคําวา “เชาวนปญญา” (Intelligence) ไววา หมายถึง
ความสามารถในการแกปญหาในสภาพแวดลอมตาง ๆ หรือการสรางสรรคผลงานตาง ๆ ซึ่งจะมี
ความสัมพันธกับบริบททางวัฒนธรรมในแตละแหง รวมท้ังความสามารถใจการต้ังปญหาเพื่อจะหา
คําตอบและเพิ่มพูนความรู การดเนอรมีความเช่ือพื้นฐานท่ีสําคัญ 2 ประการ คือ 

1. เชาวนปญญาของบุคคลมิไดมีเพียงความสามารถทางภาษาและทางคณิตศาสตรเทานั้น 
แตมีอยูอยางหลากหลายถึง 8 ประเภทดวยกัน ซึ่งเขาบอกวา ความจริงอาจจะมีมากกวานี้ คนแตละ
คนจะมีความสามารถเฉพาะดานท่ีแตกตางไปจากคนอื่น และมีความสามารถในดานตาง ๆ ไมเทากัน 
ความสามารถท่ีผสมผสานกันออกมา ทําใหบุคคลแตละคนมีแบบแผนซึ่งเปนเอกลักษณเฉพาะตน 
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2. เชาวนปญญาของแตละบุคคลจะไมอยูคงท่ีอยูท่ีระดับท่ีตนมีตอนเกิด สามารถเปล่ียน 
แปลงได หากไดรับการสงเสริมท่ีเหมาะสม 
  ในความคิดของการดเนอร เชาวนปญญาของบุคคลประกอบดวยความสามารถ 3 ประการคือ 

1. ความสามารถในการแกปญหาในสภาพการณตาง ๆ ท่ีเปนไปตามธรรมชาติและตามบริบท
ทางวัฒนธรรมของบุคคลนั้น 

2. ความสามารถในการสรางสรรคผลงานท่ีมีประสิทธิภาพและสัมพันธกับบริบททาง
วัฒนธรรม 

3. ความสามารถในการแสวงหาหรือต้ังปญหาเพื่อหาคําตอบและเพิ่มพูนความรู 
  เชาวปญญา 8 ดาน ตามแนวคิดของการดเนอร มีดังนี ้

1. เชาวนปญญาดานภาษา (Linguistic Intelligence) 
  เชาวนปญญาดานนี้ถูกควบคุมโดยสมองสวนท่ีเรียกวา “Broca’s Area” สติปญญาดานนี้
แสดงออกทางความสามารถในการอาน การเขียน การพูดอภิปราย การส่ือสารกับผูอื่น การใชคําศัพท 
การแสดงออกของความคิด การประพันธ การแตงเรื่อง การเลาเรื่อง เปนตน 

2. เชาวปญญาดานคณิตศาสตรหรือการใชเหตุผลเชิงตรรกะ (Logical Mathematical 
Intelligence)  

ผูท่ีมีอัจฉริยภาพดานการใชเหตุผลเชิงตรรกะ มักจะคิดโดยใชสัญลักษณ มีระบบระเบียบใน
การคิด ชอบคิดวิเคราะห แยกแยะส่ิงตาง ๆ ใหเห็นชัดเจน ชอบคิดและทําอะไรตามเหตุผล เขาใจส่ิงท่ี
เปนนามธรรมไดงาย ขอบและทําคณิตศาสตรไดดี 

3. สติปญญาดานมิติสัมพันธ (Spatial Intelligence) 
  เชาวนปญญาดานนี้ถูกควบคุมโดยสมองซีกขวา และแสดงออกทางความสามารถดานศิลปะ 
การวาดภาพ การสรางภาพ การคิดเปนภาพ การเห็นรายละเอียด การใชสี การสรางสรรคงานตาง ๆ 
และมักจะเปนผูมองเห็นวิธีแกปญหาในมโนภาพ 

4. เชาวนปญญาดานดนตรี (Musical Intelligence) 
  เชาวนปญญาดานนี้ถูกควบคุมโดยสมองซีกขวา แตยังไมสามารถระบุตําแหนงท่ีแนนอนได
บุคคลท่ีมีสติปญญาทางดานนี้ จะแสดงออกทางความสามารถในดานจังหวะ การรองเพลง การฟง
เพลงและดนตรี การแตงเพลง การเตน และมีความไวตอการรับรูเสียงและจังหวะตาง ๆ 

5. เชาวนปญญาดานการ เค ล่ือน ไหวร างกายและกล าม เนื้ อ  (Bodily-Kinesthetic 
Intelligence) 
  เชาวนปญญาดานนี้ถูกควบคุมโดยสมองสวนท่ีเรียกวาคอรเท็กซ โดยดานซายควบคุมการ
เคล่ือนไหวของรางกายซีกขวา และดานขวาควบคุมการเคล่ือนไหวของรางกายซีกซาย สติปญญา
ทางดานนี้สังเกตไดจากความสามารถในการเคล่ือนไหวรางกาย เชน ในการเลนกีฬา และเกมตาง ๆ 
การใชภาษาทาทาง การแสดง การเตนรํา ฯลฯ 

6. เชาวนปญญาดานการสัมพันธกับผูอื่น (Interpersonal Intelligence) 
  เชาวปญญาดานนี้ถูกควบคุมโดยสมองสวนหนา ความสามารถท่ีแสดงออกทางดานนี้ เห็นได
จากการปฏิสัมพันธกับผูอื่น การทํางานกับผูอื่น การเขาใจและเคารพผูอื่น การแกปญหาความขัดแยง 
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และการจัดระเบียบ ผูมีความสามารถทางดานนี้ มักเปนผูท่ีมีความไวตอความรูสึกและความตองการ
ของผูอื่น 

7. เชาวปญญาดานการเขาใจตนเอง (Intrapersonal Intelligence) 
  บุคคลท่ีสามารถในการเขาใจตนเอง มักเปนคนท่ีชอบคิด พิจารณาไตรตรอง มองตนเอง และ
ทําความเขาใจถึงความรูสึกและพฤติกรรมของตนเอง มักเปนคนท่ีมั่นคงในความคิดความเช่ือตาง ๆ 
จะทําอะไรมักตองการเวลาในการคิดไตรตรอง และชอบท่ีจะคิดคนเดียว ชอบความเงียบสงบ 
สติปญญาทางดานนี้ มักเกิดรวมกับสติปญญาดานอื่น มีลักษณะเปนปฏิสัมพันธระหวางเชาวปญญา 
อยางนอย 2 ดานข้ึนไป 

8. เชาวนปญญาดานความเขาใจธรรมชาติ (Naturalist Intelligence) 
  เชาวนปญญาดานนี้เปนความสามารถในการสังเกตส่ิงแวดลอมทางธรรมชาติ การจําแนก
แยกแยะ จัดหมวดหมู ส่ิงตาง ๆ รอบตัว บุคคลท่ีมีความสามารถทางนี้ มักเปนผูรักธรรมชาติ เขาใจ
ธรรมชาติ ตระหนักในความสําคัญของส่ิงแวดลอมรอบตัว และมักจะชอบและสนใจสัตว ชอบเล้ียง
สัตวเล้ียง เปนตน 
  เนื่องจากเชาวปญญาแตละดานถูกควบคุมโดยสมองสวนตาง ๆ กัน ดังนั้นหากสมองสวนใด
ถูกทําลาย ความสามารถในดานท่ีสมองสวนนั้นควบคุมก็จะไดรับความกระทบกระเทือนหรือเสียไป
ดวย สําหรับสมองสวนท่ีไมถูกทําลาย ความสามารถในสวนท่ีสมองนั้นควบคุมก็จะยังเปนปกติ อยางไร
ก็ตาม เชาวนปญญาแตละดานไมไดทํางานแยกจากกัน แตมักจะทํางานในลักษณะผสมผสานกันไป
แลวแตกิจกรรมท่ีทําอยูวาตองการสติปญญาสวนใดบาง การดเนอรเช่ือวา ในการกระทําอยางใดอยาง
หนึ่ง แมจะดูเหมือนวา ใชเชาวปญญาดานหนึ่งดานใดอยางชัดเจน แตแทจริงแลวตองอาศัยเชาวน
ปญญาหลาย ๆ ดานผสมผสานกัน เชน นักดนตรีท่ีประสบความสําเร็จ แมจะดูเหมือนวาตองอาศัย
เชาวนปญญาดานดนตรี แตจริง ๆ แลว การประสบความสําเร็จ ยังอาจตองอาศัยเชาวนปญญาดาน
การสัมพันธกับผูอื่น ดานภาษา และดานการเขาใจตนเองดวย 
  2. ทฤษฎีโครงสรางสมรรถภาพทางสมอง 
2  กิลฟอรด (Guilford, 967) นักจิตวิทยาชาวอเมริกันไดศึกษาโครงสรางสมรรถภาพทางสมอง
โดยเนนเรื่องความคิดสรางสรรค ความมีเหตุผลและการแกปญหา จนไดแบบจําลองโครงสรางสมรรถ 
ภาพทางสมองดังภาพท่ี 1   
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21ภาพท่ี 1 รูปแบบโครงสรางสมรรถภาพทางสมองของกิลฟอรด 
 

2  รูปแบบโครงสรางสมรรถภาพทางสมองของกิลฟอรดเปนระบบสามมิติประกอบดวย  
   1. มิติทางดานเนื้อหาการคิด21 (contents) หมายถึงวัตถุหรือขอมูลตาง ๆ ท่ีรับรู ใช
เปนส่ือกอใหเกิดการคิด เนื้อหาแบงเปน 5 ชนิด คือ  

• 4เนื้อหาท่ีเปนภาพ (figural content) หมายถึง ขอมูลหรือส่ิงเราท่ีเปน
รูปธรรมตาง ๆ บุคคลสามารถรับรูไดดวยประสาทสัมผัส  

• 4เนื้อหาท่ีเปนเสียง (auditory content) หมายถึงส่ิงท่ีอยูในรูปของเสียงท่ีมี
ความหมาย  

• 3เนื้อหาท่ีเปนสัญลักษณ(symbolic content) หมายถึงขอมูลหรือส่ิงเราท่ี
อยูในรูปเครื่องหมายตาง ๆ เชน ตัวอักษร ตัวเลข รวมท้ังสัญลักษณตาง ๆ  

• 4เนื้อหาท่ีเปนภาษา (semantic content) หมายถึง ขอมูลหรือส่ิงเราท่ีอยู
ในรูปถอยคําท่ีมีความหมายตาง ๆ กัน สามารถใชติดตอส่ือสารได  

• 4เนื้อหาท่ีเปนพฤติกรรม (behavior content) หมายถึงขอมูลท่ีเปนการ
แสดงออกของมนุษย เจตคติ ความตองการ รวมถึง ปฏิสัมพันธระหวาง
บุคคล การกระทําท่ีสามารถสังเกตได  

   2. มิติดานวิธีการคิด 2 1 (operations) หมายถึงกระบวนการคิดตางๆ ท่ีสรางข้ึน 
ประกอบดวยความสามารถ 5 ชนิด ดังนี้  

• 4การรูและการเขาใจ(cognition) เปนความสามารถทางสติปญญาของ
มนุษยในการรับรูและทําความเขาใจ  

• 3การจํา(memory) เปนความสามารถทางสติปญญาของมนุษยในการเก็บ
สะสมความรูและขอมูลตาง ๆ และสามารถระลึกไดเมื่อตองการใช  

http://www.bsru.ac.th/study/decision/%E0%B8%9A%E0%B8%97%E0%B9%80%E0%B8%A3%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B8%84%E0%B8%B4%E0%B8%94%E0%B8%9A%E0%B8%97%E0%B8%97%E0%B8%B5%E0%B9%88%201/%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B8%84%E0%B8%B4%E0%B8%94%E0%B8%9A%E0%B8%97%E0%B8%97%E0%B8%B5%E0%B9%88%201.htm
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• 3การคิดแบบอเนกนัย(divergent thinking) เปนความสามารถในการคิด
คลองและคิดหลากหลาย นั่นคือสามารถท่ีจะคิดในเรื่องใดเรื่องหนึง่ หรือใน
สถานการณใดสถานการณหนึ่ง ใหไดผลของการคิดจํานวนมาก รวดเร็ว 
ตรงประเด็น หรือหลายรูปแบบ และเปนความสามารถในการคิดริเริ่ม ซึ่ง
เปนการคิดท่ีมีลักษณะหรือมุมมองใหม ๆ  

• 4การคิดแบบเอกนัย (convergent thinking) เปนความสามารถในการสรุป
คําตอบท่ีดีท่ีสุด ถูกตองท่ีสุด จากขอมูลหรือส่ิงเราท่ีมีหลากหลาย  

• 3การประเมินคา(evaluation) เปนความสามารถทางสติปญญาในการตัดสิน
ส่ิงท่ีรับรู จําได หรือกระบวนการคิดนั้นวามีคุณคา ถูกตอง เหมาะสม 
หรือไมโดยอาศัยเกณฑท่ีดีท่ีสุด  

   3. มิติดานผลของการคิด 2 1 (products) หมายถึงความสามารถท่ีเกิดจากการ
ผสมผสานมิติดานเนื้อหาและดานปฏิบัติการเขาดวยกันเปนผลผลิต เมื่อสมองรับรูจากส่ิงเราทําใหเกิด
การคิดในรูปแบบตาง ๆ กัน ซึ่งผลท่ีไดแบงเปน 6 ชนิดคือ  

• 3หนวย (unit) หมายถึงส่ิงท่ีมีลักษณะเฉพาะแตกตางไปจากส่ิงอื่นๆ เชนโตะ 
ตู เสือ เปนตน  

• 3จําพวก(class) หมายถึง ประเภทหรือกลุมของหนวยท่ีมีลักษณะรวมกัน 
เชน สัตวเล้ียงลูกดวยนม ไดแก คน สุนัข แมว เปนตน  

• 3ความสัมพันธ(relation) หมายถึง ผลของการเช่ือมโยงความคิดของ
ประเภทหรือหลายประเภทเขาดวยกัน เชน สิงโตคูกับปา ปลาคูกับน้ํา เปน
ความสัมพันธระหวางส่ิงมีชีวิตกับท่ีอยูอาศัย  

• 3ระบบ (system) หมายถึง การเช่ือมโยงกลุมของส่ิงเรา โดยอาศัยกฎเกณฑ
หรือแบบแผนบางอยาง เชน 2 , 4, 6, 8 เปนระบบเลขคู  

• 3การแปลงรูป (transformation) หมายถึง การเปล่ียนแปลง ปรับปรุง 
ตีความ ขยายความ ใหนิยามใหม  

• 3การประยุกต (implications) หมายถึง การคาดคะเน หรือทํานายจาก
ขอมูลหรือส่ิงเราท่ีกําหนด โครงสรางทางสติปญญาตามทฤษฎีของกิลฟอรด
ประกอบดวยหนวยจุลภาคจากท้ังสามมิติ เทากับ 5 x 5 x 6 คือ 150 
หนวย แตละหนวยประกอบดวย เนื้อหา– ปฏิบัติการ- ผลผลิต (contents 
– operations – products )  

2  นอกจากนี้กิลฟอรดไดอธิบายเกี่ยวกับความคิดสรางสรรค (creative thinking ) โดยเทียบ
กับโครงสรางทางสติปญญาท่ีกลาวมาแลว และนํามาศึกษาเฉพาะสวนท่ีเปนกระบวนการคิด ดานการ
คิดแบบอเนกนัย โดยใชมิติดานเนื้อหา และผลผลิต ทําใหไดหนวยจุลภาคท่ีแทนความสามารถ 2 
2ดานความคิดสรางสรรคอยูท่ี 1 x 5 x 6 ดังภาพท่ี 2  
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21ภาพท่ี 2  สมรรถภาพดานความคิดสรางสรรคของกิลฟอรด  
 

ลักษณะนิสัย 
 ความหมายของลักษณะนิสัย 

ลักษณะนิสัยของเราจะข้ึนอยูกับบุคลิกภาพ ซึ่งคําวา “บุคลิกภาพ” (Personality) มาจากคํา
ละตินวา Persona หมายถึงหนากากท่ีตัวละครใชสวมเวลาออกแสดง เพื่อแสดงบทบาทตามท่ีถูก
กําหนดให มีผูใหคําจํากัดความไวหลายทาน ดังนี้ 

เออรเนส อาร.ฮิลการด (Hilgard, 1962: 447) กลาววา บุคลิกภาพเปนลักษณะสวนรวมของ
บุคคล และการแสดงออกของพฤติกรรมซึ่งช้ีใหเห็นความเปนปจเจกบุคคลในการปรับตัวตอ
ส่ิงแวดลอม รวมถึงลักษณะท่ีสงผลสูการติดตอสัมพันธกับผูอื่น ไดแก ความรูสึกนับถือตนเอง 
ความสามารถ แรงจูงใจ ปฏิกิริยาในการเกิดอารมณ และลักษณะนิสัยท่ีสะสมจากประสบการณชีวิต 
           ฟลลิป จี.ซิมบารโด และฟลอยด แอล.รูช (Zimbardo and Ruch, 1980: 292) อธิบายวา 
บุคลิกภาพเปนผลรวมของลักษณะเชิงจิตวิทยาของบุคคลแตละคน มีผลตอการแสดงออกซึ่ง
พฤติกรรมหลากหลายของบุคคลนั้น ท้ังสวนท่ีเปนลักษณะภายนอกท่ีสังเกตไดงายและพฤติกรรม
ภายในท่ีสังเกตไดยาก ลักษณะท่ีหลากหลายดังกลาว สงผลใหบุคคลแสดงออกตางกันในแตละ
สถานการณและชวงเวลา 
           ริชารด ซี.บุทซิน และคณะ (Bootzin and others, 1991: 502) ใหความหมายวา
บุคลิกภาพเปนลักษณะนิสัยและรูปแบบของความคิด ความรูสึก และการประพฤติปฏิบัติของบุคคล
แตละคน 
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อัลชลี แจมเจริญ (2530: 163) ใหความหมายวา บุคลิกภาพหมายถึงลักษณะสวนรวมของ
บุคคลท้ังหมด ท่ีแสดงออกมาปรากฎใหคนอื่นไดรูไดเห็น ซึ่งแตกตางกันเพราะภาวะส่ิงแวดลอมท่ีสราง
ตัวบุคคลนั้นแตกตางกันประการหนึ่ง และพันธุกรรมท่ีแตละบุคคลไดมาก็แตกตางกันไปอีกประการ
หนึง่ 

Organ and Hammer (1982) กลาววา บุคลิกภาพ เปนสภาวะภายใน (Internal states) 
ของบุคคลท่ีแสดงออกมาในรูปของพฤติกรรมท่ีปรากฏแกสายตาของผูอื่น พฤติกรรมท่ีจะเรียกวาเป
ยบุคลิกภาพไดนั้นจะตองเปนแบบของพฤติกรรมท่ีมีลักษณะคอนขางสม่ําเสมอ (Consistency) และมี
ความตอเนื่องถาวร (Stability) 

Sanford ใหความหมายวา “บุคลิกภาพ คือ กระบวนการรวมกันระหวางลักษณะตาง ๆ ของ
บุคคลอยางเปนแบบฉบับเดียวซึ่งแตละลักษณะตางก็มีความสัมพันธซึ่งกันและกัน และรวมกันเปน
ลักษณะเฉพาะประจําของแตละบุคคล” 

Morgan ใหความหมายวา “บุคลิกภาพ คือ คุณสมบัติและคุณลักษณะเดนของบุคคล รวมท้ัง
การปรับตัวของบุคคลตอส่ิงแวดลอมตาง ๆ 

Murphy ใหความหมายวา “บุคลิกภาพ คือ ความเดนประจําตัวของแตละบุคคลซึ่งอาจจะ
บอกถึงความแตกตางกับบุคคลอื่น ๆ ไดในรูปของปริมาณและคุณภาพในลักษณะเดนนั้น ๆ” 

Allport ใหความหมายวา “บุคลิกภาพ หมายถึง กระบวนการสรางหรือการจัดสวนประกอบ
ของแตละคนท้ังภาพในและภาพนอก(จิตใจและทางรางกาย)ซึ่งบุคลิกภาพนี้จะทําหนาท่ีเปนเครื่อง
กําหนดตัดสินพิจารณา ลักษณะพฤติกรรมและความนึกคิดของบุคคลนั้น” 

Schneiders  “บุคลิกภาพ คือ กระบวนการสราง หรือการรวมคุณลักษณะท้ังดานรางกาย
และจิตใจของบุคคล ตลอดจนความสามารถ ความโนมเอียง นิสัย อากัปกิริยาของแตละบุคคล
โดยเฉพาะ และบุคลิกภาพจะเปนเครื่องกําหนดปฏิกิริยาของบุคคลท่ีมีตอตนเองและตอผูอื่นและเปน
ผลตอความรูสึกนึกคิดท่ีมีตอส่ิงแวดลอม วัตถุ บุคคล และวัฒนธรรมของสังคมท่ีเขาอาศัยอยู” 

ดังนั้นจึงอาจสรุปไดวา “บุคลิกภาพ”  หมายรวมถึง ลักษณะท่ีสําคัญตอการปรับตัวของ
บุคคลไดแกรูปราง หนาตา ทาทาง ความสามารถ แรงจูงใจ และการแสดงออกทางอารมณและผลท่ี
เกิดจากประสบการณ” อยางไรกต็ามเราไมสามารถกลาวไดวาคําจํากัดความใดดีท่ีสุดและถูกตองท่ีสุด
ท้ังนี้เพราะคําจํากัดความแตละอันตางก็มาจากความเช่ือในทฤษฎีบุคลิกภาพท่ีมีอยูมากมายแตกตาง
กัน ในท่ีนี้จะกลาวถึงทฤษฎีบุคลิกภาพกลุมลักษณะนิสัย (Traits Theory of Personality) 
  ทฤษฎีบุคลิกภาพกลุมลักษณะนิสัย (Traits Theory of Personality)  
  แนวคิดนี้อธิบายบุคลิกภาพบุคคลวา ประกอบไปดวยมิติหลาย ๆ อยาง ลักษณะ (Trait) แต
ลักษณะจะแสดงคุณสมบัติหรือ คุณภาพ (Characteristics) ท่ีแตละคนมีมากกวาบุคคลอื่น ๆ หรือ
นอยกวา คนอื่น ๆ เชน ความกาวราว ชอบพึ่งพิงผูอื่น หรือการมองวาตนเองมีปมดอย ความเฉ่ือยชา 
ความเขมแข็ง ออนแอ ฯลฯ 
  แนวคิดท่ีสําคัญของทฤษฎีอุปนิสัยของกอรดอน ออลพอรต 
  แนวคิดท่ีสําคัญ เนื่องจากออลพอรต ไดศึกษาแนวคิดทางจิตวิทยาอยางกวางขวาง ทําใหเขา
ไดรับอิทธิพลจาก แนวความคิดตางๆ เหลานั้น มาเปนแนวทางในการสรางทฤษฎีของเขา เขาไดนํา
วิธีการสังเคราะหมาใชในการศึกษาบุคลิกภาพ ซึ่งเปนแบบอยาง ใหแกนักทฤษฎีในระยะตอมา 
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นอกจากนี้ ออลพอรต ยังไดเนนวา การศึกษาบุคลิกภาพ ควรศึกษาจาก คนปกติมากกวา เพราะ
บุคคลปกติจะมีพฤติกรรมท่ีสอดคลองกันอยูในตัวเอง มีความสมดุลและการรูตัว (Congruence Unit 
and Conscious) แนวคิดของเขาโดยภาพรวมแลว จะมีความคลายคลึงกับ แนวคิดของ แนวคิดของ
กลุมมนุษยนิยม (Humanistic Psychology) 
  ออลพอรต เช่ือวา บุคคลจะมีพฤติกรรม อยูในอิทธิพลของปจจุบันมากกวาอดีต โดยแสดง
พฤติกรรม ท่ีเกิดจาก องคประกอบ ตางๆ ในปจจุบัน มากกวาเหตุการณในอดีต โดยเฉพาะอยางยิ่ง 
การแสดงพฤติกรรมตางๆ จะเกี่ยวของกับ แรงจูงใจ ท่ีเกิดจากจิตสํานึก เปนสวนใหญและรวมถึง การ
รูตัวยิ่งไปกวานั้น ออลพอรตยังมองมนุษยในแงดีเขาเช่ือวา ไมมีความตอเนื่องกันระหวาง พฤติกรรม
ปกติ กับพฤติกรรมผิดปกติของบุคคล เด็กกับผูใหญ หรือ สัตวกับมนุษย และการสรุปส่ิงหนึ่ง เพื่อ
อธิบายปรากฏการณของอีกส่ิงหนึ่งเปนส่ิงท่ีควรใหความระมัดระวังอยางยิ่งเชนทฤษฎีจิตวิเคราะห 
อาจเปนทฤษฎีท่ีเหมาะสมใน การอธิบาย ความแปรปรวนของพฤติกรรม และพฤติกรรมท่ีผิดปกติ แต
อาจมีประโยชนไมมากนักในการอธิบายพฤติกรรมปกติ หรือแมแต ทฤษฎีท่ีมีความสมบูรณในเรื่องการ
พัฒนาการของเด็ก รายละเอียดของทฤษฎีดังกลาว ก็ไมสามารถอธิบายถึง พฤติกรรมในวัยผูใหญได
อยางสมบูรณโดยเขาไดสรุปวา ไมมีทฤษฎีใด ท่ีมีเนื้อหาท่ีครอบคลุม ถึงโครงสรางทางพฤติกรรมของ
มนุษยไดโดยสมบูรณ เขาจึงเนนความสําคัญของการศึกษา รายละเอียดท่ีเกี่ยวของโดยตรงในการวัด
พฤติกรรม ซึ่งถือวาเปนการนําวิธีการทางวิทยาศาสตรมาใชในการศึกษาทางจิตวิทยา และจุดมุงหมาย
ท่ีสําคัญของการศึกษาบุคลิกภาพ คือ การเขาใจในพฤติกรรมของมนุษย เพื่อการแกปญหาทาง
พฤติกรรม โดยเนนส่ิงแวดลอมในปจจุบันวา มีอิทธิพลตอ การแสดงพฤติกรรมมากกวาประวัติสวนตัว
ในอดีต อยางไรก็ตาม แนวคิดของออลพอรต เปนทฤษฎีท่ีเนนการทํางานของอุปนิสัย (Traits) จึงเปน
ท่ีรับรูในกลุมนักจิตวิทยาวา เปนจิตวิทยาเชิงอุปนิสัย (Traits Psychology) 
  โครงสรางทฤษฎีอุปนิสัยของออลพอรต 
  โครงสรางบุคลิกภาพประกอบดวย อุปนิสัย (Traits) บุคลิกภาพถูกกําหนดจากอุปนิสัย หรือ
เปนการทํางานของอุปนิสัย และในเวลาเดียวกัน พฤติกรรมของบุคคล จะเกิดจากแรงจูงใจ หรือแรง
ขับจากอุปนิสัย ซึ่งสะทอนใหเห็นบุคคลไดเทาๆ ความคิดของบุคคลนั้นเอง ออลพอรตไดแบง
โครงสรางหรืออุปนิสัยของบุคคลออกเปนสวนๆ ทําใหเขาใจพฤติกรรม และกระบวนการทํางาน ของ
อุปนิสัยตางๆ ไดชัดเจนข้ึน โดยเฉพาะอยางยิ่งอุปนิสัยท่ีอยูภายในตัวเอง ซึ่งอุปนิสัยนี้เกิดมาจาก การ
ทํางานของอินทรีย (Organism) นั่นเองออลพอรตใหความหมายของคําวา “บุคลิกภาพ” คือ ระบบ
การทํางานท้ังหมด ซึ่งอยูภายในของแตละบุคคลเปนหลักการของระบบทางกาย และจิตท่ีมีพลังในตัว
บุคคล ซึ่งกําหนดการปรับตัว ท่ีเปนเอกลักษณของบุคคล ท่ีมีตอส่ิงแวดลอม หรืออาจกลาวส้ันๆ วา
บุคลิกภาพ คือลักษณะบางอยาง และการกระทําบางอยาง ซึ่งอยูเบ้ืองหลังของการทําหนาท่ี
เฉพาะเจาะจงท่ีอยูภายในบุคคล และการทําหนาท่ีท่ีสําคัญของบุคลิกภาพก็คือ การปรับตัวของบุคคล 
ตอส่ิงแวดลอมไดอยางมีประสิทธิภาพ ออลพอรตใหความสําคัญในเรื่องระบบการแปรพลัง (Dynamic 
Organization) ท่ีจะตองมีการเปล่ียนแปลงและพัฒนาการตลอดเวลา ระบบการเปล่ียนแปลงนี้ จะมี
การเช่ือมโยง และเกี่ยวของกับ องคประกอบอื่นๆ ท้ังทางรางกายและจิตใจ (Psychophysical) ท่ีทํา
ใหเกิดการหลอหลอม ความเปนอันหนึ่ง อันเดียวกันของบุคคล และเปนการกําหนด (Determine) 
แนวทางในการแสดงพฤติกรรมของบุคคล 
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  โครงสรางบุคลิกภาพ มีองคประกอบ อุปนิสัย (Traits) เจตนารมณ ( Intentions ) และ ตน 
(The Propium หรือ Self) มีรายละเอียดดังนี้ 
  1. อุปนิสัย (Traits) เปนตัวกําหนดแนวโนมในการตอบสนองของบุคคลตอส่ิงเรา และช้ีนํา
พฤติกรรมของบุคคล อุปนิสัยจะสังเกตไดจาก พฤติกรรมท่ีปรากฏออกมา (Overt Behavior) ถือวา
เปนศูนยกลางของ ระบบจิตท่ีมีลักษณะเฉพาะ และลักษณะพิเศษของแตละบุคคล ทําใหเกิด
ความสามารถ ท่ีจะทําหนาท่ีตอส่ิงเรา ใหเกิดความสมดุล ในรูปของการปรับตัว และ การแสดงออก
ทางพฤติกรรม 
  ออลพอรต ไดอธิบายใหเห็นถึงความแตกตางระหวางอุปนิสัย (Traits) กับคําอื่นๆ ท่ีมี
ความหมายใกลเคียงกัน คือ อุปนิสัย (Traits) และนิสัย (Habits) วา ท้ังสองตางก็เปนตัวกําหนด
แนวโนมของพฤติกรรม โดยท่ีอุปนิสัย จะมีความหมายกวาง กวานิสัย ท้ังนี้ เพราะอุปนิสัยจะทําหนาท่ี
เช่ือมโยง หรือรวบรวมนิสัยตางๆ ต้ังแต 2 ลักษณะข้ึนไป 
  สวนอุปนิสัยกับ เจตคติ (Attitudes) นั้นมีความหมายท่ีคลายคลึงกันมาก เพราะท้ังสองตาง 
ก็เปนไปตัวกําหนดแนวโนม ในการตอบสนองตอส่ิงเราตางๆ และเปนเอกลักษณของบุคคล แตท่ี
ตางกันคือ เจตคติ เปนส่ิงท่ีบุคคลมีตอส่ิงใดส่ิงหนึ่งอยางเฉพาะเจาะจงท่ีเกิดจากการเช่ือมโยงของ
ความรูสึกท่ีมีตอส่ิงนั้นๆ ซึ่งอาจจะมีระดับความรูสึกแตกตางกันไป ในขณะท่ีอุปนิสัยจะเกี่ยวของกับ
ลักษณะโดยท่ัวๆ ไป มากกวาเจตคติ นอกจากนี้ เจตคติจะเปนเรื่องของการประเมิน หรือตัดสินท่ีมีตอ
ส่ิงตางๆ มากกวาอุปนิสัย ตัวอยาง เชน การยอมรับ การไมยอมรับ และเจตคตินั้น จะนํามาใชเม่ือ
กลาวถึงส่ิงใดส่ิงหนึ่งท่ีเกี่ยวของกับคานิยม (Value) จะเกิดเมื่อบุคคลถูกกระตุนจากส่ิงเรา ท่ีทําใหเกิด
ความรูสึกชอบใจ หรือไมชอบเทานั้น แต สําหรับอุปนิสัย กับรูปลักษณะ (Type) นั้นแตกตางกันท่ี
รูปรางลักษณะ เปนโครงสรางทางความคิดเห็นของผูสังเกตแลว จัดบุคคลไวในลักษณะท่ีเห็นวา
เหมาะสม จึงไมมีลักษณะท่ีโดดเดน เปนของตนเอง แตจะจัดไวเปนภาพรวม ในขณะท่ีอุปนิสัยนั้น จะ
เปนตัวแทน หรือพฤติกรรมท่ีแสดงใหเห็นถึง เอกลักษณของบุคคล นอกจากนี้อุปนิสัยของมนุษยมีมาก 
และไมมีอุปนิสัยใดท่ีตายตัว ในแตละบุคคล และการท่ีบุคคลจะแสดงอุปนิสัยท่ีโดดเดนออกมานั้น 
ข้ึนอยูกับ ส่ิงแวดลอมทางกายภาพ (Physical Environment) และส่ิงแวดลอมทางสังคม (Social 
Environment) รวมท้ังอุปนิสัยของแตละคนท่ีจะแสดงออกนั้น จะมีการประสมประสานกันของ
หลายๆ อุปนิสัย ท่ีเปนเหตุเปนผลอยางเกี่ยวของกัน เชน อุปนิสัยของคนชอบเขาสังคม จะทํางาน
ประสานกับอุปนิสัย ท่ีชอบเจรจา ชอบแสดงตัว นอกจากนี้ อุปนิสัยใดๆ ของบุคคลนั้น จะข้ึนอยูกับ
พื้นฐานทางจิตใจของผูนั้นดวยเชนกัน 
  อุปนิสัยจะแบงออกเปน 2 ชนิด ไดแก อุปนิสัยสามัญ (Common Traits) และอุปนิสัย
เฉพาะตัว (Personal Disposition Traits) 
   1.1 อุปนิสัยสามัญ หมายถึง บุคลิกภาพท่ัวๆ ไปท่ีเหมือนกับคนอื่นๆ ท่ีสามารถ

นํามาเปรียบเทียบกันไดสวนหนึ่ง โดยเฉพาะผูท่ีอยูในวัฒนธรรมเดียวกัน และเผาพันธุเหมือนกัน ก็จะ
ทําใหบุคคล มีบุคลิกภาพเหมือนกัน ไดสวนหนึ่ง สวนใหญซึ่งไดแก คานิยมตางๆ หรือ ลักษณะรวมๆ 
ของบุคคลในแตละวัฒนธรรม เชน คนไทยใจดี คนอเมริกันอิสระ คนจีนมีความขยัน เปนตน 
   1.2 อุปนิสัยเฉพาะตัว หมายถึง เอกลักษณของแตละบุคคล ท่ีเปนลักษณะ

เฉพาะตัว ท่ีไมสามารถนํามาเปรียบเทียบกับ ระหวางคนสองคนได อุปนิสัยเฉพาะตัวแบงออกเปน 3 
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ระดับคืออุปนิสัยสําคัญ อุปนิสัยสําคัญหรืออุปนิสัยรวม และอุปนิสัยทุติยภูมิ ซึ่งทํางานตาม
ความสําคัญท่ีมีอิทธิพลตอการแสดงพฤติกรรมของบุคคลดังนี้คือ 
    1.2.1 อุปนิสัยสําคัญ (Cardinal Disposition Traits) หรือเรียกอีก
อยางหนึ่งวา อุปนิสัยเดน (Eminent Traits) จะมีอิทธิพลอยางยิ่งตอพฤติกรรมเกือบทุกดานของ
บุคคล เปนลักษณะเดนท่ีแสดงออกชัดเจนเหนือพฤติกรรมอื่นๆ ท่ีไมสามารถปดบังซอนเรนได เปน
อุปนสัิยท่ีมากําหนดอารมณ ความรูสึก และช้ีนําวิถีทางชีวิต ควบคุมแรงจูงใจตางๆ เพื่อใหบุคคลเกิด
พลังในการแสดงพฤติกรรมท้ังหมดของบุคคล เชน สมเด็จพระนเรศวรมหาราชทรงมีความกลาหาญ 
เปนอุปนิสัยท่ีโดดเดนท่ีมีอยูในพระองค จนเปนท่ีประจักษโดยท่ัวไป เปนตน อุปนิสัยสําคัญนี้ อาจไม
ปรากฏกับทุก ๆ คนก็ได แตถาผูใดมีอุปนิสัยสําคัญเพียงลักษณะเดียวท่ีควบคุมพฤติกรรมของบุคคล
นั้น ก็จะกลายเปนบุคลิกภาพอางอิง (Reference Personality) ท่ีมักจะใชเรียกผูอื่นท่ีมีลักษณะ
เหมือนเขา เชน เรามักจะอางอิงคนท่ีมีความตระหนี่ข้ีเหนียว วาเหมือนกับ ไซล็อค หรือผูชายท่ีเจาชู
วาเปนขุนแผน เปนตน 
    1.2.2 อุปนิสัยศูนยกลาง หรืออุปนิสัยรวม (Central Disposition 
Traits) เปนกลุมของอุปนิสัยของบุคคลใดบุคคลหนึ่ง ท่ีมีอยูภายในตัวบุคคล เปนอุปนิสัยท่ีสังเกตได
งายเชนเดียวกัน เปนส่ิงท่ีมั่นคงอยูในบุคลิกภาพ แตอาจแสดงออกมาเพียงเล็กนอย แตก็เปน
คุณลักษณะท่ีมีความสําคัญในการควบคุมพฤติกรรมของบุคคล เชน ความทะเยอทะยาน การแขงขัน 
ความซื่อสัตย การตรงตอเวลา และความเมตตากรุณา ลักษณะเหลานี้จะควบคุมพฤติกรรมของบุคคล
ในสถานการณตางๆ อยางไรก็ตาม เปนการจะเขาใจอุปนิสัยนี้ตองสังเกตมาก เพราะบางอยางไม
สามารถสังเกตอยางตรงไปตรงมาจากทวงทีอากัปกิริยาและการแสดงออกภายนอกได ดังนั้น จึงควร
คํานึงถึงความถ่ี และความเขมของพฤติกรรมนั้น ในสถานการณตางๆ อยางหลากหลายใน
ขณะเดียวกัน 
    1.2.3 อุปนิสัยทุติยภูมิ ( Secondary Traits ) เปนคุณลักษณะท่ีอยู
บริเวณรอบนอก (Peripheral) ท่ีผลักดันใหบุคคลแสดงออกโดยท่ัวไป เปนลักษณะท่ีมีอยูมากในตัว
บุคคล ไดแก ความสนใจ และปฏิกิริยาตอบสนองตอส่ิงเราตางๆ เชน เมื่อบุคคลชอบส่ิงใดส่ิงหนึ่ง เขา
ก็มักจะแสดงความคิดเห็นท่ีดีท่ีมีตอส่ิงนั้นๆ ทําใหเขาเกิดความชอบ และสนใจ หรือเปนเจตคติซึ่ง
บางครั้งเรียกอุปนิสัยชนิดนี้วา เปนอุปนิสัยเชิงเจตคติ (Attitudinal Traits) 
   2. เจตนารมณ ( Intentions ) เปนความต้ังใจของบุคคลท่ีจะกาวไปขางหนา หรือ
แสวงหาเปาหมายเพื่ออนาคต เปนส่ิงท่ีจะชวยใหบุคคลเขาใจ บุคลิกภาพของบุคคลไดมากกวา การ
คนหาอดีต หรือ ประวัติความเปนมาของบุคคล เชน ความหวัง ความปรารถนา ความใฝฝน ความ
ทะเยอทะยานและการวางแผน เปนตน ส่ิงเหลานี้จะผลักดันใหบุคคล กาวไปขางหนา และเปนปจจัย
ท่ีมีอิทธิพลตอ พฤติกรรมของมนุษย และเปนส่ิงช้ีนําพฤติกรรมปจจุบัน เพื่อบรรลุเปาหมายในอนาคต 
ดังนั้นเจตนารมณ จึงเปนกุญแจท่ีสําคัญท่ีจะชวยใหเขาใจพฤติกรรมของมนุษย 
   3. “ตน” (The Propium หรือ Self) ออลพอรต จะใชคําวา “Propium” แทน
คําวา “Self” ซึ่งหมายถึง ลักษณะเฉพาะของบุคคล เขาเปรียบวา ถาบุคลิกภาพของมนุษยเหมือน
ตนไมใหญท่ีประกอบไปดวย ราก กิ่ง ใบ กาน เปลือก “The Propium” ก็จะเปรียบเสมือน แกนของ
ตนไม และอธิบายวา ลักษณะตางๆ ท่ีประกอบ เปนบุคลิกภาพของแตละบุคคล จะมีท้ังสวนกาย จิต 
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สังคม อารมณ มีจุดรวมและจุดรวม หรือ “The Propium” ถาจุดรวมและจุดรวมนี้ สามารถประสาน
สัมพันธ กันไดอยางเหมาะสม ก็จะทําใหบุคคลนั้น มีบุคลิกภาพท่ีสมบูรณ (Healthy Personality) 
แตถาจุดท้ังสองไมสามารถประสานสัมพันธกันอยางเหมาะสม ก็จะนําไปสูโรคจิต โรคประสาท ความ
ออนแอ ความกาวราว การเปนอันธพาล เปนตน ดังนั้น “The Propium” จึงหมายรวมถึง ทุกส่ิงทุก
อยางของบุคลิกภาพ ซึ่งเปนเครื่องแสดงถึง เอกภาพภายในของบุคคล ท่ีเกิดจากพัฒนาการท่ีตอเนื่อง 
ต้ังแตวัยทารกจนส้ินอายุขัย โดยผานข้ันตางๆ ของพัฒนาการชีวิต 
   ข้ันตอนของการพัฒนาการทาง บุคลิกภาพ (Stage of Personality 
Development) แบงพัฒนาการของชีวิตเปน 5 ข้ันไดแก 
    1. วัยเริ่มแรกของทารก (Early Infancy) เปนระยะแรกเกิด โดยในระยะ
เริ่มแรกของชีวิต ทารกยังไมมีความรูสึกเกี่ยวกับตน เพราะ ทารกไมสามารถแยก “ตัวฉัน” (Me) ออก
จากส่ิงแวดลอมรอบ ๆ ตัวได 
    2. วัยเริ่มแรกของตัวตน (The Early Self) เปนระยะ 3 ปแรกของชีวิต เด็ก
จะเริ่มรูสึกเกี่ยวกับ รางกายของตนเอง (Sense of Bodily Self) เด็กจะมีพัฒนาการและ การ
เจริญเติบโตทางดานรางกาย และการทํางาน ของอวัยวะตางๆ เปนระยะท่ีเด็กจะสํารวจ และจัดการ
ส่ิงตางๆ รอบๆ ตัว โดยการรับรูส่ิงเราตางๆ จากอวัยวะสัมผัสและเมื่อทารกเจริญเติบโตข้ึน ก็จะมีวุฒิ
ภาวะมากข้ึน เด็กจะเริ่มรับรูถึงรางกายของตนมากข้ึน เชน “ฉันเปนคนออนแอ” “ฉันเปนคนนา
เกลียด” “ฉันเปนสวยงาม” “ฉันเปนคนมีจิตใจเขมแข็ง” “อดทน” เปนตน และการรับรูเกี่ยวกับ
รางกาย จะเริ่มกอตัวเปนศูนยกลางของ “ตน” (The Propium) และสราง ความรูสึกนึกคิดเกี่ยวกับ
ตนเอง (Self-Concept) ไปตลอดชีวิต จากนั้นเด็กจะรูสึกใน เอกลักษณของตนเอง (Sense of Self-
Identity) โดยสรางลักษณะเฉพาะตัว หรือเอกลักษณของตนข้ึนมา ท่ีแตกตางไปจากผูอื่น เอกลักษณ
นี้ จะเปนส่ิงท่ีติดตัวตอไป และเปนวิถีทางเดียวกัน กับท่ีเรารับรู เกี่ยวกับตัวเอง เด็กจะสราง
ลักษณะเฉพาะดังกลาว จากตัวแบบท่ีสําคัญๆ เชน จากบุคคลท่ีเขายกยองนับถือ คนใกลชิด โดยการ
แสดงเอกลักษณ ออกมาในลักษณะตางๆ เชน อุดมคติ เอกลักษณ เปนส่ิงท่ีควบคุมแรงขับและทําให
รูสึกวา ตนเปนคนอยางไร หรือตองการอะไร และควรตัดสินใจอยางไร ตอมาเด็กจะพัฒนาความรูสึก
ยกยองตนเอง หรือ ความภาคภูมิใจในตนเอง (Self-Esteem, Pride) ท่ีเกิดมาจากความรูสึก
ภาคภูมิใจของเขาในการทํางานอยางใดอยางหนึ่งไดสําเร็จในขณะท่ีจะเกิดความรูสึกตํ่าตอย เมื่อ
ประสบความลมเหลว ถาเด็กสามารถจัดการกับส่ิงแวดลอมตางๆ ได เขาจะรูสึกเปนตัวของตัวเองท่ี
แยกจากคนอื่นๆ ซึ่งถือวาเปนระยะของการแสดงออกและการแสดงความสามารถของตนเอง 
    3. ระยะ 4 – 6 ขวบ (Four to Six) เปนระยะของเด็กท่ีมีความรูสึก
เกี่ยวกับตนเองในลักษณะตางๆ คือ มีความรูสึกเปนเจาของ (The Extension of Self) มีความรูสึก
แขงขัน และมีแบบแผนมากข้ึนในระยะนี้ คือ การยึดตัวเองเปนศูนยกลาง (Egocentric) เชน “นี่เปน
ของฉัน” “บานของฉัน” “ของๆ ฉัน” เปนตน ความรูสึกเปนเจาของท่ียึดตัวเองเปนศูนยกลาง ทําให
เด็กรูสึกอบอุนความรูสึกนี้ทําใหบุคคลพัฒนาคุณลักษณะรวมๆ ในวัยตอมา เชน ความรูสึกท่ีมีตอ
สวนรวม สังคมและประเทศชาติในท่ีสุด อีกลักษณะหนึ่งของความรูสึกท่ีบุคคลมีตอตนเอง คือ มโน
ภาพแหงตน (Self-Image) เปนบทบาทของบุคคลท่ีจะแสดงออก เพื่อใหไดรับการยอมรับจากผูอื่น 
และเปนส่ิงท่ีสําคัญท่ีจะกําหนดวิธีการและรูปแบบตางๆ ในการแสดงพฤติกรรมเพื่อใหบรรลุตาม



17 

วัตถุประสงคและเปาหมาย สําหรับอนาคตในระยะนี้เด็กจะเรียนรูวาพอแมคาดหวังอะไรจากตัวเขา
และเขาจะทําอยางไรและเปรียบเทียบความคาดหวังตางๆ ดังกลาวกับพฤติกรรมของตนเองจาก
กระบวนการปฏิสัมพันธ เชน เด็กทราบวาพอแมตองการใหเขาเปนเด็กคนดี แตเด็กก็ยังซุกซน แตโดย
ความเปนจริงแลว เขาก็ยังไมเกิดความเขาใจอยางชัดเจนนักในการท่ีจะสรางมโนภาพของตนเองวา 
ตองการเปนเชนไรเมื่อเติบโตเปนผูใหญ ซึ่งระยะนี้ จึงเปนเพียงความคิดท่ีจะเปนรากฐานของการ
พัฒนาตนในวัยท่ีสูงข้ึนตอไป 

   4. ระยะ 6 – 12 ป (Six to Twelve) เปนระยะท่ีเด็กเขาโรงเรียน และ
พัฒนาสติปญญามากข้ึน ในขณะเดียวกันความรูสึกของความเปนเอกลักษณในตนเอง มโนภาพแหง
ตนและความรูสึกเปนเจาของ ก็จะพัฒนามากข้ึน ทําใหเด็กรูสึกมีคุณคาในตนเองมากยิ่งข้ึน เด็กจะ
เรียนรูถึงส่ิงใหมๆ และสามารถเลือกสรรส่ิงตางๆ เด็กเริ่มรูสึกวาตนเองมีพลังใหมๆ ในตนเองเกิดข้ึน
และไดคนพบตนเองในแงมุมอื่นๆ เพิ่มข้ึนอีกหลายอยาง นอกจากนี้ ยังมีลักษณะท่ีเดนอีกอยางหนึ่งท่ี
เกิดข้ึนไดแก การมีเหตุผลในตนเอง (Self as Relational Copper) เปนลักษณะของการมีความ
เช่ือมั่นวา เขามีความสามารถท่ีจะคิดอยางมีเหตุมีผล ในการจัดการกับปญหาตางๆ ซึ่งเปนระยะ
เริ่มตนของการมีพลังความคิดอยางมีเหตุผล ทําใหบุคคลมองวาตนเองมีความสามารถท่ีจะคิด และต้ัง
จุดมุงหมายท่ีเปนประโยชน 
    5. ระยะวัยรุน (Adolescence) เปนระยะต้ังแตอายุ 12 – 21 ป วัยนี้
บุคคลจะมีปญหาในดานตางๆ เชน ปญหาการเลียนแบบ การเลือกอาชีพ รวมท้ังปญหาในการเลือก
เปาหมายของชีวิต เขาจึงเรียนรูวาจะตองมีการวางแผนเพื่อไปถึงจุดมุงหมายระยะยาว (Propriety 
Striving) ท่ีเกี่ยวของกับแรงจูงใจในภายใน ซึ่งถือวา เปนศูนยกลางของการมีชีวิตอยู และเปนจุด
กําเนิดของการพัฒนา มโนธรรม (Conscience) ท่ีทําใหเกิดความแตกตางระหวางมนุษยกับสัตว     
ออลพอรตไดอธิบาย ข้ันตอนการพัฒนามโนธรรมวา จะเริ่มจากการท่ีเด็กจะรับรูมโนธรรม ในแงของ
การกลัวการถูกลงโทษ(Authoritarian Conscience) จากพอแมเขาจะรูสึกผิดหากขัดขืนตอกฎเกณฑ
ตาง ๆ แตเมื่อเด็กมีวุฒิภาวะมากข้ึนก็จะมีการรับรูเกี่ยวกับส่ิงแวดลอมและบุคคลอื่นเปล่ียนแปลงไป
จากเดิม โดยมีความรูสึกในเรื่องมโนธรรม โดยความเช่ือฟงจากสังคม และจะเปล่ียนมาเปนวิธีการ
สรางมาตรฐานภายในตัวเองซึ่งถือวา เปนจุดเริ่มตนในการสรางกฎเกณฑของตนเอง (Self-
Generated Rules) และโดยความเปนจริงแลว ชีวิตของบุคคลจะถูกหลอหลอมความเปน “ตน” โดย
กระบวนการทํางานตามข้ันตอนตางๆ รวมกัน 
   พัฒนาการของบุคคลท่ีหลอหลอมรวมกันจนเขาสูวุฒิภาวะ จะมีพัฒนาการเรื่อง
ตางๆ ไดอยางสมดุลและมีลักษณะดังนี้คือ 
   1. พัฒนาการทางบุคลิกภาพท่ีมีวุฒิภาวะ (Mature Personality) เปนการ
พัฒนาการทางบุคลิกภาพ เปนกระบวนการ ท่ีตองใชเวลายาวนาน ท่ีจะตองพัฒนาตัวเองกอน และ
พัฒนาการในระยะแรก เกิดจากแรงจูงใจทางรางกาย และตอมาเมื่อ บุคคลมีอายุมากข้ึน ก็จะเปล่ียน
มาเปนมีแรงจูงใจภายใน รวมท้ัง การใชความคิดสรางสรรค ท่ีจะ ทําใหบุคคลดําเนินไปสู ความมีวุฒิ
ภาวะ ไดอยางสมบูรณ ลักษณะของผูมีบุคลิกภาพ ท่ีสมบูรณจะพิจารณาไดจาก 
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   2. การพัฒนาความรูสึกเปนเจาของ ( Extension of the Sense of Self ) คือ 
ความสามารถรวมทํากิจกรรมตางๆ ท่ีนอกเหนือไปจากกิจกรรมของตน เขาจะแสดงพฤติกรรมตางๆ 
เพื่อความสุขของท้ังตนเองและผูอื่น อยางเหมาะสม 
   3. การพัฒนาการมีความสัมพันธท่ีดีกับบุคคลอื่น (Warm Relatedness to 
Others) คือมีความสามารถใน การสรางสัมพันธท่ีใกลชิและอบอุนกับผูอื่น (Intimacy) สามารถท่ีจะ
ใหความรักตอผูอื่นดวยความบริสุทธิ์ ใจ และยังมีความเขาใจ และความเห็นอกเห็นใจผูอื่น 
(Compassion) เขาจะไมมีอคติในการติดตอ และสัมพันธกับผูอื่น จะยอมรับ และช่ืนชมในพฤติกรรม 
และความคิดเห็น ท่ีแตกตางกันของผูอื่น ไมนินทาผูอื่น มีการปฏิบัติตาม กฎเกณฑตางๆ อยาง
เหมาะสม ไมทําใหเสียบรรยากาศใน การมีความสัมพันธกัน 
   4. การพัฒนาการยอมรับตนเอง ( Self-Acceptance ) คือ มีอารมณมั่นคง 
หลีกเล่ียงการโตตอบท่ีไมสมควร ตลอดจนควบคุมตนเองได เมื่อมีความคับของใจ มีความอดทน ไม
ตําหนิผูอื่นแบบไมมีเหตุผล โทษคนอื่นไมยอมรับความจริง 
   5. การพัฒนาการรับรูตามความเปนจริง ( Realistic Perception of Reality ) คือ
มีความสามารถรับรูส่ิงตางๆ ตามความเปนจริง โดยไมบิดเบือน มีความรอบรูและทักษะท่ีจําเปน
สําหรับการดําเนินชีวิตท่ีมีประสิทธิภาพ และสามารถอุทิศตนเองเพื่อการทํางานโดยมีลักษณะยึด
ปญหาเปนศูนยกลาง (Problem-Centered) ไมใชยึดตนเองเปนศูนยกลาง (Ego-Center) 
   6. การพัฒนาการมองตนเองดวยสายตาเปนกลาง (Self-Objectification) หมายถึง 
การรูจักตนเองและมีความสุขท่ีมองเห็น ความสามารถและ ขีดจํากัดของตนเอง การมีอารมณขัน มี
ความสามารถท่ีจะเห็น ความสนุกสนานใน มโนภาพแหงตน(Self-Image) สามารถมองส่ิงแวดลอม
รอบตัวอยางเปนกลาง 

ลักษณะนิสัยท่ีเอื้อตอการเปนนักโปรแกรมคอมพิวเตอร 
ผู ท่ีมีอาชีพในการพัฒนาโปรแกรมคอมพิวเตอร ซึ่งเปนการประยุกตใชคอมพิวเตอร ท่ี

แพรหลายในปจจุบันนี้ ผูท่ีจะสามารถประกอบอาชีพนี้ได ตองมีความรูในภาษาคอมพิวเตอรอยางนอย
หนึ่งภาษา และจะตองมีคุณลักษณะท่ีเหมาะสมกับลักษณะของงานดวย ครรชิต  มาลัยวงศ (2545: 
134-154) นักโปรแกรมคอมพิวเตอรท่ีดีตองประกอบไปดวยคุณสมบัติดังตอไปนี้ 

1. มีความชํานาญหลากหลายในศาสตรคอมพิวเตอร เชน โปรแกรมคอมพิวเตอร โปรแกรม
ภาษา ฮารดแวรเทคโนโลยีสารสนเทศ เปนตน 

2. มีความเขาใจในระบบธุรกิจ ระบบการเงิน และระบบการตลาด เปนอยางดี 
3. มีความเขาใจในความตองการของผูใชระบบเปนอยางดี 
4. ตองเปนนักสํารวจ ท่ีชางสังเกตในรายละเอียดในรายละเอียดตาง ๆ ของระบบ รวมท้ัง

องค ประกอบภายนอกท่ีเกี่ยวของกับระบบ 
5. มีจรรยาบรรณตอองคกรท่ีพัฒนาระบบให ไมนําขอมูลท่ีไดซึ่งเปนความลับขององคกรไป

เผยแพรภายนอกอันกอใหเกิดผลเสียแกองคกร 
6. ตองทํางานเปนทีมไดอยางดี 
7. มีมนุษยสัมพันธท่ีดี เนื่องจากนักวิเคราะหระบบตองมีการติดตอประสานงานระหวาง

บุคคลหลายกลุม 
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8. สามารถเรียนรูส่ิงใหม ๆ ไดดวยตนเอง 
9. มีความสามารถในการนําเสนอขอมูลใหท้ังผูบริหารระดับสูงรวมไปถึงผูใชระบบ ให

สามารถเขาใจไดโดยงายและตรงกัน 
10. มีความสามารถในการติดตอส่ือสารเปนภาษาอังกฤษไดดี หากองคกรนั้นส่ือสารภายใน

เปนภาษาอังกฤษ 
11. สามารถทํางานภายในภาวะกดดันได เนื่องจากตองทํางานกับบุคคลหลายฝาย 
12. เปนนักจิตวิทยา ในการท่ีจะพูดคุยหรือติดตอกับกลุมบุคคลหลายกลุมเพื่อใหไดขอมูล

อยางถูกตอง 
  จากคุณลักษณะท่ีดีของนักโปรแกรมคอมพิวเตอร พบวา การพัฒนาโปรแกรมคอมพิวเตอร
นั้น เปนงานท่ีมีความเครียดสูงในการทํางาน ซึ่งลักษณะของงาน ประกอบดวยลักษณะดังตอไปนี้ 
 1. ตองแกปญหาท่ีหลายรูปแบบ ซึ่งในการแกปญหาแตละปญหาจะมีวิธีการ หรือรูปแบบใน
การแกปญหาหลายวิธี ผูพัฒนาโปรแกรมคอมพิวเตอรตองตัดสินใจเลือกวิธีการท่ีเห็นวาดีท่ีสุด ซึ่ง
จําเปนท่ีตองอาศัยลักษณะนิสัยดานความเช่ือมั่นในตนเอง ในการคิดและตัดสินใจเลือกวิธีการ
แกปญหาวาถูกตองและดีท่ีสุด 
  2. ตองทํางานหนักภายในเวลาท่ีจํากัด ซึ่งการทํางานในภาวะดังกลาวกอใหเกิดความเครียด
ในการทํางานสูง ผูท่ีมีความสามารถในการทํางานในภาวะดังกลาว ตองเปนผูท่ีมีลักษณะนิสัยท่ีมีความ
อดทนตอปญหาและอุปสรรคท่ีเกิดข้ึนไดตลอดเวลา มีความต้ังใจในการทํางานสูง และตองเปนผูท่ีมี
ความรับผิดชอบทํางานใหเสร็จภายในเวลาท่ีจํากัด 
 3. ตองติดตามความกาวหนาของเทคโนโลยีคอมพิวเตอร และมีการพัฒนาตนเองอยูเสมอ ซึ่ง
ตองอาศัยลักษณะนิสัยท่ีมีความกระตือรือรน 
  ซึ่งจะเห็นไดวาผูท่ีพัฒนาโปรแกรมคอมพิวเตอรนั้น ตองเปนบุคคลท่ีมีกระบวนการคิดท่ีเปน
ระบบ เพราะตองคิดหาทางแกปญหาทางตรรกะและตองมีการปรับกระบวนการคิด หรือวิธีการ
แกปญหาใหไดในเวลาท่ีจํากัด ดังนั้น ผูท่ีประสบผลสําเร็จในการพัฒนาโปรแกรมคอมพิวเตอร ตอง
เปนบุคคลท่ีมีความสามารถทางสมอง หรือสมรรถภาพทางสมองเดียงพอท่ีจะคิดหาวิธีการแกปญหา
ทางตรรกะ มีลักษณะนิสัยท่ีเหมาะสม มีแรงจูงใจภายในสูง และตองมีการรับรูความสามารถของ
ตนเองดวย จึงปฏิบัติงานภายใตแรงกดดันตาง ๆ ท่ีเกิดข้ึนได จึงถือวาประสบผลสําเร็จในการระกอบ
อาชีพ ลักษณะนิสัยท่ีคาดวาสงผลตอการพัฒนาโปรแกรมคอมพิวเตอรมี 5 ลักษณะนิสัย ไดแก 
 1. ความมีวินัย หมายถึง การแสดงพฤติกรรมตามกฎระเบียบ ขอตกลงท่ีกําหนดไว 
  2. ความอดทน หมายถึง ความสามารถของรางกาย ความคิด และจิตใจ ท่ีจะทนตอการ
ปฏิบัติกิจกรรมตาง ๆ ได เชน การทํางานทุกอยางใหสําเร็จโดยไมคํานึงถึงอุปสรรค 
 3. ความกระตือรือรน หมายถึง พฤติกรรมท่ีบอกถึงความคลองแคลววองไว ความเอาใจใสตอ
กิจกรรมตาง ๆ ท่ีตองทํา 
 4. ความต้ังใจ หมายถึง ความมุงมั่นท่ีผลักดันใหบุคคลพยายามประกอบกิจกรรมอยางใด
อยางหนึ่ง เพื่อใหบรรลุจุดมุงหมายท่ีต้ังใจไว เชน การทํางานอยางเปนระเบียบ 
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 5. ความรับผิดชอบ หมายถึง ลักษณะของบุคคลท่ีแสดงถึงความเอาใจใส จดจอและรับเปน
ภาระตอหนาท่ีการงาน การดําเนินชีวิต การเปนอยูของตนเอง และผูอยูในความดูแลตลอดจนสังคม 
พยายามทําหนาท่ีตาง ๆ อยางเต็มความสามารถ 
   
แรงจูงใจภายในของตนเอง 
 นักจิตวิทยาท่ีใหความสนใจเกี่ยวกับแรงจูงใจภายใน คือ กลุมท่ีมองธรรมชาติของมนุษย
ออกมาในลักษณะท่ีวา การเรียนรูเกิดจากความตองการภายในของผูเรียนเปน แรงผลักจากภายใน 
(Active) ซึ่งหมายถึงกลุมมนุษยนิยมและกลุมท่ีมีความเช่ือเกี่ยวกับธรรมชาติของมนุษยวามนุษยมีแรง
ขับจากภายในท่ีจะทําส่ิงตาง ๆ ไดดวยตนเอง  โดยท่ีพิจารณาถึงอิทธิพลของส่ิงแวดลอม 
(Interactive) ซึ่งหมายถึง กลุมปญญานิยมท้ังสองกลุมใหความสนใจกับแรงจูงใจภายใน โดยท่ีแตละ
กลุมมีความคิดเกี่ยวกับเรื่องแรงจูงใจ ดังนี้ 
 ความเขาใจเก่ียวกับแรงจูงใจภายใน 
  ก. แนวความคิดของกลุมปญญานิยมเนนวาการแสดงพฤติกรรมของคนไดรับอิทธิพล
มาจากการรับรูส่ิงตาง ๆ ของบุคคลโดยกลุมปญญานิยมไดเสนอแนวความคิดเกี่ยวกับเรื่อง “แวดวง
ของชีวิต” (Life space) เพื่อท่ีจะอธิบายวา ทําไมแตละคนจึงแสดงพฤติกรรม ดังเชน ท่ีเปนอยูใน
ชวงเวลาใดเวลาหนึ่ง คนจะไดรับแรงจากหลายทิศทางท่ีจะกระตุนใหแสดงพฤติกรรมซึ่งการท่ีคน
แสดงพฤติกรรมนั้น เนื่องมาจากความไมสมดุลท่ีเกิดข้ึน คนเราจึงพยายามแสวงหาความรูหรือแสดง
พฤติกรรมเพื่อกอใหเกิดสภาพท่ีสมดุล 
   ข. แนวความคิดของกลุมมนุษยนิยมเกี่ยวกับแรงจูงใจภายในแนวความคิดของกลุม
มนษุยนิยมในเรื่องแรงจูงใจ คลายคลึงกับแนวความคิดของกลุมปญญานิยมกลุมนี้ อธิบายวาแรงท่ีมา
กระตุนใหคนแสดงพฤติกรรมนั้นคือ ความตองการความพอเพียงในชีวิตมองเห็นวา การแสดง
พฤติกรรมนั้นมิใชเปนเพื่อสนองความตองการทางดานรางกายเทานั้น เพราะเมื่อความตองการ
ทางดานรางกายไดรับการตอบสนองแลวคนก็ยังแสดงพฤติกรรมอยูส่ิงท่ีมากระตุนใหคนแสดง
พฤติกรรมนั้น คือ ความอยากรูอยากเห็น ซึ่งเปนตัวกระตุนใหคนอยากมีการสํารวจ หรือพูดงาย ๆ 
บางครั้งคนเราอาจจะทําอะไร ซึ่งดูแลวตลก หรือไมสมเหตุสมผลเพียงเพื่อสนองความอยากรูอยาก
เห็น 
 จากแนวคิดท้ังสองจะเห็นไดวาท้ังสองกลุมมีแนวคิดท่ีสอดคลองกันประการหนึ่งคือ เห็นวา
แรงจูงใจภายในนั้นเปนแรงขับท่ีเกิดจากภายในตัวผูกระทําเอง 
  ลักษณะการกระทําอันเนื่องมาจากแรงจูงใจภายใน 

เนื่องจากคนท่ีมีแรงจูงใจประเภทนี้จะเปนผูท่ีมีความสุขในการทําส่ิงตาง ๆ เพราะมีความพึง
พอใจ โดยตัวของมันเอง มิไดหวังรางวัลหรือคําชมเชย จึงมีแรงจูงใจท่ีจะทําส่ิงตาง ๆ อยางตอเนื่องไม
มีท่ีส้ินสุด ไมมีความเบ่ือหนาย จะเปนผูท่ีทํางานเพราะรักในงานถึงแมจะไมมีใครเห็น ไมมีใครชมหรือ
ทํางานแลวไมไดสองข้ัน ก็ไมเกิดความทอถอยเบ่ือหนาย เพราะเขามีความสุขของตนเอง คนประเภทนี้
ถาทําบุญก็เพราะตองการทําบุญ มิไดหวังผลตอบแทนใด ๆ ท้ังส้ิน ลักษณะของผูท่ีมีการกระทําอัน
เนื่องมาจากแรงจูงใจภายใน จะเปนผูท่ีทําส่ิงตาง ๆ เพื่อสนองความตองการของตัวเองไมตองคอย
หวาดวิตก หรือกังวลวาใครจะคิดอยางไรก็ตาม ทําใหสามารถทํางานไดเต็มท่ี เปนผูท่ีสามารถสราง
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สัมพันธภาพกับคนท่ัว ๆ ไปไดดี มิใชสรางพันธภาพเฉพาะบุคคลท่ีทําประโยชนใหไดเทานั้น เปนผูท่ี
ทํางานโดยมุงประโยชน สวนรวมมากกวาสวนตน 
 ท้ังนี้จากทฤษฎีแรงจูงใจของมนุษย อาจกลาไดวา มนุษยมีความตองการ และการสนองตอบ
ตอพฤติกรรมเชิงบวกโดยมีความตองการสัมฤทธิ์ผล เพื่อความสําเร็จ ความรัก และความตองการมี
อํานาจ โดยมีพลัง คือ แรงจูงใจทําหนาท่ีเปนตัวกระตุนใหคนมีการทําเพื่อไปสูจุดหมายปลายทาง 
 ดังนั้นกระบวนการปฏิบัติงานใด ๆ ก็ตามหากทําความเขาใจกับเรื่องแรงจูงใจไมวาจะเปน
แรงจูงใจภายในหรือภายนอก แรงจูงใจจะเปนตัวกระตุนใหคนแสดงพฤติกรรม ซึ่งมีการควบคุมไดเพื่อ
สรางความ   พึงพอใจในการทํางานใหสําเร็จหรือสัมฤทธิ์ผล และมีนักจิตวิทยาหลายทานไดแบง
ประเภทของแรงจูงใจ ดังนี้ 
 เอนกกุล  กรีแสง (2546 : 36 – 40) แบงแรงจูงใจออกเปน 3 ประเภท คือ  
 1. แรงจูงใจทางรางกาย (Physiological Motives) เปนแรงจูงใจท่ีเกิดจากความตองการทาง
รางกาย เชน ความหิว ความกระหาย การพักผอน การขับถายและความตองการทางเพศ เปนตน 
 2. แรงจูงใจทางสังคม (Social Motives) เปนแรงจูงใจท่ีเกิดข้ึนในภายหลังเปนส่ิงท่ีเกิดข้ึน
จากการเรียนรู 
 3. แรงจูงใจสวนบุคคล (Personal Motives) แรงจูงใจประเภทนี้ หมายถึง แรงจูงใจท่ี
พัฒนาข้ึนในตัวตน ซึ่งจะแตกตางกันไปไมเหมือนกัน แรงจูงใจ สวนบุคคล มีรากฐานมาจากความ
ตองการทางรางกาย และความตองการทางสังคมประกอบกัน แตความรุนแรงจะมากนอยตางกัน เชน 
ในเรื่องความตองการสะสมส่ิงของตาง ๆ เปนตน แรงจูงใจสวนบุคคลท่ีสําคัญและเห็นไดชัดคือ การ
ติดยา หากไมไดเสพแลวจะเกิดอาการผิดปกติกับรางกาย สําหรับรายท่ีติดยาอยางรุนแรงอาจถึงกับฆา
ตัวตายหรือกออาชญากรรม และอีกประการหนึ่งคือ ระดับความมุงหวัง หมายถึง ขอบเขตของความ
มุงหวังท่ีกําหนดไวซึ่งแตละคนต้ังระดับความมุงหวังไวไมเหมือนกัน และจะเปล่ียนแปลงไดเสมอ 
 กมลรัตน  หลาสุวงษ (2552 : 227) ไดแบงแรงจูงใจเปน 2 ประเภท คือ  
 1. แรงจูงใจทางดานรางกาย (Physical Motivation) เปนแรงจูงใจท่ีมีติดตัวมาแตเกิด มี
ความจําเปนในการดําเนินชีวิต ซึ่งเกิดจากความตองการทางรางกาย ไดแก ความตองการอาหาร น้ํา 
การพักผอน การไดรับความคุมครอง ความปลอดภัย การไดรับความเพลิดเพลิน การลดความ
เครงเครยีด ความตองการทางเพศ ความกระหายน้ํา เปนตน 
 2. แรงจูงใจทางดานสังคม (Social Motivation) เปนแรงจูงใจท่ีเกิดข้ึนทันทีหลังจากการ
เรียนรูในสังคม ไดแก ความตองการความรัก ความอบอุน การเปนท่ียอมรับในสังคม ความมีเกียรติ
ไดรับความยกยองชมเชย เปนตน 
 สวนถวิล เกื้อกูลวงศ (2552 : 94 - 114) กลาววา แรงจูงใจประกอบดวยลักษณะตาง ๆ 
ดังตอไปนี้ 
 1. แรงจูงใจดานความมั่นคง มักอยูในรูปของจิตสํานึกโดยท่ีจะเห็นไดจากการท่ีมนุษยมีความ
ตองการความปลอดภัย สวนความมั่นคงในรูปของจิตใตสํานึกนั้นเปนส่ิงท่ีไดพัฒนามาต้ังแตเกิด โดย
การปฏิสัมพันธกับบุคคลท่ีอยูใกลชิดท่ีจะทําเปนคนท่ีมีจิตใจมั่นคงหรือออนแอ 
 2. แรงจูงใจดานสังคม เนื่องจากมนุษยเปนสัตวสังคม จึงตองมีการติดตอสัมพันธซึ่งกันและ
กัน และมีการอยูรวมกันกับผูอื่น เพื่อจะไดเปนสวนหนึ่งของสังคม และไดรับการยกยองการท่ีบุคคล
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ติดตอสัมพันธกันนั้นมิใชเพื่อมิตรภาพเพียงอยางเดียวเสมอไป หากแตตองการใหผูอื่นยอมรับศรัทธา
และเช่ือถือ 
 3. แรงจูงใจในดานช่ือเสียง แรงจูงใจดานช่ือเสียงนี้มีมากข้ึนทุกท่ีในสังคมไทย โดยเฉพาะ
สังคมในระดับชนช้ันกลาง ความตองการดานช่ือเสียงเปนการกําหนดขีดจํากัดของบุคคลอยางหนึ่ง 
บุคคลบางคนมีความพึงพอใจกับช่ือเสียงในระดับเพื่อนหรือในระดับชุมชนเทานั้น แตบางคนก็อาจ
แสวงหาช่ือเสียงในระดับชาติหรือระดับโลก 
 4. แรงจูงใจดานอํานาจ อํานาจเปนศักยภาพแหงอิทธิพลของบุคคล แบงออกเปน 2 ประเภท 
คือ อํานาจตามตําแหนง และอํานาจสวนตัว เชน บุคคลท่ีสามารถทําใหผูอื่นปฏิบัติตามเพราะ
ตําแหนงหนาท่ีนั้นแสดงวาเปนผูมีอํานาจตามตําแหนง สวนบุคคลซึ่งมีอิทธิพล โดยบุคลิกภาพและ
พฤติกรรมแสดงวาเปนผูมีอํานาจสวนตัว แตบางคนเปนเจาของอํานาจท้ังสองประเภท คือ ท้ังอํานาจ
ตามตําแหนงและอํานาจสวนตัว 
 5. แรงจูงใจดานความสามารถ ความสามารถ หมายถึง การควบคุมองคประกอบส่ิงแวดลอม
ท้ังกายภาพและสังคม ความรูสึกดานความสามารถนี้เกี่ยวของอยางใกลชิดกับมโนทัศนดานความ
คาดหวังบุคคลจะมีความสามารถหรือไมนั้นข้ึนอยูกับความสําเร็จและความลมเหลวในอดีต ถา
ความสําเร็จอยูเหนือความลมเหลวแลว ความรูสึกดานความสามารถจะมีแนวโนมสูงทําใหบุคคลมอง
โลกในแงบวก และมองสถานการณตาง ๆ วาเปนส่ิงทาทายนาสนใจและสามารถท่ีจะเอาชนะได แตถา
ความลมเหลวอยูเหนือความสําเร็จแลว จะทําใหบุคคลมองโลกในแงลบ และบุคคลท่ีมีความรูสึกตํ่าจะ
ไมมีเหตุจูงใจท่ีจะแสวงหาการทาทายใหม ๆ หรือทําการเส่ียงบุคคลเหลานี้จะปลอยใหส่ิงแวดลอม
บังคับควบคุมและบังคับส่ิงแวดลอม 
 6. แรงจูงใจดานความสําเร็จ เปนแรงจูงใจท่ีเดนชัดของมนุษยท่ีสามารถแยกความตองการ
ดานอื่น ๆ ลักษณะอยางหนึ่งของบุคคลท่ีมีแรงจูงใจดานความสําเร็จ คือ มีความพอใจในความสําเร็จ
สวนตัวมากกวารางวัลของความสําเร็จ ความสําเร็จท่ีไดรับมีคามากกวาเงินทองและคํายกยอง
สรรเสริญ บุคคลประเภทนี้จะมีความกาวหนาในการงานเพราะวาจะเปนผูสรางสรรคใหงานสําเร็จ 
 7. แรงจูงใจดานเงิน เงินเปนแรงจูงใจท่ีสลับซับซอนและสัมพันธกับความตองการทุกประเภท 
ทุกระดับ คุณลักษณะท่ีเดนและสําคัญท่ีสุดของเงิน ตัวเงินนั้นไมไดมีความสําคัญแตเปนตัวแทนของ
ความตองการใด ๆ ท่ีบุคคลตองการใหเปนตัวแทน 
  สงวน  สุทธิเลิศอรุณ (2528 : 63-64) ไดแบงแรงจูงใจออกเปน 2 ประเภท คือ 
 1. แรงจูงใจภายใน (Intrinsic Motivation) หมายถึง แรงจูงใจท่ีเกิดจากภายในตัวบุคคล ซึ่ง
มีผลตอการกระตุนใหบุคคลแสดงพฤติกรรมอยางใดอยางหนึ่งตามความตองการหรือตามจุดมุงหมาย
ท่ีกําหนดไว แรงจูงใจภายในมีความสําคัญมากกวาแรงจูงใจภายนอก เพราะวาแรงจูงใจภายในเกิด
จากความรูสึกของบุคคล เมื่อบุคคลรูสึกเชนใดก็จะแสดงพฤติกรรมตอบสนองความรูสึกของตนเสมอ 
สวนแรงจูงใจภายนอกนั้นบุคคลอาจเกิดจากความรูสึกเฉย ๆ ก็ไดสําหรับตัวอยางของแรงจูงใจภายใน 
ไดแก 
  1.1 ความยากเห็น ทําใหบุคคลคนควาเพิ่มเติมหรือเกิดไทยมุงได 
  1.2 ความสนใจ ทําใหบุคคลไตถาม หรือจองมอง เปนตน 
  1.3 ความรัก ทําใหหูหนวกตาบอด 
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  1.4 ความอบอุน ทําใหสบายใจ 
  1.5 ความเห็นอกเห็นใจ ทําใหเกิดการคลอยตาม หรือตามใจ 
  1.6 ความสงสาร ทําใหเกิดการใหอภัย 
  1.7 ความสําเร็จ ทําใหบุคคลเกิดความภาคภูมิใจ 
  1.8 ความหิว ทําใหบุคคลปรับพฤติกรรมได 
  1.9 ความตองการ ทําใหบุคคลเปนอะไรหรือทําอะไรก็ได 
  1.10 ความพอใจ ทําใหบุคคลยินดีและทําอะไรก็ได 
  1.11 ความศรัทธา ทําใหบุคคลเกิดการยอมรับและทําอะไรก็ได 
  1.12 ความซาบซึ้ง ทําใหบุคคลแสดงพฤติกรรมตาง ๆ ได 
 2. แรงจูงใจภายนอก (Extrinsic Motivation) หมายถึง แรงจูงใจท่ีเกิดจากภายนอกตัว
บุคคล ซึ่งมีผลตอการกระตุนใหบุคคลแสดงพฤติกรรมอยางใดอยางหนึ่งตามความตองการหรือตาม
จุดมุงหมายท่ีกําหนดไว แรงจูงใจภายนอกท่ีสําคัญ ไดแก การแขงขัน การรวมมือ บุคลิกภาพของครู 
วิธีการสอนครู การใหรางวัล การลงโทษ และการใชส่ือการสอน เปนตน 
 นอกจากการแบงประเภทดังกลาวแลว สงวน สุทธิเลิศอรุณ ยังไดแบงแรงจูงใจตามพื้นฐาน
ทางสังคม เปน 3 ประเภท คือ 
 1. แรงจูงใจใฝสัมพันธ (Afflictive Motive) แรงจูงใจชนิดนี้เกิดข้ึนเนื่องจากสัญชาตญาณใน
การรวมกลุมของมนุษยเพื่อชวยเหลือกันเพื่อความอยูรอดของสังคมเอื้อเฟอแสดงไมตรีตอกัน เปน
แรงจูงใจของบุคคลท่ีจะชวยเหลือเกื้อกูลกันอยางผูกมิตรไมตรี 
 2. แรงจูงใจใฝอํานาจ (Power Motive) แรงจูงใจชนิดนี้เกิดข้ึนเนื่องจากสัญชาตญาณในการ
เปนผูนําของบุคคล เพื่อท่ีจะใหไดมาซึ่งอํานาจ และอํานาจจะบันดาลใหเกิดผลตามท่ีตองการอีกหลาย
อยาง อันอาจจะเปนท่ียอมรับหรือยกยองของสังคม 
 3. แรงจูงใจใฝสัมฤทธิ์ (Achievement Motive) หมายถึง ความปรารถนาท่ีจะทําส่ิงหนึ่งส่ิง
ใดสําเร็จลุลวงไปดวยดีไดผลเปนเยี่ยม หรือไดผลดีกวาบุคคลอื่น ๆ โดยทุมเท ความพยายามท้ังหมดท่ี
มีอยูจนประสบความสําเร็จ ไดรับคํายกยองชมเชย หรือไดรับรางวัล 
    บุคคลท่ีไดช่ือวาเปนผูทํางานไดอยางสัมฤทธิ์ผลนั้น จะตองเปนไปใน 3 ลักษณะ คือ 
  1. มีความตองการในการทํางานใหสําเร็จอยูในระดับสูง หรือตองการทํางานใหได
มาตรฐานจริง ๆ  
  2. เปนงานสรางสรรคท่ีบงบอกใหรูถึงเอกลักษณวาชอบงานนั้นอยางเปนชีวิตจิตใจมี
ความรูสึกเปนเจาของงานนั้น ๆ  
  3. เปนงานท่ีตองใชเวลานาน อาศัยความอดทนอยางยอดเยี่ยม ซึ่งช้ีใหเห็นถึงวาเปน
ผูมีแรงจูงใจใฝสัมฤทธิ์ คือ มีความต้ังใจท่ียาวนานในการทํางาน 
 กิตติ  ตยัคคานนท (2533 : 120) ไดแบงแรงจูงใจออกไดเปน 2 ประเภท คือ 
 1. แรงจูงใจท่ีเกิดจากส่ิงเราภายในรางกาย หรือแรงจูงใจท่ีเกิดข้ึนภายใน ดานบุคคลเอง เชน 
ความหิวกระหาย ความรัก เปนตน 
 2. แรงจูงใจท่ีเกิดจากส่ิงเราภายนอกรางกาย เชน การไดรับรางวัล คาตอบแทนเงินเดือน 
ยศถาบรรดาศักด์ิ การยอมรับหรือการยกยองนับถือจากบุคคลอื่น ๆ เปนตน 
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 ส่ิงเราท้ังสองประเภทนี้คือ ตัณหาหรือความอยากตามหลักของพระพุทธศาสนานั่นเองหรือ
จะพูดอีกอยางหนึ่งก็ไดวา แรงจูงใจนั้นเกิดจากตัณหาของมนุษย 
 ฮิลการด (Hilgard. 1981 : 321 – 322) แบงแรงจูงใจออกเปน 3  ประเภท คือ 
 1. แรงจูงใจเพื่อการอยูรอด (The Survival Motive) หมายถึง ความตองการทางกาย 
(Physiological Needs) ซึ่งเปนส่ิงท่ีจะขาดเสียมิได เชน ความตองการน้ํา ความตองการอาหาร 
ความตองการอุณหภูมิพอเหมาะ ความตองการในการขับถายของเสีย ความตองการพักผอน และ
ความตองการทํากิจกรรม 
 2. แรงจูงใจทางสังคม (The Social Motives) หมายถึง แรงจูงใจอันเกิดจากความตองการ
ทางสังคม (Social Needs) ของมนุษยในการเกี่ยวของสัมพันธกับบุคคลอื่นไดแก ความตองการความ
รัก (Need for Affection) ความตองการตําแหนงในสังคม (Need for Social Status) ความ
ตองการทางเพศ (Sex Need) ความตองการเหลานี้กระตุนใหเกิดแรงจูงใจ (Motives) ใหคนเรา
กระทําพฤติกรรมทางสังคม (Social Behavior)  
 3. แรงจูงใจในทางอวดตน (Ego integrative Motives) หมายถึง แรงจูงใจอันเกิดจากความ
ตองการความสําเร็จ (Need for Success) ความตองการปรัชญาชีวิตท่ีนาพอใจ ความตองการในการ
สรางและประดิษฐ เพื่อใหเกิดความรูสึกนับถือตนเอง (Self respect) ซึ่งจะเปนทางใหบุคคลสามารถ
หลีกเล่ียงจากการมีปมดอย (Inferiorly Complex) และความรูสึกวาตนไมมีคา (Self depreciation) 
หรือจะกลาวอีกนัยหนึ่งวาตนจะไดมีความรูสึกวาตนมีความสามารถ (Sense of Attainment) สวน
แรงจูงใจท่ีเกิดจากความตองการปรัชญาชีวิตท่ีนาพอใจ (Satisfying Philosophies of Life) นั้น ก็
เพื่อบุคคลจะไดเปนท่ีนานิยมยกยองของตนอื่นในสังคมดวย 
 มอรแกน และคิง (Morgan and King. 1966 : 281) ไดแบงแรงจูงใจออกเปน 2 ประเภท 
คือ 
 1. ความตองการผูกพันกับผูอื่น (Affiliation Needs) เพราะมนุษยเปนสัตวสังคมจึง
จําเปนตองอยูรวมกับผูอื่นนอกเหนือจากพอแม พี่นอง ความผูกพันกันนั้นทําใหเกิดความพึงพอใจและ
สบายใจในการท่ีจะอยูรวมกันหรือทํางานเกี่ยวของกันเพื่อสนองความตองการตาง ๆ  
 2. ความตองการฐานะ (Status Needs) ในชุมชนท่ีอาศัยอยูดวยกันเปนจํานวนมาก การ
แบงแยกระดับช้ันจะเกิดข้ึนเสมอ คนสวนมากจึงพยายามจะสรางฐานะของตนเองใหทัดเทียมหรือให
ดีกวาคนอื่น ๆ ในสังคมเดียวกัน ซึ่งมีหลายรูปแบบ เชน อยากไดตําแหนง (Rank) อยากไดเกียรติยศ
และอํานาจ (Prestige and Power)   
 เออชูเบล (Ausubel. 1968 : 368 – 379 อางใน ทองหลอ นาคหอม. 2535 : 16)  ไดกลาว
วา แรงจูงใจเกิดข้ึนมาจากความตองการของบุคคล 6 ประการดวยกัน คือ 
 1. ความตองการใฝรู 
 2. ความตองการการเปล่ียนแปลง 
 3. ความตองการการเคล่ือนไหว 
 4. ความตองการเปนท่ียอมรับในสังคม 
 5. ความตองการความรู 
 6. ความตองการช่ือเสียง 
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 ตามท่ีนักจิตวิทยาไดแบงแรงจูงใจออกเปนประเภทตาง ๆ แลวนั้นสามารถ สรุปประเภท
แรงจูงใจ ออกเปน 2 ประเภทใหญ คือ  

1. การจูงใจภายใน (Intrinsic Motivation) 
หมายถึง สภาวะของบุคคลท่ีมีความตองการในการทํา การเรียนรู หรือแสวงหาบางอยางดวย

ตนเอง โดยมิตองใหมีบุคคลอื่นมาเกี่ยวของ เชน นักเรียนสนใจเลาเรียนดวยความรูสึกใฝดีในตัวของ
เขาเอง ไมใชเพราะถูกบิดามารดาบังคับ หรือเพราะมีส่ิงลอใจใดๆ การจูงใจประเภทนี้ไดแก 

1.1 ความตองการ (Need) เนื่องจากคนทุกคนมีความตองการท่ีอยูภายใน อันจะทําให
เกิดแรงขับ แรงขับนี้จะกอใหเกิดพฤติกรรมตาง ๆ ข้ึน เพื่อใหบรรลุเปาหมาย และความพอใจ  

1.2 เจตคติ (Attitude) หมายถึง ความรูสึกนึกคิดท่ีดีท่ีบุคคลมีตอส่ิงหนึ่งส่ิงใด ซึ่งจะ
ชวยเปนตัวกระตุนใหบุคคลทําในพฤติกรรมท่ีเหมาะสม เชน เด็กนักเรียนรักครูผูสอน และพอใจ
วิธีการสอน ทําใหเด็กมีความสนใจ ต้ังใจเรียน เปนพิเศษ 

1.3 ความสนใจพิเศษ (Special Interest) การท่ีเรามีความสนใจในเรื่องใดเปนพิเศษ ก็
จัดวาเปนแรงจูงใจใหเกิดความเอาใจใสในส่ิงนั้น ๆ มากกวาปกติ  

2. การจูงใจภายนอก (Extrinsic Motivation) 
หมายถึง สภาวะของบุคคล ท่ีไดรับแรงกระตุนมาจากภายนอกใหมองเห็นจุดหมายปลายทาง 

และนําไปสูการเปล่ียนแปลงหรือการแสดงพฤติกรรมของบุคคล แรงจูงใจเหลานี้ไดแก 
2.1 เปาหมายหรือความคาดหวังของบุคคล คนท่ีมีเปาหมายในการกระทําใด ๆ ยอม

กระตุนใหเกิดแรงจูงใจใหมีพฤติกรรมท่ีดีและเหมาะสม  เชน พนักงานทดลองงาน มีเปาหมายท่ีจะ
ไดรับการบรรจุเขาทํางาน จึงพยายามต้ังใจทํางานอยางเต็มความสามารถ 

2.2 ความรูเกี่ยวกับความกาวหนา คนท่ีมีโอกาสทราบวาตนจะไดรับความกาวหนา
อยางไรจากการกระทํานั้น ยอมจะเปนแรงจูงใจใหต้ังใจและเกิดพฤติกรรมข้ึนได  

2.3 บุคลิกภาพ ความประทับใจอันเกิดจากบุคลิกภาพ จะกอใหเกิดแรงจูงใจใหเกิด   
พฤติกรรมข้ึนได เชน ครู อาจารย ก็ตองมีบุคลิกภาพทางวิชาการท่ีนาเช่ือถือ นักปกครอง ผูจัดการ     
จะตองมีบุคลิกภาพของผูนําท่ีดี เปนตน 

2.4 เครื่องลอใจอื่นๆ  มีส่ิงลอใจหลายอยางท่ีกอใหเกิดแรงกระตุนใหพฤติกรรมข้ึน เชน 
การใหรางวัล (Rewards) อันเปนเครื่องกระตุนใหอยากกระทํา หรือการลงโทษ (Punishment) ซึ่งจะ
กระตุนมิใหกระทําในส่ิงท่ีไมถูกตอง นอกจากนี้การชมเชย การติเตียน การประกวด การแขงขัน หรือ
การทดสอบก็จัดวาเปนเครื่องมือท่ีกอใหเกิดพฤติกรรมไดท้ังส้ิน 
 
การรับรูความสามารถของตนเอง 

แนวคิดการรับรูความสามารถของตนเอง (Self-Efficacy) คือ การรับรูความสามารถของ
ตนเองนั้นมีผลตอการกระทําของบุคคล บุคคลแตละคนอาจจะ มีความสามารถไมตางกันแตอาจ
แสดงออกในคุณภาพท่ีแตกตางกันไดการรับรูความสามารถของตนเองนั้น เปนการตัดสิน
ความสามารถของตนเองปจจัยท่ีเกี่ยวของกับการรับรูความสามารถของตนเอง ม ี 4  ปจจัย คือ  
  1.  ประสบการณท่ีประสบความสําเร็จ ( Mastery Experiences  )  บุคคลจะเช่ือวาเขา
สามารถท่ีจะทําได ดังนั้นในการพัฒนาการรับรูความสามารถของตนเองนั้นจําเปนจะตองฝกใหเขามี
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ทักษะเพียงพอท่ีจะประสบความสําเร็จไดพรอมๆกับการทําใหเขารูวา เขามีความสามารถท่ีจะกระทํา
เชนนั้น จะทําใหเขาไดรับทักษะท่ีไดรับการฝกไดอยางมีประสิทธิภาพท่ีสุด บุคคลท่ีรับรูวาตนเองมี
ความสามารถนั้นจะไมยอมแพอะไรงายๆ แตจะพยายามทํางานตางๆเพื่อใหบรรลุเปาหมายท่ีตองการ 
  2.  การใชตัวแบบ ( Modeling )  การไดสังเกตตัวแบบแสดงพฤติกรรมท่ีมีความซับซอนและ
ไดรับผลการกระทําท่ีตนพอใจก็จะทําใหผู ท่ีสังเกตฝก มีความรู สึกวาเขาก็จะสามารถประสบ
ความสําเร็จได ถาเขาพยายามจริงและไมยอทอ ลักษณะของตัวแบบท่ีสงผลถึงความรูสึกวาเขามี
ความสามารถท่ีจะกระทําไดนั้นไดแก  การแกปญหาของบุคคลท่ีมีความกลัวตอส่ิงตางๆ โดยท่ีใหดูตัว
แบบท่ีมีลักษณะคลายกันเองก็สามารถทําใหลดความกลัวตางๆ เหลานั้นได 
  3.  การใชคําพูดชักจูง ( Verbal Persuation ) เปนการบอกวาบุคคลนั้นมีความสามารถท่ีจะ
ประสบความสําเร็จได โดยการใชคําพูดชักจูงพรอมกับและควรจะใชรวมกับการทําใหบุคคลมีประสบ 
การณของความสําเร็จซึ่งอาจจะตองคอยๆสรางความสามารถใหกับบุคคลอยางคอยเปนคอยไปและให
เกิดความสําเร็จตามลําดับ พรอมท้ังการใชคําพูดชักจูงรวมกันก็จะทําใหบุคคลสามารถรับรู
ความสามารถของตนเอง 
  4.  การกระตุนทางอารมณ ( Emotional Arousal  ) เปนการกระตุนทางอารมณท่ีมีผลตอ
การรับรูความสามารถของตน บุคคลท่ีถูกกระตุนอารมณทางลบเชน การอยูในสภาพท่ีถูกขมขู จะทํา
ใหเกิดความวิตกกังวลและความเครียด กลัว บุคคลประเภทนี้จะทําใหการรับรูตนเองตํ่า ถาอารมณ
และลักษณะดังกลาวเกิดมากข้ึนก็จะทําใหบุคคลไมสามารถแสดงออกไดนําไปสูประสบการณของ
ความลมเหลวและบุคคลก็จะมีรับรูเกี่ยวกับความสามารถรับรูตนเองตํ่าลง  แตถาบุคคลสามารถลด
หรือระงับการถูกกระตุนทางอารมณไดจะทําใหบุคคลสามารถรับรูไดดีข้ึนอันนําไปสูการแสดงออกทาง
พฤติกรรมของบุคคลดีดวย 
  การรับรูความสามารถของตนเองนั้น มีผลตอการกระทําของบุคคล บุคคล 2 คน อาจมี
ความสามารถไมตางกัน แตอาจแสดงออกในคุณภาพท่ีแตกตางกันได ถาพบวาคน 2 คนนี้มีการรับรู
ความสามารถของตนเองแตกตางกัน ในคนคนเดียวกเ็ชนกัน ถารับรูความสามารถของตนเองในแตละ
สภาพการณแตกตางกัน ก็อาจจะแสดงพฤติกรรมออกมาไดแตกตางกันเชนกัน Bandura เห็นวา 
ความสามารถของคนเรานั้นไมตายตัว หากแตยืดหยุนตามสภาพการณ ดังนั้นส่ิงท่ีจะกําหนด
ประสิทธิภาพของการแสดงออกจึงข้ึนอยูกับ การรับรูความสามารถของตนเองในสภาวการณนั้น ๆ 
นั่นเอง นั่นคือถาเรามีความเช่ือวาเรามีความสามารถ เราก็จะแสดงออกถึง ความสามารถนั้นออกมา 
คนท่ีเช่ือวาตนเองมีความสามารถจะมีความอดทน อุตสาหะ ไมทอถอยงาย และจะประสบ
ความสําเร็จในท่ีสุด (Evans, 1989) 
  มักมีคําถามวาการรับรูความสามารถของตนเองนั้น เกี่ยวของหรือแตกตางอยางไรกับความ
คาดหวัง ผลท่ีจะเกิดข้ึน (Outcome Expectation) เพื่อใหเขาใจและชัดเจน Bandura (1997) ได
เสนอภาพแสดงความแตกตางระหวางการรับรูเกี่ยวกับ ความสามารถของ ตนเอง และความคาดหวัง
ผลท่ีจะเกิดข้ึน ดังภาพ 
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ภาพท่ี 3 ความสัมพันธระหวางการรับรูความสามารถของตนเอง และความคาด หวังผลท่ีจะเกิดข้ึน 

 
จากภาพท่ี 3 แสดงใหเห็นถึงความแตกตาง ระหวางการรับรูความสามารถของตนเองและ

ความคาด หวังผลท่ีจะเกิดข้ึน (Bandura, 1977) การรับรูความสามารถของตนเอง เปนการตัดสิน
ความสามารถของตนเองวา จะสามารถทํางานไดในระดับใด ในขณะท่ีความคาดหวัง เกี่ยวกับผลท่ีจะ
เกิดข้ึนนั้น เปนการตัดสินวาผลกรรมใดจะเกิดข้ึนจากการกระทําพฤติกรรมดังกลาว อยางเชนท่ี
นักกีฬา มีความเช่ือวา เขากระโดดไดสูงถึง 6 ฟุต ความเช่ือดังกลาวเปนการตัดสินความสามารถของ
ตนเอง การไดรับการยอมรับจากสังคม การไดรับรางวัล การพึงพอใจในตนเองท่ีกระโดดไดสูงถึง 6 
ฟุต เปนความคาดหวังผลท่ีจะเกิดข้ึน แตจะตองระวังความเขาใจผิดเกี่ยวกับ ความหมาย ของคําวา 
ผลท่ีเกิดข้ึน ผลท่ีเกิดข้ึนในท่ีนี้จะหมายถึง ผลกรรมของการกระทําพฤติกรรมเทานั้น มิไดหมายถึงผล 
ท่ีแสดงถึง การกระทําพฤติกรรม เพราะวาผลท่ีแสดงถึงการกระทําพฤติกรรมนั้นจะพิจารณาวา 
พฤติกรรมนั้น สามารถทําไดตาม การตัดสินความสามารถของตนเองหรือไม นั่นคือจะกระโดดไดสูงถึง 
6 ฟุตหรือไม ซึ่งการจะกระโดดไดสูงถึง 6 ฟุตหรือไมนั้น มิใชเปนการคาดหวังผลท่ีจะเกิดข้ึน ซึ่งมุงท่ี
ผลกรรมท่ีจะไดจากการกระทําพฤติกรรมดังกลาว การรับรูความสามารถของตนเอง และความ
คาดหวังผลท่ีจะเกิดข้ึนนั้นมีความสัมพันธกันมาก โดยท่ีความสัมพันธระหวางตัวแปรท้ังสองนี้ มีผลตอ
การตัดสินใจ ท่ีจะกระทําพฤติกรรมของบุคคลนั้น ๆ ซึ่งจะเห็นไดจากภาพความคาดหวังเกี่ยวกับ ผลท่ี
จะเกิดข้ึนดังกลาวแนนอน แตถามีเพียงดานใดสูงหรือตํ่า บุคคลนั้นมีแนวโนมจะไมแสดงพฤติกรรม 
   วิธีการพัฒนาการรับรูความสามารถของตนเอง  

การพัฒนาการรับรูความสามารถของตนเองนั้น Bandura ไดเสนอแหลงขอมูลในการสราง
การรับรูความสามารถของตนเอง โดยการท่ีคนเราจะสรางการรับรูความสามารถของตนเองตอเรื่องใด
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เรื่องหนึ่งนั้น เกิดจากการเรียนรูขอมูลท่ีไดจากแหลงตางๆ (Bandura, 1977; 1986; 1997) 4 แหลง
ดังนี้ 

1. ประสบการณความสําเร็จของตนเอง (Enactive mastery experience) เปนวิธีการท่ีมี
ประสิทธิภาพมากท่ีสุด ในการพัฒนาการรับรูความสามารถของตนเอง เนื่องจากวาเปนประสบการณ
โดยตรง การประสบความสําเร็จทําใหเพิ่มความสามารถของตนเอง บุคคลจะเช่ือวาเขาสามารถท่ีจะ
ทําได การกระทํากิจกรรมจนเกิดความสําเร็จ จะชวยสงผลใหบุคคลมีการรับรูความสามารถของตนเอง
สูง โดยเช่ือวาถาหากใหกระทํากิจกรรมนั้นอีกหรือกระทํากิจกรรมท่ีมีลักษณะคลายคลึงกัน จะ
สามารถกระทํากิจกรรมนั้นไดสําเร็จซ้ําอีก ความสําเร็จหลายๆ ครั้งท่ีไดรับจะชวยสรางระดับพลัง
ความเช่ือท่ีแรงกลาในการรับรูความสามารถของตนเอง แตความลมเหลวซ้ําแลวซ้ําเลาจะบ่ันทอน
ความเช่ือในการรับรูความสามารถของตนเอง โดยเฉพาะอยางยิ่งถาความลมเหลวนั้นเกิดข้ึนกอนท่ี
ความเช่ือมั่นในความสามารถของตนเองจะถูกสรางข้ึน ถาหากบุคคลใดไดสรางความเช่ือม่ันใน
ความสามารถของตนเองข้ึนมาแลว ก็มักจะมีความพยายามในการทํากิจกรรมท่ีกําหนด และถึงแม
จะตองเผชิญกับอุปสรรคตางๆ ก็ไมยอทองาย ประสบการณของการไดรับความสําเร็จมากอนเปน
แหลงท่ีมาท่ีสําคัญและมีอิทธิพลมากท่ีสุดในการสรางการรับรูความสามารถของตนเอง (Percieved 
self-efficacy) 
          2. การใช “ตัวแบบ” (Model) หรือการสังเกตประสบการณ (Vicarious experience) จาก
ตัวแบบท่ีประสบความสําเร็จหรือความลมเหลวจากการกระทําในเรื่องใดเรื่องหนึ่ง ยอมมีผลตอการ
รับรูความสามารถของผูสังเกตในเรื่องนั้นๆ ดวย โดยเฉพาะอยางยิ่งถาตัวแบบนั้นมีลักษณะหรืออยูใน
สถานการณท่ีคลายคลึงกับผูสังเกตมากเทาไร ก็ยิ่งมีอิทธิพลมากข้ึน การท่ีไดสังเกตตัวแบบแสดง
พฤติกรรมท่ีมีความซับซอนและไดรับผลลัพธท่ีพึงพอใจ ก็จะทําใหผูสังเกตรูสึกวาเขาก็สามารถท่ีจะ
ประสบความสําเร็จได ถาเขาพยายามจริงและไมยอทอ Bandura จึงมีความเช่ือวาคนเราสวนใหญนั้น
จะตองผานการเรียนรูโดยการสังเกตพฤติกรรมจากผูอื่นมาแทบท้ังส้ิน 
         การใชตัวแบบประกอบดวย 4 กระบวนการดังนี ้
           กระบวนการท่ี 1 กระบวนการต้ังใจ (Attentional processes) บุคคลไมสามารถ
เรียนรูไดจากการสังเกต ถาเขาไมมีความต้ังใจและรับรูอยางแมนยําถึงพฤติกรรมท่ีตัวแบบแสดงออก 
การต้ังใจจะเปนตัวกําหนดวาบุคคลจะสังเกตอะไรจากตัวแบบนั้น องคประกอบท่ีมีผลตอกระบวนการ
ต้ังใจ แบงออกเปน 2 องคประกอบ ไดแก องคประกอบของตัวแบบเอง ตัวแบบท่ีทําใหบุคคลมีความ
ต้ังใจท่ีจะสังเกต ตองเปนตัวแบบท่ีมีลักษณะเดนชัด เปนตัวแบบท่ีทําใหผูสังเกตเกิดความพึงพอใจ 
พฤติกรรมท่ีแสดงออกไมซับซอนมาก เขาใจงาย และพฤติกรรมของตัวแบบท่ีแสดงออกควรมีคุณคาใน
การใชประโยชน นอกจากนี้ยังมีองคประกอบของผูสังเกต ไดแก ความสามารถในการรับรูของผูสังเกต 
ซึ่งรวมถึงการเห็น การไดยิน การรับรูรส กล่ินและสัมผัส ระดับของการรับรูความสามารถทางปญญา 
ระดับของการต่ืนตัว และความชอบท่ีเคยเรียนรูมากอนแลว 
           กระบวนการท่ี 2 กระบวนการเก็บจํา (Retention processes) บุคคลตองจดจํา
ลักษณะของตัวแบบ แลวแปลงขอมูลจากตัวแบบเปนรูปของสัญลักษณและจัดโครงสรางเพื่อใหจดจํา
งาย การท่ีบุคคลมีการเก็บความทรงจํา จึงสามารถแสดงพฤติกรรมเลียนแบบหรือแสดงพฤติกรรม
เลียนแบบภายหลังการสังเกตพฤติกรรมของตัวแบบผานไประยะเวลาหนึง่ 
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           กระบวนการท่ี 3 กระบวนการกระทํา (Production processes) เปนกระบวนการ
ท่ีผูสังเกตแปลงสัญลักษณท่ีเก็บจําไวนั้นมาเปนการกระทํา การไดขอมูลยอนกลับ จากการกระทําของ
ตนเอง และเทียบเคียงการกระทํากับภาพท่ีจําได จะชวยใหผูสังเกตสามารถปรับปรุง แกไขพฤติกรรม
ของตนและการเลียนแบบจนเปนท่ีพอใจ 
           กระบวนการท่ี 4 กระบวนการจูงใจ (Motivational processes) พฤติกรรมท่ีผู
สังเกตเรียนรูจากการสังเกตตัวแบบ อาจแสดงออกมาหรือไมก็ไดยอมข้ึนกับส่ิงลอใจภายนอก ถา
พฤติกรรมของตัวแบบไดผลลัพธท่ีนาพอใจหรือสามารถหลีกเล่ียงผลลัพธท่ีไมพึงพอใจ จะมีแนวโนม
เลียนแบบสูง เพราะบุคคลเกิดความคาดหวังในผลลัพธเชนเดียวกับตัวแบบหรือเกิดความรูสึกแฝงวา
ตนคือผูไดรับผลลัพธท่ีนาพอใจนั้น 
         ประเภทของตัวแบบแบงเปน 2 ประเภทดังนี้ (Bandura, 1977) คือ ประเภทท่ี 1 ตัวแบบท่ี
เปนบุคคลจริงๆ (Live modeling) คือ ตัวแบบท่ีบุคคลไดมีโอกาสสังเกตและมีปฏิสัมพันธโดยตรง 
และประเภทท่ี 2 ตัวแบบท่ีเปนสัญลักษณ (Symbolic modeling) คือ ตัวแบบท่ีเสนอผานส่ือตางๆ 
เชน วิทยุ โทรทัศน การตูน หนังสือ ภาพพลิก (สมโภชน เอี่ยมสุภาษิต, 2541) ตัวแบบท่ีทําใหบุคคลมี
การสังเกตนั้นจะตองมีลักษณะเดนชัด ทําใหผูสังเกตเกิดความพึงพอใจ พฤติกรรมท่ีแสดงออกไม
ซับซอน มีความเปนไปไดดึงดูดใจใหปฏิบัติตามและมีคุณคาในการใชประโยชน (Bandura, 1997) 

3. การพูดชักจูง (Verbal persuasion) หมายถึง การท่ีผูอื่นซึ่งมีความสําคัญ/มีอิทธิพลใน
การโนมนาวจิตใจหรือเปนท่ีเคารพนับถือของบุคคลนั้น (Significant persuasion) ไดแสดงออกโดย
คําพูดวาบุคคลนั้นมีความสามารถท่ีจะกระทํากิจกรรมท่ีกําหนดได โดยการพูดชักจูงใหเช่ือใน
ความสามารถของตนเอง ยอมทําใหบุคคลเลิกสงสัยในตัวเอง (Self-doubts) แตเกิดกําลังใจและมี
ความพยายามมากข้ึนท่ีจะกระทําใหสําเร็จก็ยอมท่ีจะไดผลดีในการพัฒนาการรับรูความสามารถของ
ตน 
          4. การกระตุนเราทางอารมณ (Emotional arousal) ในการตัดสินความสามารถของตนเอง
ของบุคคล สวนหนึ่งอาศัยอาการแสดงทางกายและสภาพอารมณท่ีถูกกระตุน เมื่อเผชิญกับภาวะตึง
เครียดหรือสถานการณท่ีคุกคามจะมีผลตอความรูสึกในทางลบ เชน เกิดความกลัว ความวิตกกังวล 
ทําใหการรับรูความสามารถของตนเองลดลง ซึ่งโดยท่ัวไปคนเรามักจะทอถอยและคิดถึงความลมเหลว
มากกวาจะคาดหวังถึงความสําเร็จ เมื่ออยูในภาวะเหนื่อยลาหรือตึงเครียด เพราะคนเรามักจะ
ตีความหมายของปฏิกิริยาความเครียดวาเปนผลมาจากการไมมีความสามารถดีพอ และจะนําไปสูการ
รับรูความสามารถของตนเองตํ่าลง ถาอารมณลักษณะดังกลาวเกิดมากข้ึน ก็จะทําใหบุคคลไมสามารถ
ท่ีจะแสดงออกไดดี อันจะนําไปสูประสบการณของความลมเหลว ซึ่งจะทําใหการรับรูเกี่ยวกับ
ความสามารถบุคคลสามารถลด หรือระงับการถูกกระตุนทางอารมณได  จะทําใหการรับรู
ความสามารถของตนดีข้ึน อันจะทําใหการแสดงออกถึงความสามารถดีข้ึนดวย 
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งานวิจัยท่ีเก่ียวของ 
 ภาณุวัชร  ปุรณะศิริ (2546: บทคัดยอ) ไดศึกษาตัวแปรท่ีสงผลตอความสามารถในการเขียน
โปรแกรมคอมพิวเตอรของนักเรียนระดับมัธยมศึกษาตอนปลาย พบวา สมรรถภาพทางสมองดาน
ตัวเลข ดานการใชคํา ดานมิติสัมพันธ มีความสัมพันธกับความสามารถในการเขียนโปรแกรม
คอมพิวเตอรอยางมีนัยสําคัญทางสถิติทีระดับ .01 และลักษณะนิสัยดานความกระตือรือรน มี
ความสัมพันธกับความสามารถในการเขียนโปรแกรมคอมพิวเตอรอยางมีนัยสําคัญทางสถิติทีระดับ 
.05  
 สาคร  ยาระวัง (2545: บทคัดยอ) ไดศึกษาความสัมพันธระหวางสมรรถภาพทางสมองและ
ลักษณะนิสัยกับสมรรถภาพในการพัฒนาโปรกรมคอมพิวเตอร พบวา สมรรถภาพทางสมองดาน
ตัวเลข ดานความจํา ลักษณะนิสัยดานความอดทนและดานความรับผิดชอบ มีความสัมพันธกับ
สมรรถภาพในการพัฒนาโปรแกรมคอมพิวเตอรในทางบวกอยางมีนัยสําคัญทางสถิติทีระดับ .01 
ยกเวนสมรรถภาพทางสมองดานภาษา ไมมีความสัมพันธกับสมรรถภาพในการพัฒนาโปรแกรม
คอมพิวเตอร โดยมีคาสัมประสิทธิ์สหสัมพันธพหุคูณเทากับ 0.927 
 จากการทบทวนวรรณกรรมขางตน พบวา ตัวแปรท่ีสงผลตอทักษะการเรียนวิชาคอมพิวเตอร
กราฟกส สวนใหญเปนองคประกอบภายในตัวบุคคล ผูวิจัยจึงสนใจศึกษาตัวแปรดานสมรรถภาพทาง
สมอง ลักษณะนิสัย แรงจูงใจภายในของตนเอง และการรับรูความสามารถของตนเอง เพื่อนํา
ผลการวิจัยไปพัฒนาหลักสูตรรายวิชาและการจัดการเรียนการสอนวิชาคอมพิวเตอรกราฟกสตอไปใน
อนาคต   
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กรอบแนวความคิด 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ดานสมรรถภาพทางสมอง 7 ดาน  
- ดานภาษา 
- ดานการใชคํา 
- ดานตัวเลข 
- ดานมิติสัมพันธ 
- ดานความจํา 
- ดานการสังเกตรับรู 
- ดานเหตุผล 

 

ดานลักษณะนิสัย 5 ดาน 
- ดานความมีวินัย 
- ดานความอดทน 
- ดานความกระตือรือรน 
- ดานความต้ังใจ 
- ดานความรับผิดชอบ 

 

ดานแรงจูงใจภายในของตนเอง 

ดานการรับรูความสามารถของ
ตนเอง 

ความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกส 

ตัวแปรตน 

ตัวแปรตาม 



บทที่ 3 
วิธีดําเนินการวิจยั 

 
การวิจัยครั้งนี้มีวัตถุประสงค 1) เพื่อศึกษาความสัมพันธระหวางสมรรถภาพทางสมอง 

ลักษณะนิสัย แรงจูงใจภายในของตนเอง และการรับรูความสามารถของตนเองกับความสามารถใน
การเรียนวชิาคอมพิวเตอรกราฟกส และ 2) เพื่อสรางสมการพยากรณความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกส ของนักเรียนสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัย
เทคโนโลยีราชมงคลพระนคร ผูวิจัยไดกําหนดวิธีการดําเนินการเปนข้ันตอนดังนี้ 
 1. ประชากรและกลุมตัวอยาง 
 2. เครื่องมือท่ีใชในการศึกษาคนควา 
 3. การสรางและหาคุณภาพของเครื่องมือ 
 4. การดําเนินการทดลอง 
 5. การวิเคราะหขอมูล 
 6. สถิติท่ีใชในการวิเคราะหขอมูล 
 
ประชากรและกลุมตัวอยาง 
 1. ประชากร ไดแก นักศึกษาสาขาวิชาไฟฟา คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัย
เทคโนโลยีราชมงคลพระนคร จํานวน 200 คน 
 2. กลุมตัวอยาง เปนนักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะ         
ครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ภาคเรียนท่ี 2 ปการศึกษา 2555 
จํานวน 15 คน ซึ่งไดมาโดยการสุมกลุมตัวอยางแบบเจาะจง (Purposive Sampling)  
 
เคร่ืองมือท่ีใชในการศึกษาคนควา 
 เครื่องมือท่ีใชในการวิจัยครั้งนี้ ผูวิจัยไดพัฒนามาจากงานวิจัยท่ีสรางข้ึนไวแลว และบางฉบับ
ไดสรางข้ึนเอง ดังนี้  

1. แบบทดสอบสมรรถภาพทางสมอง ไดทําการพัฒนามาจากโครงการวิจัยการสรางและ
พัฒนาแบบทดสอบวัดความถนัดทางการเรียนสําหรับนักเรียนช้ันมัธยมศึกษาตอนปลายของ
มหาวิทยาลัยมหาสารคาม (สุทธิวรรณ  พีรศักด์ิโสภณ, 2541) จํานวน 7 ดาน ไดแก ดานภาษา ดาน
ตัวเลข ดานมิติสัมพันธ ดานการสังเกตรับรู ดานเหตุผล ดานการใชคํา และดานความจํา เปน
แบบทดสอบชนิดแบบเลือกตอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุ
ศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน ท่ีไมใชนักศึกษากลุม
ตัวอยาง และหาคาความเช่ือมั่นท้ังฉบับ  
 ซึ่งผลจากการหาคาความเช่ือมั่นแบบทดสอบสมรรถภาพทางสมอง มีคาเทากับ .824 ดัง
ตัวอยาง 
 คําช้ีแจง ใหจัดเรียงคํา ขอความใหมใหไดใจความสมบูรณ  
  คําถาม 1) เปน 175 เขต 
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   2) เขตพื้นท่ีการศึกษา 
   3) ไดแบง 
   4) ประเทศไทย 
  ก. 3-2-1-4    ข. 4-3-2-1 
  ค. 4-2-3-1    ง. 2-1-4-3 
  จ. 3-4-2-1 
  2. แบบวัดแรงจูงใจภายในของตนเอง ไดทําการพัฒนามาจากงานวิจัยของสภาคณาจารย
มหาวิทยาลัยศรีนครินทรวิโรฒประสานมิตร (อรพินธ  ชูชม และคณะ, 2540) เปนแบบทดสอบชนิด
แบบเลือกตอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุศาสตรอุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน ท่ีไมใชนักศึกษากลุมตัวอยาง และหาคา
ความเช่ือมั่นท้ังฉบับ 
 ซึ่งผลจากการหาคาความเช่ือมั่นแบบวัดแรงจูงใจภายในของตนเอง มีคาเทากับ .749 ดัง
ตัวอยาง 
 คําช้ีแจง ใหอานขอความท่ีกําหนดให โดยใหเวลาในการอาน 1 นาที สงกระดาษขอความ
กลับคืนแลวตอบคําถามขอ 1-5  
  “สามรอยหกสิบหาวันคือวันแม มิใชแตวันใดใหนึกถึง สม่ําเสมอสมัครจิตคิดคํานึง เหมือนแม
ซึ่งรักลูกครบทุกวัน” 
 คําถาม ขอความนี้ ตองกาแรสดงออกถึงความรูสึกอยางไร 
  ก. เอาใจ    ข. ปลุกใจ 
  ค. ปลอบใจ    ง. ประโลมใจ 
  จ. ยกยอง 

3. แบบทดสอบวัดลักษณะนิสัย ไดพัฒนามาจากงานวิจัยของภาณุวัชร  ปุรณะศิริ เรื่องตัว
แปรท่ีสงผลตอความสามารถในการเขียนโปรแกรมคอมพิวเตอรของนักเรียนระดับมัธยมศึกษาตอน
ปลาย โดยใชรูปแบบการทดสอบแบบสถานการณ แตละสถานการณมี 3 ตัวเลือก ประกอบดวย
ลักษณะนิสัยดานความมีวินัย ดานความอดทน ดานความกระตือรือรน ดานความต้ังใจ และดานความ
รับผิดชอบ เปนแบบทดสอบชนิดแบบเลือกตอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญา
ตรี คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน ท่ีไมใช
นักศึกษากลุมตัวอยาง และหาคาความเช่ือมั่นท้ังฉบับ  
 ซึ่งผลจากการหาคาความเช่ือมั่นแบบทดสอบวัดลักษณะนิสัย มีคาเทากับ .882 ดังตัวอยาง 
 คําช้ีแจง ใหนักศึกษาเลือกคําตอบท่ีตรงกับลักษณะนิสัยของตนเองมากท่ีสุด 
 คําถาม วันหนึ่งเปนชวงพักกลางวัน สมศักด์ิหิวมาก และกําลังนั่งรอทานกวยเต๋ียวท่ีส่ังไว เมื่อ
รอไปประมาณ 10 นาที คนขายก็ยังไมทําใหบอกแตวารอกอนเด๋ียวจะทําให ทานจะทําอยางไร เมื่อ
ทานเปนสมศักด์ิ 
  ก. เตือนคนขายอีกครั้ง    
   ข. ลุกไปส่ังรานอื่นท่ีเร็วกวา 
  ค. นั่งรอตอไปอีก แลวคิดวาเด๋ียวสักครูคงได 
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 4. แบบวัดการรับรูความสามารถของตนเอง เปนการใชสถานการณตาง ๆ ท้ังหมดท่ีเกี่ยวของ
กับพฤติกรรมนั้น ๆ นํามาสรางเปนขอคําถามแลวใหบุคคลตอบถึงระดับความมั่นใจในขอคําถาม
เหลานั้น มีลักษณะเปนมาตราสวนประมาณคา (Rating Scale) ดังตัวอยาง 
 

ขอ พฤติกรรม 

ระดับการรับรูความสามารถของตนเอง 

จริงมาก 
จริงเปน

สวน
ใหญ 

จริงนอย ไมจริง 

0 
เพื่อใหแนใจวาฉันเขียนคอมพิวเตอรกราฟกส
ถูกตอง ฉันตรวจสอบทุกครั้ง 

    

00 
กอนท่ีเริ่มเขียนคอมพิวเตอรกราฟกส ฉันศึกษา
ขอมูลท่ีเกี่ยวของไดครบถวนทุกครั้ง 

    

 
 5. แบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส เปนแบบทดสอบท่ี
ผูวิจัยสรางข้ึนโดยใชเนื้อหาตามคําอธิบายรายวิชาของหลักสูตรครุศาสตรอุตสาหกรรมบัณฑิต 
สาขาวิชาวิศวกรรมไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
รายวิชาคอมพิวเตอรกราฟกส มีลักษณะเปนแบบทดสอบปรนัยแบบเลือกตอบมี 4 ตัวเลือก จํานวน 
70 ขอ ดังตัวอยาง 
  คําช้ีแจง ใหนักศึกษาเลือกคําตอบท่ีถูกตองท่ีสุดเพียงคําตอบเดียว แลวกาเครื่องหมาย x ตรง
กับขอท่ีเลือกลงในกระดาษคําตอบ 
 คําถาม ขอใดกลาวถูกตองเกี่ยวกับหลักการทํางานของกราฟกแบบ  Vector 
   ก.ใชสรางภาพ แกไขและตกแตงภาพ เหมาะกับการสรางโลโก และออกแบบ 
   ข. ภาพเกดิจากจุดสีส่ีเหล่ียมเล็ก ๆ หลาย ๆ จุดมาเรียงตอกันจนเกิดเปนรูปภาพ 

ค. ภาพเกิดจากการอางอิงความสัมพันธทางคณิตศาสตร หรือการคํานวณ 
ง. ภาพเกิดจากยิงแสงของประจุไฟฟาไปยังแมสี  RGB และเกิดเปนภาพสีตาง ๆ 

 
การสรางและหาคุณภาพของเคร่ืองมือ 

การสรางเครื่องมือท่ีใชในการวิจัยครั้งนี้  ผูวิ จัยไดนําเสนอตามประเภทของเครื่องมือ 
ดังตอไปนี้ 

1. แบบทดสอบวัดสมรรถภาพทางสมอง ผูวิจัยดําเนินการพัฒนาแบบทดสอบตามข้ันตอน 
ดังตอไปนี้ 
  1.1 กําหนดจุดมุงหมายในการสรางแบบทดสอบเพื่อวัดสมรรถภาพทางสมองรายวิชา
คอมพิวเตอรกราฟกสของนักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตร
อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
 1.2 ศึกษาเอกสารและงานวิจัยท่ีเกี่ยวของ และศึกษาวิธีการเขียนขอคําถาม เพื่อวัด
สมรรถภาพทางสมอง 
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 1.3 เขียนนิยามเชิงพฤติกรรมของแบบทดสอบวัดสมรรถภาพทางสมอง ซึ่งสรุปมาจาก
การศึกษาคนควา 
 1.4 ผูวิจัยเขียนขอคําถามตามคํานิยามแตละดาน 
  1.5 สรางแบบทดสอบฉบับราง โดยนําไปใหผูทรงคุณวุฒิ จํานวน 3 คน ทําการตรวจสอบ
ความเท่ียง ความครอบคลุมเนื้อหา และความถูกตองในสํานวนภาษา ซึ่งในการตรวจสอบความ
เท่ียงตรงเชิงเนื้อหาใชวิธีของแฮมเบลตัน (Hembleton) มีเกณฑ ดังนี้  
 +1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
   0 คะแนน      ถาไมแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
 -1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไมไดตรงตามพฤติกรรมแตละดาน 
  หาคาดัชนีความสอดคลอง (IOC) ระหวางขอคําถามกับพฤติกรรมแตละดาน และคัดเลือกขอ
คําถามท่ีมีคา IOC ต้ังแต 0.5 ข้ึนไป  
 1.6 นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) กับนักศึกษาท่ีไมใชกลุม
ตัวอยาง เพื่อทําการทดสอบเครื่องมือเพื่อหาความยากงาย คาอํานาจจําแนก และคาความเช่ือมั่นของ
แบบทดสอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุศาสตรอุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน 
  1.7 นําแบบทดสอบมาปรับปรุงใหเหมาะสมตอการใชกับกลุมตัวอยางตอไป 
 1.8 จัดพิมพแบบทดสอบฉบับสมบูรณ 
  จากข้ันตอนการดําเนินการสรางแบบทดสอบสมรรถภาพทางสมอง สามารถสรุปไดดังภาพท่ี 
4 
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ภาพท่ี 4   ข้ันตอนการดําเนินการสรางแบบทดสอบสมรรถภาพทางสมอง 
 
 

กําหนดจุดมุงหมายในการสรางแบบทดสอบ 

ศึกษาทฤษฎี วิธีการ และงานวิจัยท่ีเกี่ยวของและศึกษาวิธีการเขียนขอคําถาม 

เขียนนิยามเชิงพฤติกรรมท่ีตองการวัด 

เขียนขอคําถามตามคํานิยามแตละดาน 

ผูทรงคุณวุฒิตรวจสอบ 

IOC ≥ 0.5 

นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) 

หาคาความยากงาย  
และหาคาอํานาจจําแนก 

ตามเกณฑท่ีกําหนด 

จัดพิมพแบบทดสอบฉบับสมบูรณ 

ปรับปรุงและ
แกไข 

ไมผาน 

ผาน 
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  2. แบบวัดแรงจูงใจภายในของตนเอง ผูวิจัยดําเนินการพัฒนาแบบวัดแรงจูงใจตามข้ันตอน 
ดังตอไปนี้ 
 2.1 กําหนดจุดมุงหมายในการสรางแบบวัดแรงจูงใจของนักศึกษาสาขาวิชาไฟฟา แขนงวิชา
วิศวกรรมคอมพิวเตอร คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
 2.2 ศึกษาเอกสารและงานวิจัยท่ีเกี่ยวของ และศึกษาวิธีการเขียนขอคําถาม เพื่อวัดแรงจูงใจ
ภายในของตนเอง 
 2.3 เขียนนิยามเชิงพฤติกรรมของแบบวัดแรงจูงใจภายในของตนเอง ซึ่งสรุปมาจากการศึกษา
คนควา 
 2.4 ผูวิจัยเขียนขอคําถามตามคํานิยามแตละดาน 
  2.5 สรางแบบทดสอบฉบับราง โดยนําไปใหผูทรงคุณวุฒิ จํานวน 3 คน ทําการตรวจสอบ
ความเท่ียง ความครอบคลุมเนื้อหา และความถูกตองในสํานวนภาษา ซึ่งในการตรวจสอบความ
เท่ียงตรงเชิงเนื้อหาใชวิธีของแฮมเบลตัน (Hembleton) มีเกณฑ ดังนี้  
 +1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
   0 คะแนน      ถาไมแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
 -1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไมไดตรงตามพฤติกรรมแตละดาน 
  หาคาดัชนีความสอดคลอง (IOC) ระหวางขอคําถามกับพฤติกรรมแตละดาน และคัดเลือกขอ
คําถามท่ีมีคา IOC ต้ังแต 0.5 ข้ึนไป  
 2.6 นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) กับนักศึกษาท่ีไมใชกลุม
ตัวอยาง เพื่อทําการทดสอบเครื่องมือเพื่อหาความยากงาย คาอํานาจจําแนก และคาความเช่ือมั่นของ
แบบทดสอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุศาสตรอุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน 
  2.7 นําแบบทดสอบมาปรับปรุงใหเหมาะสมตอการใชกับกลุมตัวอยางตอไป 
  2.8 จัดพิมพแบบวัดแรงจูงใจของตนเองฉบับสมบูรณ 
  จากข้ันตอนการดําเนินการสรางแบบวัดแรงจูงใจภายในของตนเอง สามารถสรุปไดดังภาพท่ี 
5 
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ภาพท่ี 5   ข้ันตอนการดําเนินการสรางแบบวัดแรงจูงใจของตนเอง 
 
 

กําหนดจุดมุงหมายในการสรางแบบวัดแรงจูงใจของตนเอง 

ศึกษาทฤษฎี วิธีการ และงานวิจัยท่ีเกี่ยวของและศึกษาวิธีการเขียนขอคําถาม 

เขียนนิยามเชิงพฤติกรรมท่ีตองการวัด 

เขียนขอคําถามตามคํานิยามแตละดาน 

ผูทรงคุณวุฒิตรวจสอบ 

IOC ≥ 0.5 

นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) 

หาคาความยากงาย  
และหาคาอํานาจจําแนก 

ตามเกณฑท่ีกําหนด 

จัดพิมพแบบวัดแรงจูงใจของตนเองฉบับสมบูรณ 

ปรับปรุงและ
แกไข 

ไมผาน 

ผาน 
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  3. แบบทดสอบวัดลักษณะนิสัย ผูวิจัยดําเนินการพัฒนาแบบทดสอบวัดลักษณะนิสัยตาม
ข้ันตอน ดังตอไปนี ้
 3.1 กําหนดจุดมุงหมายในการสรางแบบทดสอบวัดลักษณะนิสัยของนักศึกษาสาขาวิชาไฟฟา 
แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระ
นคร 
 3.2 ศึกษาเอกสารและงานวิจัยท่ีเกี่ยวของ และศึกษาวิธีการเขียนขอคําถาม เพื่อวัดลักษณะ
นิสัยท้ังหมด 5 ดาน ไดแก ดานความมีวินัย ดานความอดทน ดานความกระตือรือรน ดานความต้ังใจ 
และดานความรับผิดชอบ 
 3.3 เขียนนิยามเชิงพฤติกรรมของผูท่ีมีลักษณะนิสัยท่ีตองการวัด 5 ดาน ซึ่งสรุปมาจากการ 
ศึกษาคนควา 
 3.4 ผูวิจัยเขียนขอคําถามตามคํานิยามแตละดาน 
  3.5 สรางแบบทดสอบฉบับราง โดยนําไปใหผูทรงคุณวุฒิ จํานวน 3 คน ทําการตรวจสอบ
ความเท่ียง ความครอบคลุมเนื้อหา และความถูกตองในสํานวนภาษา ซึ่งในการตรวจสอบความ
เท่ียงตรงเชิงเนื้อหาใชวิธีของแฮมเบลตัน (Hembleton) มีเกณฑ ดังนี้  
 +1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
   0 คะแนน      ถาไมแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
 -1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไมไดตรงตามพฤติกรรมแตละดาน 
  หาคาดัชนีความสอดคลอง (IOC) ระหวางขอคําถามกับพฤติกรรมแตละดาน และคัดเลือกขอ
คําถามท่ีมีคา IOC ต้ังแต 0.5 ข้ึนไป  
 3.6 นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) กับนักศึกษาท่ีไมใชกลุม
ตัวอยาง เพื่อทําการทดสอบเครื่องมือเพื่อหาความยากงาย คาอํานาจจําแนก และคาความเช่ือมั่นของ
แบบทดสอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุศาสตรอุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน 
  3.7 นําแบบทดสอบมาปรับปรุงใหเหมาะสมตอการใชกับกลุมตัวอยางตอไป 
 3.8 จัดพิมพแบบทดสอบวัดลักษณะนิสัยฉบับสมบูรณ 
  จากข้ันตอนการดําเนินการสรางแบบวัดแรงจูงใจภายในของตนเอง สามารถสรุปไดดังภาพท่ี 
6 
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ภาพท่ี 6   ข้ันตอนการดําเนินการสรางแบบทดสอบวัดลักษณะนิสัย 
 
 

กําหนดจุดมุงหมายในการสรางแบบทดสอบวัดลักษณะนิสัย 

ศึกษาทฤษฎี วิธีการ และงานวิจัยท่ีเกี่ยวของและศึกษาวิธีการเขียนขอคําถาม 

เขียนนิยามเชิงพฤติกรรมท่ีตองการวัดท้ัง 5 ดาน 

เขียนขอคําถามตามคํานิยามแตละดาน 

ผูทรงคุณวุฒิตรวจสอบ 

IOC ≥ 0.5 

นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) 

หาคาความยากงาย  
และหาคาอํานาจจําแนก 

ตามเกณฑท่ีกําหนด 

จัดพิมพแบบทดสอบวัดลักษณะนิสัยฉบับสมบูรณ 

ปรับปรุงและ
แกไข 

ไมผาน 

ผาน 
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  4. แบบวัดการรับรูความสามารถของตนเอง ผูวิจัยดําเนินการพัฒนาแบบวัดการรับรู
ความสามารถของตนเอง ตามข้ันตอนดังตอไปนี ้
 4.1 กําหนดจุดมุงหมายในการสรางวัดการรับรูความสามารถของนักศึกษาสาขาวิชาไฟฟา 
แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระ
นคร 
 4.2 ศึกษาเอกสารและงานวิจัยท่ีเกี่ยวของ และศึกษาวิธีการเขียนขอคําถาม เพื่อวัดระดับ
ความมั่นใจในการเขียนคอมพิวเตอรกราฟกส 
 4.3 เขียนนิยามเชิงพฤติกรรมของการรับรูความสามารถของนักศึกษา ซึ่งสรุปมาจากการ 
ศึกษาคนควา 
 4.4 ผูวิจัยเขียนขอคําถามตามคํานิยามแตละดาน 
  4.5 สรางแบบวัดการรับรูความสามารถฉบับราง โดยนําไปใหผูทรงคุณวุฒิ จํานวน 3 คน ทํา
การตรวจสอบความเท่ียง ความครอบคลุมเนื้อหา และความถูกตองในสํานวนภาษา ซึ่งในการ
ตรวจสอบความเท่ียงตรงเชิงเนื้อหาใชวิธีของแฮมเบลตัน (Hembleton) มีเกณฑ ดังนี้  
 +1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
   0 คะแนน      ถาไมแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
 -1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไมไดตรงตามพฤติกรรมแตละดาน 
  หาคาดัชนีความสอดคลอง (IOC) ระหวางขอคําถามกับพฤติกรรมแตละดาน และคัดเลือกขอ
คําถามท่ีมีคา IOC ต้ังแต 0.5 ข้ึนไป  
 4.6 นําแบบวัดการรับรูความสามารถท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) กับ
นักศึกษาท่ีไมใชกลุมตัวอยาง ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุศาสตร
อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน 
  4.7 นําแบบวัดการรับรูความสามารถมาปรับปรุงใหเหมาะสมตอการใชกับกลุมตัวอยางตอไป 
 4.8 จัดพิมพแบบวัดการรับรูความสามารถของตนเองฉบับสมบูรณ 
  จากข้ันตอนการดําเนินการสรางแบบวัดการรับรูความสามารถของตนเอง สามารถสรุปไดดัง
ภาพท่ี 7 
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ภาพท่ี 7   ข้ันตอนการดําเนินการสรางแบบวัดการรับรูความสามารถ 

 
 
 
 
 
 
 
 
 

กําหนดจุดมุงหมายในการสรางแบบวัดการรับรูความสามารถ 

ศึกษาทฤษฎี วิธีการ และงานวิจัยท่ีเกี่ยวของและศึกษาวิธีการเขียนขอคําถาม 

เขียนนิยามเชิงพฤติกรรมท่ีตองการวัด  

เขียนขอคําถามตามคํานิยามแตละดาน 

ผูทรงคุณวุฒิตรวจสอบ 

IOC ≥ 0.5 

นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) 

จัดพิมพแบบวัดการรับรูความสามารถฉบับสมบูรณ 
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 5. แบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส ผูวิจัยดําเนินการ
พัฒนาแบบทดสอบวัดลักษณะนิสัยตามข้ันตอน ดังตอไปนี ้
 5.1 กําหนดจุดมุงหมายในการสรางแบบทดสอบวัดความสามารถดานการเรียนวิชา
คอมพิวเตอรกราฟกสของนักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตร
อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
 5.2 ศึกษาเอกสารและงานวิจัยท่ีเกี่ยวของ และศึกษาวิธีการเขียนขอคําถาม เพื่อวัด
ความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส  
  5.3 เขียนนิยามเชิงพฤติกรรมของผูท่ีมีลักษณะนิสัยท่ีตองการวัดใหครอบคลุมกับคําอธิบาย
รายวิชาคอมพิวเตอรกราฟกส 
 5.4 ผูวิจัยเขียนขอคําถามตามคํานิยามแตละดาน 
  5.5 สรางแบบทดสอบฉบับราง โดยนําไปใหผูทรงคุณวุฒิ จํานวน 3 คน ทําการตรวจสอบ
ความเท่ียง ความครอบคลุมเนื้อหา และความถูกตองในสํานวนภาษา ซึ่งในการตรวจสอบความ
เท่ียงตรงเชิงเนื้อหาใชวิธีของแฮมเบลตัน (Hembleton) มีเกณฑ ดังนี้  
 +1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
   0 คะแนน      ถาไมแนใจวาขอคําถามขอนั้นวัดไดตรงตามพฤติกรรมแตละดาน 
 -1 คะแนน      ถาแนใจวาขอคําถามขอนั้นวัดไมไดตรงตามพฤติกรรมแตละดาน 
  หาคาดัชนีความสอดคลอง (IOC) ระหวางขอคําถามกับพฤติกรรมแตละดาน และคัดเลือกขอ
คําถามท่ีมีคา IOC ต้ังแต 0.5 ข้ึนไป  
 5.6 นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) กับนักศึกษาท่ีไมใชกลุม
ตัวอยาง เพื่อทําการทดสอบเครื่องมือเพื่อหาความยากงาย คาอํานาจจําแนก และคาความเช่ือมั่นของ
แบบทดสอบ ซึ่งผูวิจัยไดนําไปทดลองกับนักศึกษาระดับปริญญาตรี คณะครุศาสตรอุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จํานวน 15 คน 
  5.7 นําแบบทดสอบมาปรับปรุงใหเหมาะสมตอการใชกับกลุมตัวอยางตอไป 
 5.8 จัดพิมพแบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกสฉบับ
สมบูรณ 
  จากข้ันตอนการดําเนินการสรางแบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอร
กราฟกส สามารถสรุปไดดังภาพท่ี 8 
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ภาพท่ี 8   ข้ันตอนการดําเนินการสรางแบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอร

กราฟกส 
 

กําหนดจุดมุงหมายในการสรางแบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส 

ศึกษาทฤษฎี วิธีการ และงานวิจัยท่ีเกี่ยวของและศึกษาวิธีการเขียนขอคําถาม 

เขียนนิยามเชิงพฤติกรรมท่ีตองการวัด  

เขียนขอคําถามตามคํานิยามแตละดาน 

ผูทรงคุณวุฒิตรวจสอบ 

IOC ≥ 0.5 

นําแบบทดสอบท่ีไดตรวจสอบแลวไปทดลองใช (Try – out) 

หาคาความยากงาย  
และหาคาอํานาจจําแนก 

ตามเกณฑท่ีกําหนด 

จัดพิมพแบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกสฉบับสมบูรณ 

ปรับปรุงและ
แกไข 

ไมผาน 

ผาน 
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การเก็บรวบรวมขอมูล 
  ในการวิจัยครั้งนี้ ผูวิจัยไดดําเนินการเก็บรวบรวมขอมูล ดังนี้ 
  1. ทําความช้ีแจงวัตถุประสงคในการเก็บรวบรวมขอมูลใหกับนักศึกษากลุมตัวอยาง ซึ่งไดแก 
นักศึกษาระดับปริญญาตรี คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
จํานวน 15 คน 
  2. นําเครื่องมือไปทดสอบกับนักศึกษาตามวัดและเวลาท่ีกําหนด โดยผูวิจัยดําเนินการกํากับ
การสอบดวยตนเอง และในการสอบแตละฉบับจะเวนชวงเวลาหางกัน 15 ถึง 30 นาที  
  3. นําแบบทดสอบและแบบวัดตาง ๆ ท่ีไดไปตรวจสอบใหคะแนน และวิเคราะหหาคาทาง
สถิติ   
 
การวิเคราะหขอมูล 
 ในการวิเคราะหขอมูล ผูวิจัยดําเนินการวิเคราะหขอมูลทางสถิติ ดังนี้ 
 1. หาคาสถิติพื้นฐานของแบบทดสอบและแบบวัดแตละฉบับ ไดแก แบบทดสอบวัด
สมรรถภาพทางสมอง  ลักษณะนิสัย แรงจูงใจภายในของตนเอง การรับรูความสามารถของตนเอง 
และแบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส 
  2. วิเคราะหหาคุณภาพของแบบทดสอบและแบบวัดแตละฉบับ ดังนี ้
   2.1 แบบทดสอบ วิเคราะหหาคาความยากงาย คาอํานาจจําแนก และความเช่ือมั่น
ของแบบทดสอบแตละฉบับ ไดแก สมรรถภาพสมองดานภาษา ดานตัวเลข ดานมิติสัมพันธ ดานการ
สังเกตรับรู ดานเหตุผล ดานการใชคํา ดานความจํา และแบบทดสอบวัดความสามารถดานการเรียน
วิชาคอมพิวเตอรกราฟกส 
  2.2 แบบวัด วิเคราะหคาอํานาจจําแนก และความเช่ือมั่นของแบบวัดลักษณะนิสัย 
แรงจูงใจภายในของตนเอง และแบบวัดการรับรูความสามารถของตนเอง 
 3. ตรวจสอบปญหาเกี่ยวกับความสัมพันธระหวางตัวแปรอิสระดวยกันท่ีเรียกวา 
Multicollinerarity 
  4. วิเคราะหความสัมพันธระหวางตัวแปรท่ีใชในการพยากรณกับตัวแปรเกณฑโดยใชสูตรของ
เพียรสัน แลวทดสอบความมีนัยสําคัญของคาสัมประสิทธิ์สหสัมพันธนั้นโดยการทดสอบคาที (T-test) 
 5. วิเคราะหหากลุมตัวพยากรณเพื่อทํานายความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส โดยการวิเคราะหการถดถอยพหุคูณแบบสเตบไวส (Stepwise Solution) 
 6. สรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
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สถิติท่ีใชในการวิเคราะหขอมูล 
 1. สถิติพื้นฐาน ไดแก คาเฉล่ีย และคาสวนเบ่ียงเบนมาตรฐาน 

               1.1 การหาคาเฉลี่ย   

X      =  
N

X∑  

เม่ือ        X      =   คะแนนเฉลี่ย 
                           ∑ X      =   ผลรวมของคะแนนทั้งหมด 

                             N      =  จํานวนขอมูล 
 
              1.2 สวนเบี่ยงเบนมาตรฐาน  (Standard  Deviation)  
 

1)N(N

2fX)(2fXN
 S.D. −

∑ ∑−=  

  
 2. การวิเคราะหหาคุณภาพของแบบทดสอบและแบบวัด  

             2.1 สูตรหาคาความยากงาย (Difficulty)  ของแบบทดสอบ  

P   =   
N
R  

       เม่ือ       P    =   ดัชนีคาความยากงายของแบบทดสอบ 
                    R   =   จํานวนนักศึกษาที่ทําขอนั้นถูก 

                                     N   =   จํานวนนักศึกษาที่ทําขอนั้นทั้งหมด 
 

   2.2 สูตรการหาคาอํานาจจําแนก  (Discrimination)    ของแบบทดสอบโดย
ใชสูตรการหาคาดัชนีอํานาจจําแนกของแบบทดสอบ   

                                                   

2
N

D RR LU
_=       

                            เม่ือ    D   =   คาอํานาจจําแนก 
                  RU

  =   จํานวนนักเรียนที่ทําขอสอบถูกในกลุมเกง 

                     RL
  =   จํานวนนักเรียนที่ทําขอสอบถูกในกลุมออน 

                   N    =   จํานวนนักศึกษาที่ทําขอสอบทั้งหมด 
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2.3  สูตรการหาความเช่ือม่ันของแบบทดสอบ  ใชสูตรคูเดอร-ริชารด 20         
 

 rtt      = 










 ∑−− 2

tS

p.q
1

1n
n  

 

            เม่ือ     rtt     =    คาความเช่ือม่ันของแบบทดสอบ 

                    n    =    จํานวนขอของแบบทดสอบ 

                    p    =   สัดสวนของผูทําไดในขอหนึ่ง ๆ นั่นคือสัดสวนของคนทําถูก 

           กับคนทั้งหมด 

                   q    =    สัดสวนของผูทําผิดในขอหนึ่ง ๆ หรือ 1-p 

                             =    คะแนนความแปรปรวนของเคร่ืองมือวัดฉบับนั้น 
 

   โดยที่               =  
( )

N
2

X
2

_XN
2

∑∑  

 

   เม่ือ             =   คะแนนความแปรปรวนของเคร่ืองมือวัดฉบับนั้น 

      N     =   จํานวนคนที่ทําขอสอบ 

      X     =   คาคะแนนของแตละคน 
 
 
 
 
 

2
tS

2
tS

2
tS



บทที่ 4 
ผลการวิจัย 

 

  การวิจัยเรื่อง องคประกอบท่ีมีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
ครั้งนี้ โดยมีวัตถุประสงคเพื่อ 1) เพื่อศึกษาความสัมพันธระหวางสมรรถภาพทางสมอง แรงจูงใจ
ภายในของตนเอง ลักษณะนิสัย และการรับรูความสามารถของตนเองกับความสามารถในการเรียน
วิชาคอมพิวเตอรกราฟกส และ 2) เพื่อสรางสมการพยากรณความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกส ของนักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัย
เทคโนโลยีราชมงคลพระนคร ผลการวิเคราะหขอมูลผูวิจัยนําเสนอตามลําดับ ดังนี้ 
   1. สัญลักษณท่ีใชในการวิเคราะหขอมูล 
  2. ผลการวิเคราะหคาสถิติพื้นฐานของตัวพยากรณและตัวเกณฑ 
 3. ผลการวิเคราะหคาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรพยากรณแตละตัวและตัว
พยากรณกบัตัวเกณฑ 
 4. ผลการวิเคราะหหากลุมตัวพยากรณท่ีเขาสูสมการเพื่อทํานายความสามารถในการเรียน
วิชาคอมพิวเตอรกราฟกส โดยใชการวิเคราะหการถดถอยพหุคูณ 
 5. สรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
 
สัญลักษณท่ีใชในการวิเคราะหขอมูล 
  ผูวิจัยไดกําหนดสัญลักษณและตัวอักษรท่ีใชในการวิเคราะหขอมูล เพื่อใหเกิดความเขาใจ
ตรงกันในการแปลความหมายของขอมูล ดังนี้ 
 X1  แทน คะแนนสมรรถภาพทางสมองดานภาษา 
 X2  แทน คะแนนสมรรถภาพทางสมองดานการใชคํา 
 X3  แทน คะแนนสมรรถภาพทางสมองดานตัวเลข 
 X4  แทน คะแนนสมรรถภาพทางสมองดานมิติสัมพันธ 
 X5  แทน คะแนนสมรรถภาพทางสมองดานความจํา 
 X6  แทน คะแนนสมรรถภาพทางสมองดานการสังเกตรับรู 
 X7  แทน คะแนนสมรรถภาพทางสมองดานเหตุผล 
 X8  แทน คะแนนลักษณะนิสัยดานความมีวินัย 
 X9  แทน คะแนนลักษณะนิสัยดานความอดทน 
 X10  แทน คะแนนลักษณะนิสัยดานความกระตือรือรน 
 X11  แทน คะแนนลักษณะนิสัยดานความต้ังใจ 
 X12  แทน คะแนนลักษณะนิสัยดานความรับผิดชอบ 
 X13  แทน คะแนนแรงจูงใจภายในของตนเอง 
 X14  แทน คะแนนการรับรูความสามารถของตนเอง 
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 Y  แทน คะแนนจากแบบทดสอบวัดความสามารถในการเรียนวิชา 
คอมพิวเตอรกราฟกส 

 �̅�  แทน คาเฉล่ียของคะแนน 
 S.D.  แทน สวนเบ่ียงเบนมาตรฐานของคะแนน 

  β   แทน น้ําหนักความสําคัญในรูปคะแนนมาตรฐาน 
  b  แทน น้ําหนักความสําคัญในรูปคะแนนดิบ 
  rtt   แทน  คาความเช่ือมั่นของแบบทดสอบ 
 SEb  แทน ความคลาดเคล่ือนมาตรฐานของน้ําหนักความสําคัญของ 
    สัมประสิทธิ์ของการพยากรณในรูปคะแนนดิบ 
 t  แทน สถิติทดสอบท่ีใชการพิจารณาใน T-Distribution 
 R  แทน สัมประสิทธิ์สหสัมพันธพหุคูณ 
 F  แทน คาสถิติการแจกแจงแบบเอฟ 
 R2  แทน อํานาจในการพยากรณ 
 a  แทน คาคงท่ีของการพยากรณในรูปคะแนนดิบ 
 Z1  แทน คะแนนมาตรฐานซ ี
 Z’

y  แทน คะแนนพยากรณในรูปคะแนนมาตรฐานของแบบทดสอบวัด 
ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 

 Y’  แทน คะแนนพยากรณในรูปคะแนนดิบของแบบทดสอบวัด 
ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 

 
ผลการวิเคราะหคาสถิติพื้นฐานของตัวพยากรณและตัวเกณฑ 
  ผูวิจัยนําแบบทดสอบและแบบวัดตาง ๆ ไปทดสอบกับกลุมตัวอยาง แลวนําคะแนนท่ีไดไป
คํานวณหาคาเฉล่ีย คาความเบ่ียงเบนมาตรฐาน คาความโดง คาความเบ และคาสัมประสิทธิ์ของการ
กระจาย ดังแสดงในตารางท่ี 1  
 
ตารางท่ี 1 คาสถิติพื้นฐานของตัวแปรท่ีศึกษามีตัวพยากรณ 14 ตัว และตัวเกณฑ  

ตัวแปรท่ีศึกษา คะแนนเต็ม 𝒙� S.D. rtt 
ตัวพยากรณ     
สมรรถภาพ
ทางสมอง 

X1 20 14.60 2.131 

.824 

X2 20 15.07 2.404 
X3 30 22.20 4.379 
X4 20 13.80 2.808 
X5 20 13.87 2.774 
X6 20 14.67 2.380 

 
 



50 

ตารางท่ี 1 (ตอ) 
 ตัวแปรท่ี

ศึกษา 
คะแนนเต็ม 𝒙� S.D. rtt 

 X7 30 20.00 4.660  
XT1 160 114.21 21.536 .824 

ลักษณะนิสัย X8 25 19.00 2.171 

.749 
X9 25 16.80 4.127 
X10 15 11.33 1.839 
X11 20 15.27 2.789 
X12 25 17.00 4.175 
XT2 110 79.40 15.101 .749 

แรงจูงใจ
ภายใน 

X13 30 20.87 4.307 .882 

การรับรู
ความสามารถ 

X14 40 27.67 6.102 .793 

ตัวเกณฑ     
แบบทดสอบ
วัดความ 
สามารถใน
การเรียน  

Y 70 27.00 11.065 .763 

 
  จากตารางท่ี 1 พบวา ภาพรวมของสมรรถภาพทางสมอง (XT1) มีคาเฉล่ียเทากับ 114.21 คา
ความเบ่ียงเบนมาตรฐานเทากับ 21.536 และคาความเช่ือมั่นเทากับ .824 เมื่อพิจารณาแตละรายดาน
ของสมรรถภาพทางสมองแยกเปน สมรรถภาพทางสมองดานภาษา (X1) สมรรถภาพทางสมองดาน
การใชคํา (X2) สมรรถภาพทางสมองดานตัวเลข (X3) สมรรถภาพทางสมองดานมิติสัมพันธ (X4) 
สมรรถภาพทางสมองดานความจํา (X5) สมรรถภาพทางสมองดานการสังเกตรับรู (X6) สมรรถภาพ
ทางสมองดานเหตุผล (X7) มีคาเฉล่ียเทากับ 14.60 15.07 22.20 13.80 13.87 14.67 และ 20.00 
ตามลําดับ คาความเบ่ียงเบนมาตรฐานเทากับ 2.131 2.404 4.379 2.808 2.774 2.380 และ 4.660 
ตามลําดับ สวนภาพรวมของลักษณะนิสัย (XT2) มีคาเฉล่ียเทากับ 79.40 คาความเบ่ียงเบนมาตรฐาน
เทากับ 15.101 และคาความเช่ือมั่นเทากับ .749 เมื่อพิจารณาแตละรายดานของลักษณะนิสัยแยก
เปน ลักษณะนิสัยดานความมีวินัย (X8)  ลักษณะนิสัยดานความอดทน (X9)  ลักษณะนิสัยดานความ
กระตือรือรน (X10) ลักษณะนิสัยดานความต้ังใจ (X11) ลักษณะนิสัยดานความรับผิดชอบ (X12)        
มีคาเฉล่ียเทากับ 19.00 16.80 11.33 15.27 และ 17.00 ตามลําดับ คาความเบ่ียงเบนมาตรฐาน
เทากับ 2.171 4.127 1.839 2.789 และ 4.175 ตามลําดับ สําหรับแรงจูงใจภายในของตนเอง         
มีคาเฉล่ียเทากับ 20.87 คาเบ่ียงเบนมาตรฐานเทากับ 4.307 และคาความเช่ือม่ันเทากับ .882 
สําหรับการรับรูความสามารถของตนเอง มีคาเฉล่ียเทากับ 27.67 คาเบ่ียงเบนมาตรฐานเทากับ 6.102 
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และคาความเช่ือมั่นเทากับ .793 และสําหรับแบบทดสอบความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส มีคาเฉล่ียเทากับ 27.00 คาเบ่ียงเบนมาตรฐานเทากับ 11.065 และคาความเช่ือมั่นเทากับ 
.763    
 
ผลการวิเคราะหคาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรพยากรณแตละตัวและตัวพยากรณกับ
ตัวเกณฑ 
  คาสัมประสิทธิ์สหสัมพันธระหวางคะแนนจากแบบทดสอบสมรรถภาพทางสมอง 7 ดาน 
แบบวัดลักษณะนิสัย 5 ดาน แบบวัดแรงจูงใจภายในของตนเอง และแบบวัดการรับรูความสามารถ
ของตนเอง กับคะแนนความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสของนักศึกษาสาขาวิชา
ไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราช
มงคลพระนคร จํานวน 15 คน โดยใชสูตรของเพียรสัน (Pearson Product Moment Correlation 
Coefficient) และทดสอบนัยสําคัญทางสถิติของคาสัมประสิทธิ์สหสัมพันธ ดังแสดงในตารางท่ี 2 
 
ตารางท่ี 2 คาสัมประสิทธิ์สหสัมพันธภายในระหวางตัวพยากรณแตละตัวและคาสัมประสิทธิ์

สหสัมพันธระหวางตัวพยากรณกับตัวเกณฑ 
ตัวแปร Y X1 X2 X3 X4 X5 X6 X7 

Y 1.000 .085* -.344 .001* .094* -.026 .100** -.472 
X1  1.000 .424** .078* -.193 -.034 -.113 -.288 
X2   1.000 .256** -.061 -.084 -.220 .242** 
X3    1.000 -.124 .032* .007* .133** 
X4     1.000 -.114 -.107 .251** 
X5      1.000 .577** .094* 
X6       1.000 -.019 
X7        1.000 

* มีนัยสําคัญทางสถิติท่ีระดับ .05    ** มีนัยสําคัญทางสถิติท่ีระดับ .01 
 
ตารางท่ี 2 (ตอ) 
ตัวแปร X8 X9 X10 X11 X12 X13 X14  

X8 1.000 -.574 .322** .047* -.481 .214** .108** 
X9  1.000 -.546 .185** .299** .219** .570** 
X10   1.000 -.283 .205** -.301 -.295  
X11    1.000 .012* .318** .001* 
X12     1.000 .079* -.087 
X13      1.000 .034* 
X14       1.000 

* มีนัยสําคัญทางสถิติท่ีระดับ .05    ** มีนัยสําคัญทางสถิติท่ีระดับ .01 
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  ตารางท่ี 2 คาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรพยากรณดวยกัน พบวา ตัวแปร
พยากรณท่ีมีความสัมพันธกัน คาสัมประสิทธิ์สหสัมพันธท่ีมีนัยสําคัญทางสถิติท่ีระดับ .01 มีคา
สัมประสิทธิ์สหสัมพันธต้ังแต .577 ถึง .100 คาท่ีมีนัยสําคัญทางสถิติท่ีระดับ .05 มีคาต้ังแต .01 ถึง 
0.94  
 เมื่อพิจารณาคาความสัมพันธภายในกลุมของตัวแปรสมรรถภาพทางสมองแตละดาน พบวา 
คูท่ีมีความสัมพันธสูงสุด คือ ดานการสังเกตรับรูจํากับดานความจํา มีความสัมพันธกันเทากับ .577 คู
ท่ีมีความสัมพันธรองลงมาตามลําดับ คือ ดานการใชคํากับดานภาษา มีความสัมพันธกันเทากับ .424 
และดานตัวเลขกับดานการใชคํา มีความสัมพันธกันเทากับ .256 ซึ่งมีนัยสําคัญทางสถิติท่ีระดับ .01 
ทุกคา สวนดานเหตุผลกับดานภาษา มีความสัมพันธกันตํ่าสุดเทากับ -.288 ซึ่งไมมีนัยสําคัญทางสถิติ 
สําหรับความสัมพันธภายในกลุมของตัวแปรลักษณะนิสัยแตละดาน พบวา คูท่ีมีความสัมพันธสูงสุด 
คือ ดานความกระตือรือรนกับดานความมีวินัย มีความสัมพันธกันเทากับ .322 คูท่ีมีความสัมพันธ
รองลงมาตามลําดับ คือ ดานความรับผิดชอบกับดานความอดทน มีความสัมพันธกันเทากับ .299 และ
ดานความรับผิดชอบกับดานความกระตือรือรน มีความสัมพันธกันเทากับ .205 ซึ่งมีนัยสําคัญทางสถิติ
ท่ีระดับ .01 ทุกคา สวนดานความกระตือรือรนกับดานความมีวินัย มีความสัมพันธกันตํ่าสุดเทากับ     
-.574 ซึ่งไมมีนัยสําคัญทางสถิติ   
 สวนการพิจารณาคาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรพยากรณกับตัวแปรเกณฑ (Y) 
พบวา ตัวแปรพยากรณท่ีมีความสัมพันธกับตัวแปรเกณฑ (Y) มีคาสัมประสิทธิ์สหสัมพันธต้ังแต .577 
ถึง .185 มีนัยสําคัญทางสถิติท่ีระดับ .01 จํานวน 9 ตัวแปร โดยเรียงความสัมพันธจากมากไปนอย 
ไดแก สมรรถภาพทางสมองดานการสังเกตรับรู (X6) การรับรูความสามารถของตนเอง (X14) 
สมรรถภาพทางสมองดานการใชคํา (X2) ลักษณะนิสัยดานความกระตือรือรน (X10) แรงจูงใจภายใน
ของตนเอง (X13) ลักษณะนิสัยดานความรับผิดชอบ (X12) สมรรถภาพทางสมองดานการใชคํา (X7) 
ลักษณะนิสัยดานความต้ังใจ (X11) มีคาสัมประสิทธิ์สหสัมพันธเทากับ .577 .570 .424 .322 .318 
.299 .256 .251 และ .185 ตามลําดับ และตัวแปรพยากรณท่ีมีความสัมพันธกับตัวแปรเกณฑมี
นัยสําคัญทางสถิติท่ีระดับ .05 คือ สมรรถภาพทางสมองดานการสังเกตรับรู (X6) มีคาสัมประสิทธิ์
สหสัมพันธเทากับ .100 ยกเวน การรับรูความสามารถของตนเอง (X14) ท่ีไมมีความสัมพันธกับ
ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
 
ผลการวิเคราะหหากลุมตัวพยากรณท่ีเขาสูสมการเพื่อทํานายความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกส โดยใชการวิเคราะหการถดถอยพหุคูณ 
  การวิเคราะหถดถอยพหุคูณระหวางตัวแปรพยากรณท้ัง 14 ตัว และตัวแปรความสามารถใน
การเรียนวิชาคอมพิวเตอรกราฟกส ดวยวิธีเพิ่มตัวแปรเปนข้ัน ๆ (Stepwise Multiple Regression 
Analysis) ดังแสดงในตารางท่ี 3 ถึงตารางท่ี 6  
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ตารางท่ี 3 ลําดับข้ันการวิเคราะหการถดถอยพหุคูณแบบสเต็บไวสของตัวพยากรณท่ีเขาสูสมการคา
สัมประสิทธิ์สหสัมพันธพหุคูณ (R) คาอํานาจในการพยากรณ (R2) คาอํานาจในการ
พยากรณท่ีเพิ่มข้ึน (R2Change) คาความคลาดเคล่ือนมาตรฐานของการพยากรณ (SEest) 
และคาสถิติของการแจกแจงแบบเอฟ (F) จากการใชตัวพยากรณ 14 ตัว 

ตัวแปร b β β % อันดับท่ี SE b t 

X1 .131 .126 12.10 2 .055 2.397* 
X2 .058 .060 5.76 5 .052 1.111 
X3 -.092 -.107 10.28 4 .046 -2.007** 
X4 .255 .233 22.38 1 .062 4.122** 
X5 -.055 -.123 11.82 3 .022 -2.491* 
X6 .088 .051 4.90 6 .091 .963 
X7 -.047 -.033 3.17 7 .077 .607 
X8 .093 .066 6.34 1 .079 1.178 
X9 .097 .038 3.65 3 .139 .695 
X10 .083 .032 3.07 4 .166 .501 
X11 .033 .019 1.83 5 .126 .262 
X12 .093 .045 4.32 2 .147 .634 
X13 .042 .017 1.86 1 .131 .235 
X14 .116 .108 10.37 1 .074 1.566 

รวม 1.041 100    
 R  =  .933    SEest   =  10.806 F   =   6.966** 
 R 2 =  .871       a    =  -9.990  

* มีนัยสําคัญทางสถิติท่ีระดับ .05    ** มีนัยสําคัญทางสถิติท่ีระดับ .01 
 
 จากตารางท่ี 3 การวิเคราะหการถดถอยพหุคูณแบบสเต็บไวสของตัวพยากรณท่ีเขาสูสมการ
คาสัมประสิทธิ์สหสัมพันธพหุคูณ  พบวา คาสัมประสิทธิ์สหสัมพันธพหุคูณระหวางแตละดานของ
สมรรถภาพทางสมอง แรงจูงใจภายในของตนเอง ลักษณะนิสัย การรับรูความสามารถของตนเอง 
สงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส  มีคาเทากับ  .933  โดยตัวแปร
พยากรณท้ัง  14  ตัวรวมกันพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส  รอยละ  
87.1  คาน้ําหนักความสําคัญแตละดานของสมรรถภาพทางสมอง แรงจูงใจภายในของตนเอง ลักษณะ
นิสัย การรับรูความสามารถของตนเอง ในรูปคะแนนดิบ (b) มีคาต้ังแต  -.092  ถึง  .255  และในรูป

คะแนนมาตรฐาน (β) มีคาต้ังแต  -.123  ถึง  .233  เมื่อพิจารณาในดานสมรรถภาพทางสมอง  
พบวา สมรรถภาพทางสมองดานมิติสัมพันธสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกสสูงสุด รอยละ  22.38  ซึ่งมีนัยสําคัญทางสถิติท่ีระดับ .01 รองลงมาตามลําดับ  ไดแก  
สมรรถภาพทางสมองดานภาษาสงผลรอยละ  12.10 สมรรถภาพทางสมองดานความจําสงผลรอยละ  



55 

11.82  สมรรถภาพทางสมองดานตัวเลขสงผลรอยละ 10.28 ซึ่งมีนัยสําคัญทางสถิติท่ีระดับ .05  และ
สมรรถภาพทางสมองดานเหตุผลสงผลตํ่าสุดรอยละ  3.17 ซึ่งไมมีนัยสําคัญทางสถิติ  เมื่อพิจารณา
ลักษณะนิสัย พบวา  ลักษณะนิสัยดานความมีวินัย ลักษณะนิสัยดานความรับผิดชอบ ลักษณะนิสัย
ดานความอดทน ลักษณะนิสัยดานความกระตือรือรน และลักษณะนิสัยดานความต้ังใจ สงผลตอ
ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส รอยละ 6.34  4.32  3.65 3.07 และ 1.83 
ตามลําดับ  ซึ่งไมมีนัยสําคัญทางสถิติ   
  สําหรับคาสัมประสิทธิ์การถดถอยของตัวแปรพยากรณในรูปคะแนนดิบ (b) ท่ีไมสามารถ
พยากรณได  มี  9  ตัว  คือ  สมรรถภาพทางสมองดานการใชคํา (X2) สมรรถภาพทางสมองดานการ
สังเกตรับรู (X6) สมรรถภาพทางสมองดานเหตุผล (X7) ลักษณะนิสัยดานความมีวินัย (X8) ลักษณะ
นิสัยดานความอดทน (X9) ลักษณะนิสัยดานความกระตือรือรน (X10) ลักษณะนิสัยดานความต้ังใจ 
(X11) ลักษณะนิสัยดานความรับผิดชอบ (X12) และการรับรูความสามารถของตนเอง (X14)   
  สวนคาสัมประสิทธิ์การถดถอยของตัวแปรพยากรณในรูปคะแนนดิบ (b) เรียงลําดับจากมาก
ไปหานอยดังนี้  ลําดับท่ี  1  สมรรถภาพทางสมองดานการสังเกตรับรู (X6) ลําดับท่ี  2  สมรรถภาพ
ทางสมองดานเหตุผล (X7)  ลําดับท่ี  3  สมรรถภาพทางสมองดานการใชคํา (X2) และลําดับสุดทาย
คือ สมรรถภาพทางสมองดานความจํา (X5) ดังกลาวสามารถสรางสมการพยากรณความสามารถใน
การเรียนวิชาคอมพิวเตอรกราฟกส  โดยใชองคประกอบแตละดานของสมรรถภาพทางสมอง 
แรงจูงใจภายในของตนเอง ลักษณะนิสัย การรับรูความสามารถของตนเองเปนตัวพยากรณและได
สมการพยากรณในรูปคะแนนดิบและคะแนนมาตรฐาน  ดังนี้ 
 Y  =  .131X1 + .058X2 - .092X3 + .255X4 - .055X5 +.088X6 - .047X7 + .093X8 
+  

.097X9 + .083X10 + .033X11 +.093X12 + .042X13 + .116X14 – 9.990 
 Z  =  .126ZX1 + .060ZX2 - .107ZX3 + .233ZX4 - .1235ZX5 + .051ZX6 - 
.033ZX7  

+ .066ZX8 + .038ZX9 + .032ZX10 + .019ZX11 + .045ZX12 + .017ZX13 +  
.108ZX14 

 
ตารางท่ี 4  คาสัมประสิทธิ์สหสัมพันธพหุคูณ อํานาจการพยากรณของสมรรถภาพทางสมอง  

แรงจูงใจภายในของตนเอง ลักษณะนิสัย การรับรูความสามารถของตนเองโดยภาพรวมท่ี
สงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส   

ตัวแปร b β β % อันดับท่ี SE b t 

XT1 .019 .075   57.99 1 .013 1.514 
XT2 .058 .095 29.78 2 .032 1.792 
X13 .042 .017 1.86 4  .131 .235 
X14 .116 .108 10.37 3 .074 1.566 

รวม                               1.978 100 
 R  =  .331    SEest   =   10.276 F   =   16.873** 
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 R 2 =  .110       a    =  -12.225  
** มีนัยสําคัญทางสถิติท่ีระดับ  .01 
  จากตารางท่ี 4 พบวา  คาสัมประสิทธิ์สหสัมพันธพหุคูณระหวางสมรรถภาพทางสมอง 
แรงจูงใจภายในของตนเอง ลักษณะนิสัย การรับรูความสามารถของตนเองโดยภาพรวมท่ีสงผลตอ
ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส มีคาเทากับ  .331  และมีการแปรผันรวมกันท้ัง  
4  ตัวแปร  คิดเปนรอยละ 11  อํานาจการพยากรณแตละดานของสมรรถภาพทางสมอง แรงจูงใจ
ภายในของตนเอง ลักษณะนิสัย การรับรูความสามารถของตนเองในรูปคะแนนดิบ (b) มีคาต้ังแต  

.019  ถึง  .116  และในรูปคะแนนมาตรฐาน (β) มีคาต้ังแต  .075  ถึง  .108 พบวา สมรรถภาพทาง
สมอง มีน้ําหนักความสําคัญท่ีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสสูงสุดรอย
ละ  57.99 อยางมีนัยสําคัญทางสถิติท่ีระดับ  .01  รองลงมา  ไดแก ลักษณะนิสัยสงผลรอยละ 29.78  
การรับรูความสามารถของตนเองสงผลรอยละ 10.37 และแรงจูงใจในตนเองสงผลนอยท่ีสุดรอยละ  
1.86 อยางไมมีนัยสําคัญทางสถิติ 
 
ตารางท่ี 5 ผลการคนหาตัวแปรพยากรณท่ีดี โดยการวิเคราะหการถดถอยพหุคูณแบบข้ันตอน 
 
ชุดของตัวพยากรณท่ีดี R R 2 R 2Change SE est F 

X5 .303 .092  10.353 41.758** 

X5X4 .353 .124 .032 10.178 29.259** 
X5X4X6 .387 .150 .026 10.041 24.140** 

X5X4X6X7 .402 .161 .011 9.985 19.730** 
** มีนัยสําคัญทางสถิติท่ีระดับ  .01 
 
 จากตารางท่ี 5  พบวา ในข้ันท่ี  1  เมื่อสมรรถภาพทางสมองดานความจํา (X5) เปนตัวแปร
พยากรณ คาอํานาจในการพยากรณ (R2) เทากับ  .092  คาความคลาดเคล่ือนมาตรฐานในการ
พยากรณ  เทากับ  10.353  ในข้ันท่ี  2  เมื่อเพิ่มตัวพยากรณซึ่งเปนสมรรถภาพทางสมองดานมิติ
สัมพันธ (X4) เขาไปในสมการ  คาอํานาจการพยากรณเทากับ  .124  เพิ่มข้ึนจากเดิม  .032  คา
ความคลาดเคล่ือนมาตรฐานในการพยากรณ  เทากับ 10.178  ลดลงจากเดิม  .175  ในข้ันท่ี  3  เมื่อ
เพิ่มตัวแปรพยากรณซึ่งเปนสมรรถภาพทางสมองดานการสังเกตรับรู (X6) เขาไปในสมการ  คาอํานาจ
การพยากรณเทากับ .150  เพิ่มข้ึนจากเดิม  .026  คาความคลาดเคล่ือนมาตรฐานในการพยากรณ
เทากับ  10.041  ลดลงจากเดิม  0.137  และในข้ันสุดทายคือข้ันท่ี  4  เมื่อเพิ่มตัวพยากรณซึ่งเปน
สมรรถภาพทางสมองดานเหตุผล (X7) เขาไปในสมการ คาอํานาจการพยากรณเทากับ  .161  เพิ่มข้ึน
จากเดิม  .011  คาความคลาดเคล่ือนมาตรฐานในการพยากรณ  เทากับ  9.985  ลดลงจากเดิม  
.056  และเมื่อทดสอบความแตกตางระหวางคาอํานาจการพยากรณเดิมกับคาอํานาจการพยากรณท่ี
เพิ่มข้ึนในแตละข้ันตอน  พบวา ลักษณะการเพิ่มของอํานาจการพยากรณและการลดลงของคาความ
คลาดเคล่ือนมาตรฐานจากเดิมในแตละข้ันตอนนี้มีความแตกตางกันอยางมีนัยสําคัญทางสถิติท่ีระดับ  
.01 นอกจากนั้น  เมื่อพิจารณาคาความคลาดเคล่ือนมาตรฐานในการพยากรณแตละข้ันตอน ก็พบวา  
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มีคาลดลงทุกข้ันตอนแสดงวา  ตัวแปรพยากรณทุกตัวท่ีเขาสูสมการพยากรณรวมกันพยากรณ
ความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสไดหลังจากนี้  เมื่อเพิ่มตัวแปรพยากรณท่ีเหลือ  
คือ  สมรรถภาพทางสมองดานภาษา (X1) สมรรถภาพทางสมองดานการใชคํา (X2) สมรรถภาพทาง
สมองดานตัวเลข (X3) ลักษณะนิสัยดานความมีวินัย (X8) ลักษณะนิสัยดานความอดทน (X9) ลักษณะ
นิสัยดานความกระตือรือรน (X10) ลักษณะนิสัยดานความต้ังใจ (X11) ลักษณะนิสัยดานความ
รับผิดชอบ (X12) แรงจูงใจภายในของตนเอง (X13) และการรับรูความสามารถของตนเอง (X14) เขาไป
ในสมการแลวทดสอบนัยสําคัญของคาสหสัมพันธพหุคูณเดิมกับคาสหสัมพันธพหุคูณเมื่อเพิ่มตัวแปร
พยากรณเขาไปครั้งละ  1  ตัว ปรากฏวา  คาสหสัมพันธพหุคูณเพิ่มข้ึนอยางไมมีนัยสําคัญทางสถิติ  
ซึ่งแสดงใหเห็นวา ตัวแปรพยากรณท่ีเหลือเหลานี้อธิบายความแปรปรวนของตัวเกณฑไดนอย จึงถูก
นําออกจากสมการพยากรณการสรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกสจากกลุมตัวแปรพยากรณท่ีดีจากผลของการวิเคราะห  เพื่อคนหาตัวแปรพยากรณท่ีดีในการ
พยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส ผูวิจัยไดวิเคราะหขอมูลเพื่อหาคา

น้ําหนักความสําคัญหรือคาสัมประสิทธิ์ของตัวแปรพยากรณ (b, β) ท้ัง  4  ตัวและคาคงท่ีของสมการ
พยากรณในรูปคะแนนดิบ (a) ดังแสดงในตารางท่ี 6 
 
ตารางท่ี 6  คาสหสัมพันธพหุคูณของตัวแปรพยากรณท่ีดี  4  ตัว  จากการใชตัวแปรพยากรณ 14  

ตัวกับตัวแปรเกณฑ 
ตัวพยากรณ b β SE b t 

X14 .206 .192 .053 3.899** 

X4 .227 .207 .055 4.152** 
X1 .171 .165 .050 3.411** 
X5 -.052 -.115 .022 -2.383** 

R  =  .402 SE est   =  9.985 F   =   19.730 ** 
R 2 =  .161    a      =  -2.623  
*  มีนัยสําคัญทางสถิติท่ีระดับ  .05  ** มีนัยสําคัญทางสถิติท่ีระดับ  .01 
 
 จากตารางท่ี 6 พบวา การทดสอบนัยสําคัญของคาสหสัมพันธพหุคูณของตัวแปรพยากรณท่ีดี
กับตัวแปรเกณฑโดยใชการทดสอบเอฟ (F-test)  พบวา คาสหสัมพันธพหุคูณดังกลาวมีนัยสําคัญทาง
สถิติท่ีระดับ .01 อยู 3 ดาน คือ การรับรูความสามารถของตนเอง สมรรถภาพทางสมองดานมิติ
สัมพันธ และสมรรถภาพทางสมองดานภาษา แสดงวาตัวแปรพยากรณท้ัง  3  ดาน  สามารถรวมกัน
พยากรณตัวแปรเกณฑไดดี  โดยมีอํานาจในการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกสไดอยางมีนัยสําคัญทางสถิติท่ีระดับ .01 ท้ัง 3 ดานและคาสหสัมพันธพหุคูณ  มีนัยสําคัญทาง
สถิติท่ีระดับ  .05  อยู  1  ดาน คือ สมรรถภาพทางสมองดานความจํา โดยมีน้ําหนักความสําคัญของ
ตัวแปรพยากรณแตละตัวในรูปคะแนนดิบ (b) ตามลําดับความสําคัญ  ดังนี้ 
  1. การรับรูความสามารถของตนเอง 
  2. สมรรถภาพทางสมองดานมิติสัมพันธ 
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  3. สมรรถภาพทางสมองดานภาษา 
  4. สมรรถภาพทางสมองดานความจํา 
สรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
 จากผลการวิเคราะหขางตนพบวา ตัวพยากรณท้ังหมดมีอํานาจในการพยากรณไดรอยละ  
16.10 มีคาสัมประสิทธิ์สหสัมพันธพหุคูณเทากับ .402 คาความคลาดเคล่ือนมาตรฐานในการ
พยากรณ เทากับ  9.985 คาคงท่ีของสมการพยากรณในรูปคะแนนดิบเทากับ -2.623 และไดสมการ
พยากรณพยากรณในรูปคะแนนดิบและคะแนนมาตรฐาน  ดังนี้ 
 สมการในรูปคะแนนมาตรฐาน 
   Y  =  .206X14 + .227X4 + .171X1 - .052X5 – 2.623 
 

สมการในรูปคะแนนดิบ 
  Z  =  .192ZX14 + .207ZX4 + .165ZX1 - .115ZX5 
 
 
 
  
 
 
 
 



 

 

บทที่ 5 
สรุปผล อภิปรายผล และขอเสนอแนะ 

 
  การวิจัยเรื่อง องคประกอบท่ีมีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส มี
วัตถุประสงคเพื่อ 1) เพื่อศึกษาความสัมพันธระหวางสมรรถภาพทางสมอง ลักษณะนิสัย แรงจูงใจ
ภายในของตนเอง และการรับรูความสามารถของตนเองกับความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส และ 2) เพื่อสรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส กลุม
ตัวอยางไดแก นักศึกษาสาขาวิชาไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร มหาวิทยาลัยเทคโนโลยีราช
มงคลพระนคร จํานวน 15 คน ซึ่งไดมาโดยการสุมกลุมตัวอยางแบบเจาะจง (Purposive Sampling)  
  เครื่องมือท่ีใชในการเก็บรวบรวมขอมูลในครั้งนี้ ประกอบดวย  

1. แบบทดสอบสมรรถภาพทางสมอง 
2. แบบวัดแรงจูงใจภายในของตนเอง 
3. แบบทดสอบวัดลักษณะนิสัย 
4. แบบวัดการรับรูความสามารถของตนเอง 
5. แบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส 

 ในการวิเคราะหขอมูล ผูวิจัยดําเนินการวิเคราะหขอมูลทางสถิติ ดังนี้ 
 1. หาคาสถิติพื้นฐานของแบบทดสอบและแบบวัดแตละฉบับ ไดแก แบบทดสอบวัดสมรรถ 
ภาพทางสมอง  แรงจูงใจภายในของตนเอง ลักษณะนิสัย การรับรูความสามารถของตนเอง และ
แบบทดสอบวัดความสามารถดานการเรียนวิชาคอมพิวเตอรกราฟกส 
  2. วิเคราะหหาคุณภาพของแบบทดสอบและแบบวัดแตละฉบับ ดังนี ้
   2.1 แบบทดสอบ วิเคราะหหาคาความยากงาย คาอํานาจจําแนก และความเช่ือมั่น
ของแบบทดสอบแตละฉบับ ไดแก สมรรถภาพสมองดานภาษา ดานตัวเลข ดานมิติสัมพันธ ดานการ
สังเกตรับรู ดานเหตุผล ดานการใชคํา ดานความจํา และแบบทดสอบวัดความสามารถดานการเรียน
วิชาคอมพิวเตอรกราฟกส 
  2.2 แบบวัด วิเคราะหคาอํานาจจําแนก และความเช่ือมั่นของแบบวัดลักษณะนิสัย 
แรงจูงใจภายในของตนเอง และแบบวัดการรับรูความสามารถของตนเอง 
 3. ตรวจสอบปญหาเกี่ยวกับความสัมพันธระหวางตัวแปรอิสระดวยกันท่ีเรียกวา 
Multicollinerarity 
  4. วิเคราะหความสัมพันธระหวางตัวแปรท่ีใชในการพยากรณกับตัวแปรเกณฑโดยใชสูตรของ
เพียรสัน แลวทดสอบความมีนัยสําคัญของคาสัมประสิทธิ์สหสัมพันธนั้นโดยการทดสอบคาที (T-test) 
 5. วิเคราะหหากลุมตัวพยากรณเพื่อทํานายความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส โดยการวิเคราะหการถดถอยพหุคูณแบบสเตบไวส (Stepwise Solution) 
 6. สรางสมการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
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สรุปผล 
  ผลการวิจัยเรื่ององคประกอบท่ีมีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
สรุปผลการวิจัย ไดดังนี้ 
 1. ผลการศึกษาความสัมพันธระหวางสมรรถภาพทางสมองดานภาษา ดานการใชคํา ดาน
ตัวเลข ดานมิติสัมพันธ ดานความจํา ดานการสังเกตรับรู ดานเหตุผล ลักษณะนิสัยดานความมีวินัย 
ดานความอดทน ดานความกระตือรือรน ดานความต้ังใจ ดานความรับผิดชอบ แรงจูงใจภายในตนเอง 
และการรับรูความสามารถของตนเองกับความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสของ
นักศึกษาสาขาวิชาวิศวกรรมไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตรอุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร พบวา ตัวแปรท่ีสัมพันธทางบวกกับความสามารถในการ
เรียนวิชาคอมพิวเตอรกราฟกสของนักศึกษา อยางมีนัยสําคัญทางสถิติท่ีระดับ .01 คือ สมรรถภาพ
ทางสมองดานการสังเกตรับรู (X6) การรับรูความสามารถของตนเอง (X14) สมรรถภาพทางสมองดาน
การใชคํา (X2) ลักษณะนิสัยดานความกระตือรือรน (X10) แรงจูงใจภายในของตนเอง (X13) ลักษณะ
นิสัยดานความรับผิดชอบ (X12) สมรรถภาพทางสมองดานการใชคํา (X7) ลักษณะนิสัยดานความต้ังใจ 
(X11) มีคาสัมประสิทธิ์สหสัมพันธเทากับ .577 .570 .424 .322 .318 .299 .256 .251 และ .185 
ตามลําดับ และตัวแปรพยากรณท่ีมีความสัมพันธกับตัวแปรเกณฑมีนัยสําคัญทางสถิติท่ีระดับ .05 คือ 
สมรรถภาพทางสมองดานการสังเกตรับรู (X6) มีคาสัมประสิทธิ์สหสัมพันธเทากับ .100 ยกเวน การ
รับรูความสามารถของตนเอง (X14) ท่ีไมมีความสัมพันธกับความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส 
  2. การทดสอบนัยสําคัญของคาสหสัมพันธพหุคูณของตัวแปรพยากรณท่ีดีกับตัวแปรเกณฑ
โดยใชการทดสอบเอฟ (F-test)  พบวา คาสหสัมพันธพหุคูณดังกลาวมีนัยสําคัญทางสถิติท่ีระดับ .01 
อยู 3 ดาน คือ การรับรูความสามารถของตนเอง สมรรถภาพทางสมองดานมิติสัมพันธ และ
สมรรถภาพทางสมองดานภาษา แสดงวาตัวแปรพยากรณท้ัง  3  ดาน  สามารถรวมกันพยากรณตัว
แปรเกณฑไดดี  โดยมีอํานาจในการพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสได
อยางมีนัยสําคัญทางสถิติท่ีระดับ .01 ท้ัง 3 ดานและคาสหสัมพันธพหุคูณ  มีนัยสําคัญทางสถิติท่ี
ระดับ  .05  อยู  1  ดาน คือ สมรรถภาพทางสมองดานความจํา โดยมีน้ําหนักความสําคัญของตัวแปร
พยากรณแตละตัวในรูปคะแนนดิบ (b) ตามลําดับความสําคัญ  ดังนี้ 
  1. การรับรูความสามารถของตนเอง 
  2. สมรรถภาพทางสมองดานมิติสัมพันธ 
  3. สมรรถภาพทางสมองดานภาษา 
  4. สมรรถภาพทางสมองดานความจํา 
  3. ตัวพยากรณท้ังหมดมีอํานาจในการพยากรณไดรอยละ  16.10 มีคาสัมประสิทธิ์
สหสัมพันธพหุคูณเทากับ .402 คาความคลาดเคล่ือนมาตรฐานในการพยากรณ เทากับ  9.985 
คาคงท่ีของสมการพยากรณในรูปคะแนนดิบเทากับ -2.623 และไดสมการพยากรณพยากรณในรูป
คะแนนดิบและคะแนนมาตรฐาน  ดังนี้ 
 สมการในรูปคะแนนมาตรฐาน 
   Y  =  .206X14 + .227X4 + .171X1 - .052X5 – 2.623 
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สมการในรูปคะแนนดิบ 
  Z  =  .192ZX14 + .207ZX4 + .165ZX1 - .115ZX5 
 
อภิปรายผล 
 การวิจัยเรื่ององคประกอบท่ีมีสงผลตอความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
สามารถสรุปประเด็นสําคัญไดดังนี้   
  คาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรเกณฑ คือ ความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกสกับตัวแปรพยากรณ คือ สมรรถภาพทางสมองดานภาษา ดานการใชคํา ดาน
ตัวเลข ดานมิติสัมพันธ ดานความจํา ดานการสังเกตรับรู ดานเหตุผล ลักษณะนิสัยดานความมีวินัย 
ดานความอดทน ดานความกระตือรือรน ดานความต้ังใจ ดานความรับผิดชอบ และแรงจูงใจภายใน
ตนเอง พบวา มีความสัมพันธทางบวกกับความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส ซึ่งเปน
ตามสมมติฐานท่ีต้ังไว สวนการรับรูความสามารถของตนเองไมมีความสัมพันธกับความสามารถในการ
เรียนวิชาคอมพิวเตอรกราฟกส ซึ่งจากผลการวิจัยพบวา 
  สมรรถภาพทางสมองแตละดานมีความสัมพันธกับความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกสของนักศึกษาอยางมีนัยสําคัญทางสถิติท่ีระดับ .01 ดวยเหตุผล่ีวาสมรรถภาพทางสมองเปน
ตัวแปรสําคัญของการเรียนรู และเปนตัวพยากรณท่ีสงผลตอกิจกรรมทางสมอง ความสามารถในการ
เรียนวิชาคอมพิวเตอรกราฟกสเปนกิจกรรมทางสมองอยางหนึ่ง จึงทําใหแบบทดสอบสมรรถภาพทาง
สมองมีความสัมพันธกับแบบทดสอบความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส ซึ่ง
สอดคลองกับผลงานวิจัยของภาณุวัชร  ปุรณะศิริ (2546: บทคัดยอ) พบวา สมรรถภาพทางสมองดาน
ตัวเลข ดานการใชคํา ดานมิติสัมพันธ มีความสัมพันธกับความสามารถในการเขียนโปรแกรม
คอมพิวเตอร และผลงานวิจัยของสาคร  ยาระวัง (2545: บทคัดยอ) ไดศึกษาความสัมพันธระหวาง
สมรรถภาพทางสมองและลักษณะนิสัยกับสมรรถภาพในการพัฒนาโปรกรมคอมพิวเตอร พบวา 
สมรรถภาพทางสมองดานตัวเลข ดานความจํา มีความสัมพันธกับสมรรถภาพในการพัฒนาโปรแกรม
คอมพิวเตอร ซึ่งผลสัมฤทธิ์ดังกลาวเปนกิจกรรมทางสมองอยางหนึ่ง เหมือนกับความสามารถในการ
เรียนวิชาคอมพิวเตอรกราฟกส 
 ลักษณะนิสัยแตละดานมีความสัมพันธกับความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส
อยางมีนัยสําคัญทางสถิติท่ีระดับ .01 ซึ่งสอดคลองกับผลงานวิจัยของสาคร  ยาระวัง (2545: 
บทคัดยอ) ท่ีพบวา ลักษณะนิสัยดานความอดทนและดานความรับผิดชอบมีความสัมพันธกับการ
พัฒนาโปรแกรมคอมพิวเตอรท่ีทําใหนักคอมพิวเตอรสามารถเขียนโปรแกรมคอมพิวเตอร ระบบ
คอมพิวเตอร คอมพิวเตอรกราฟกสไดอยางมีประสิทธิภาพ อีกท้ังยังสอดคลองลักษณะงานของนัก
โปรแกรมคอมพิวเตอรท่ีมีความเครียดสูงในการทํางาน ตองมีการแกปญหาท่ีหลากหลายรูปแบบ ตอง
ทํางานหนักภายในเวลาท่ีจํากัด  
 แรงจูงใจภายในของตนเอง มีความสัมพันธกับความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกสอยางมีนัยสําคัญทางสถิติท่ีระดับ .01 ซึ่งสอดคลองกับแนวความคิดของกิตติ ตยัคคานนท ท่ี
กลาวไววา แรงจูงใจท่ีเกิดจากส่ิงเราภายในรางกาย หรือแรงจูงใจท่ีเกิดข้ึนภายใน ดานบุคคลเอง เชน 
ความหิวกระหาย ความรัก เปนตน จึงทําใหนักคอมพิวเตอรตองเปนผูท่ีไมยอมแพตอปญหา เพราะ
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ลักษณะการทํางานตองคิดหาวิธีการแกปญหาทางดานคณิตศาสตรหรือตรรกวิทยา ซึ่งเปนลักษณะ
ของบุคคลท่ีชอบคนพบรางวัลในตัวของงาน  
 การรับรูความสามารถขอตนเอง ไมมีความสัมพันธกับความสามารถในการเรียนวิชา
คอมพิวเตอรกราฟกส ท้ังนี้เนื่องจาก การเรียนวิชาคอมพิวเตอรกราฟกสเปนลักษณะงานท่ีตองอาศัย
ท้ังทักษและความชํานาญหลายดานประกอบดวย เชน การเตรียมอัลกอริทึม การเขียนผังงาน การ
เขียนโปรแกรม การตรวจแกขอผิดพลาดและการทดสอบโปรแกรม ซึ่งแตละดานตองอาศัยทักษะ
ความชํานาญและประสบการณเฉพาะของแตละบุคคลเปนไปไดคอนขางยากท่ีบุคคลหนึ่งคนตองมี
ความสามารถครบทุกดาน และการรับรูความสามารถของตนเองนั้น ดังท่ี Bandura (1977) ไดเสนอ
วิธีการพัฒนาการรับรูความสามารถของตนเองไววา การท่ีจะทําใหบุคคลประประสบการณ
ความสําเร็จของตนเอง (Enactive mastery experience) เปนวิธีการท่ีมีประสิทธิภาพมากท่ีสุด ใน
การพัฒนาการรับรูความสามารถของตนเอง เนื่องจากวาเปนประสบการณโดยตรง การประสบ
ความสําเร็จทําใหเพิ่มความสามารถของตนเอง บุคคลจะเช่ือวาเขาสามารถท่ีจะทําได การกระทํา
กิจกรรมจนเกิดความสําเร็จ จะชวยสงผลใหบุคคลมีการรับรูความสามารถของตนเองสูง โดยเช่ือวาถา
หากใหกระทํากิจกรรมนั้นอีกหรือกระทํากิจกรรมท่ีมีลักษณะคลายคลึงกัน จะสามารถกระทํากิจกรรม
นั้นไดสําเร็จซ้ําอีก ความสําเร็จหลายๆ ครั้งท่ีไดรับจะชวยสรางระดับพลังความเช่ือท่ีแรงกลาในการ
รับรูความสามารถของตนเอง แตความลมเหลวซ้ําแลวซ้ําเลาจะบ่ันทอนความเช่ือในการรับรู
ความสามารถของตนเอง โดยเฉพาะอยางยิ่งถาความลมเหลวนั้นเกิดข้ึนกอนท่ีความเช่ือมั่นใน
ความสามารถของตนเองจะถูกสรางข้ึน ถาหากบุคคลใดไดสรางความเช่ือมั่นในความสามารถของ
ตนเองข้ึนมาแลว ก็มักจะมีความพยายามในการทํากิจกรรมท่ีกําหนด และถึงแมจะตองเผชิญกับ
อุปสรรคตางๆ ก็ไมยอทองาย ประสบการณของการไดรับความสําเร็จมากอนเปนแหลงท่ีมาท่ีสําคัญ
และมีอิทธิพลมากท่ีสุดในการสรางการรับรูความสามารถของตนเอง (Percieved self-efficacy) 
 
ขอเสนอแนะ 
 จากผลการวิจัยดังกลาว ผูวิจัยมีขอเสนอแนะ ดังตอไปนี้ 
 1. ขอเสนอแนะในการนําผลการวิจัยไปใช 
  1.1 การทดสอบความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสของนักศึกษาสาขาวิชา
วิศวกรรมไฟฟา แขนงวิชาวิศวกรรมคอมพิวเตอร คณะครุศาสตรอุตสาหกรรม มหาวิทยาลัย
เทคโนโลยีราชมงคลพระนคร พบวา ลักษณะนิสัยดานความกระตือรือรนมีคารอยละของคะแนนเฉล่ีย
เมื่อเทียบกับคะแนนเต็มตํ่าท่ีสุด และโดยรวมของคะแนนเฉล่ียคอนขางตํ่า ดังนั้น เพื่อเปนการ
ชวยเหลือและสงเสริมใหนักศึกษาประสบผลสําเร็จในการเรียนวิชาคอมพิวเตอรกราฟกส ผูสอนควร
คํานึงถึงตัวแปรลักษณะนิสัยดานความกระตือรือรน คือ ควรใหนักศึกษามีการฝกฝนทักษะในการ
เรียนวิชาคอมพิวเตอรกราฟกสใหมากข้ึน และควรมีการจัดกิจกรรมท่ีเนนใหนักศึกษามีความ
กระตือรือรนในการทํางานและพัฒนาทักษะในการเรียนวิชาคอมพิวเตอรกราฟกสโดยเฉพาะใหกับ
นักศึกษา 
 1.2 การทดสอบสมรรถภาพทางสมองดานมิติสัมพันธ ดานภาษา และดานความจํา การรับรู
ความสามารถของตนเอง สามารถพยากรณความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสได 
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ดังนั้น ในการใหนักศึกษาเลือกเรียนวิชาคอมพิวเตอรกราฟกสในระดับนี้ หากมีการวัดสมรรถภาพทาง
สมองและลักษณะนิสัยดังกลาวแลว จะชวยใหไดขอมูลสําหรับพิจารณาหรือแนะนํานักศึกษาท่ีชัดเจน 
ซึ่งเปนส่ิงท่ีเสริมใหนักศึกษามีความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกสมากยิ่งข้ึน 
  2. ขอเสนอแนะเพื่อการวิจัย 
 2.1 ควรศึกษาตัวแปรอื่น ๆ ท่ีจะมีอิทธิพลตอความสามารถในการเรียนวิชาคอมพิวเตอร
กราฟกส ไดแก ผลสัมฤทธิ์ทางการเรียน ความถนัดทางการเรียน กิจกรรมท่ีใชในการเรียนวิชา
คอมพิวเตอรกราฟกส เปนตน 
 2.2 ควรศึกษาวิธีการเรียนท่ีจะทําใหนักศึกษามีผลสัมฤทธิ์ทางการเรียนวิชาคอมพิวเตอร
กราฟกส 
    



บรรณานุกรม 
 
กมลรัตน  หลาสุวงษ. จิตวิทยาการศึกษานอกโรงเรียน. พิมพครั้งท่ี 2. กรุงเทพฯ : ศรีเดชา, 
 2552. 
กระทรวงศึกษาธิการ.  ประกาศกระทรวงศึกษาธิการ เร่ือง มาตรฐานคุณวุฒิระดับปริญญาตรี 

สาขาคอมพิวเตอร พ.ศ. 2552. กรุงเทพมหานคร, 2552. 
กิตติ  ตยัคคานนท. นักบริหารทันสมัย. พิมพครั้งท่ี 2. กรุงเทพฯ : บัตเตอรฟลาย, 2533. 
ครรชิต มาลัยวงศ.  สารสนเทศและการวิจัยการบริหารการศึกษาในประมวลสาระชุดวิชาการ

จัดการสถานศึกษา. นนทบุรี: มหาวิทยาลัยสุโขทัยธรรมาธิราช, 2545.   
ชลา แพรัตกุล. เทคนิคการเขียนคําถามเลือกตอบ. กรุงเทพฯ: กิ่งจันทรพิมพ, 2543. 
ถวิล  เกื้อกูลวงศ. การจูงใจเพื่อผลงาน. นครปฐม : โรงพิมพมหาวิทยาลัยศิลปากร วิทยาเขต 
 พระราชวังสนามจันทร, 2552. 
ทองหลอ นาคหอม. แรงจูงใจในการศึกษาตอระดับปริญญาโทของนิสิต วิชาเอกการบริหาร

การศึกษา มหาวิทยาลัยนเรศวร ปการศึกษา 2533- 2534. วิทยานิพนธหลักสูตรระดับ
ปริญญาโท มหาวิทยาลัยนเรศวร. พิษณุโลก: มหาวิทยาลัยนเรศวร, 2535. 

ทิศนา แขมมณี. ศาสตรการสอน : องคความรูเพื่อการจัดกระบวนการเรียนรูท่ีมีประสิทธิภาพ.  
พิมพครั้งท่ี 5.  กรุงเทพฯ : สํานักพิมพแหงจุฬาลงกรณมหาวิทยาลัย, 2545. 

ภาณุวัชร  ปุรณะศิริ.  ตัวแปรท่ีสงผลตอความสามารถในการเขียนโปรแกรมคอมพิวเตอรของ
นักเรียนระดับมัธยมศึกษาตอนปลาย. วิทยานิพนธการศึกษามหาบัณฑิต สาขาวิชาการวิจัย
การศึกษา มหาวิทยาลัยมหาสารคาม.  มหาสารคาม, 2546. 

ยืน ภูวรรณ.  กวาจะเปนนักคอมพิวเตอร. คอมพิวเตอรแม็กกาซีน. 2(16): 16 มิถุนายน, 2533. 
ลวน  สายยศและอังคณา  สายยศ.  เทคนิคการสรางและเขียนขอสอบความถนัดทาง 

การเรียน.  พิมพครั้งท่ี 3. กรุงเทพฯ : สุวีริยาสาสน, 2541. 
สงวน  สุทธิเลิศอรุณ.  จิตวิทยาการศึกษา (ศึกษา 122).  พิมพครั้งท่ี 2.  กรุงเทพฯ: อักษรบัณฑิต, 

2528. 
สมโภชน  เอี่ยมสุภาษิต. ทฤษฎีและเทคนิคการปรับพฤติกรรม. กรุงเทพฯ: สํานักพิมพจุฬาลงกรณ

มหาวิทยาลัย, 2541.  
สุรศักด์ิ  อมรรัตนศักด์ิ  เตือนใจ เกตุษา และบุญมี  พันธไทย. การวิเคราะหขอมูลทางสถิติทางการ

ศึกษา.  พิมพครั้งท่ี 3. กรุงเทพฯ: สํานักพิมพศูนยสงเสริมวิชาการ, 2545. 
สาคร  ยาระวัง.  ความสัมพันธระหวางสมรรถภาพทางสมองและลักษณะนิสัยกับสมรรถภาพใน

การพัฒนาโปรกรมคอมพิวเตอร. วิทยานิพนธการศึกษามหาบัณฑิต มหาวิทยาลัยทักษิณ.  
สงขลา, 2545. 

อเนกกุล  กรีแสง. จิตวิทยาการศึกษา. พิมพครั้งท่ี 6. พิษณุโลก : โครงการตํารามหาวิทยาลัย 
 ศรีนครินทรวิโรฒ พิษณุโลก, 2546. 
__________. หลักสูตรครุศาสตรอุตสาหกรรมบัณฑิต.  แขนงวิชาวิศวกรรมคอมพิวเตอร 

มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร, 2550. 



65 

บรรณานุกรม (ตอ) 
 
อัลชลี แจมเจริญ.  จิตวิทยาธุรกิจ.  พิมพครั้งท่ี 3. กรุงเทพฯ: วิทยาลัยครูสวนสุนันทา, 2530. 
Bandura, A. Principles of behavior modification. New York: Holt, Rinehart and 

Winston, 1977. 
Bingham, Walter  Van Dyke.  Aptitude and Aptitude Testing.  New York: Harper, 

1937. 
Hilgard, Ernest R. Introduction to Psychology. New York : Harcourt, Brace and World 

Inc., 1981. 
Morgan, Clifford and Richard A. King. Introduction to Psychology. New York : 

McGraw-Hill Book Co., 1966. 
 
 



 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



67 

 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ก 
แบบทดสอบสมรรถภาพทางสมองดานความจํา 
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แบบทดสอบสมรรถภาพทางสมองดานความจํา 
คําช้ีแจง  1. แบบทดสอบชุดนี้เปนแบบปรนัย 5 ตัวเลือก จํานวน 20 ขอ ใชเวลา 15 นาที 

2. ใหนักเรียนเลือกตอบคําถามท่ีถูกตองท่ีสุดเพียงคําตอบเดียว แลวกาเครื่องหมาย 
x ตรงกับขอท่ีเลือกลงในกระดาษคําตอบ 

3. ใหนักเรียนเขียน ช่ือ-นามสกุล เลขประจําตัวนักเรียน ลงในกระดาษคําตอบให
ชัดเจน กอนทําแบบทดสอบ 

          4. หามขีดเขียนขอความใด ๆ ลงในแบบทดสอบนี ้
 
คําช้ีแจง   อานบทความเรื่อง ประเพณีทําบุญกลางบาน แลวตอบคําถาม ขอ 1-6 

1. ข้ันตอนของประเพณีทําบุญกลางบานคือขอใด 
ก. ปูเส่ือกลางลานบาน      
ข. นิมนตพระ 
ค. นําอาหารมาเล้ียงพระ 
ง. ทํากะแตะ 
จ. เชิญคนมารวมงาน 

2. “กระทงหนาวัว” คืออะไร 
ก. กระทงกาบกลวยรูปส่ีเหล่ียม 
ข. กระทงกาบกลวยรูปสามเหล่ียม 
ค. ถวยท่ีทําจากกาบกลวย 
ง. กระจาดใบกลวย 
จ. ใบตองกลวยหอเปนรูปสามเหล่ียม 

3. กระทงหนาวัวมีขนาดความยาวดานละเทาไร 
ก. 5-10 เซนติเมตร 
ข. 10-15 เซนติเมตร 
ค. 15-20 เซนติเมตร 
ง. 20-25 เซนติเมตร 
จ. 25-30 เซนติเมตร 

4. ชาวบานจะนํากระทงหนาวัวท่ีใสเครื่องเซนเรียบรอยแลวไปวางไวบริเวณใด 
ก. ทางส่ีแยก 
ข. ทางโคง 
ค. ชายปา 
ง. ทางสามแพรง 
จ. ริมถนน 
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5. คนท่ีทํากระทงและนําไปวางหามทําในส่ิงใด 
ก. หามยิ้ม 
ข. หามวิ่ง 
ค. หามทักหามพูด 
ง. หามรองเพลง 
จ. หามสงเสียงดัง 

6. ประเพณีทําบุญกลางบานแตเดิมผูเฒาผูแกเลาวาอยางไร 
ก. ทําทุกป 
ข. ทําปเวนป 
ค. ทําเฉพาะปท่ีฝนแลง 
ง. ทําทุกเดือน 6 
จ. ทําเฉพาะปท่ีอุดมสมบูรณ 

             คําช้ีแจง อานบทความเรื่อง การทําขนมกระยาสารท แลวตอบคําถาม ขอ 7-15 
7. กระยาสารทถาใสตูเย็นเก็บไวไดนานเทาใด 

ก. 2 สัปดาห 
ข. 2 เดือน 
ค. 6 สัปดาห 
ง. 6 เดือน 
จ. 8 เดือน 

8. ขนมกระยาสารท นิยมทําในเดือนใด 
ก. เดือนเจ็ด 
ข. เดือนแปด 
ค. เดือนเกา 
ง. เดือนสิบ 
จ. เดือนสิบเอ็ด 

9. ขนมกระยาสารทนี้ใชถ่ัวลิสงกี่กิโลกรัม 
ก. 16 กิโลกรัม 
ข. 26 กิโลกรัม 
ค. 28 กิโลกรัม 
ง. 29 กิโลกรัม 
จ. 30 กิโลกรัม 
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10. ขอใดไมใชสวนผสมของขนมกระยาสารทนี้ 
ก. งาขาว 
ข. น้ําตาลทราย 
ค. แบะแซ 
ง. ถ่ัวลิสง 
จ. ขาวเมา 

11. ข้ันตอนแรกของการทํากระยาสารทคือขอใด 
ก. ค่ัวถ่ัวลิสง 
ข. คัดเมล็ดถ่ัว 
ค. ค้ันกะทิ  
ง. เค่ียวน้ําตาล 
จ. ตากถ่ัวลิสง งา ขาวเมา 

12. ถาตองการใหขนมกระยาสารทแข็งตัวเร็วตองทําอยางไร 
ก. เค่ียวใชไฟแรง ๆ 
ข. เค่ียวไฟนานใหนาน ๆ 
ค. ใสแบะแซมาก ๆ 
ง. ใสน้ํากะทินอย ๆ 
จ. ทําเสร็จแลวนําเขาไวในตูเย็น 

13. หมูบานท่ีทํากระยาสารทนี้อยูในจังหวัดใด 
ก. บุรีรัมย 
ข. นครราชสีมา 
ค. สุรินทร 
ง. สระบุรี 
จ. ปทุมธาน ี

14. สวนผสมของกระยาสารทในบทความนี้ไดขนมกระยาสารทกี่กระทะ 
ก. 4 กระทะ  
ข. 3 กระทะ 
ค. 2 กระทะ 
ง. 1 กระทะ 
จ. ครึ่งกระทะ 

15. ในบทความนี้ใชสวนผสม งาขาวกี่กิโลกรัม 
ก. 6 กิโลกรัม 
ข. 8 กิโลกรัม 
ค. 12 กิโลกรัม 
ง. 16 กิโลกรัม 
จ. 28 กิโลกรัม 
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คําช้ีแจง อานบทความเรื่อง ไฟฟาราษฎร แลวตอบคําถาม ขอ 16-20 
16. ผูผลิตไฟฟาจําหนายแกราษฎรคนแรกเปนคนชาติใด 

ก. ไทย 
ข. ฝรั่งเศส 
ค. ญี่ปุน 
ง. เดนมารค 
จ. อังกฤษ 

17. ผูผลิตไฟฟาจําหนายคนแรกคือใคร 
ก. นายอังเดร 
ข. นายโฮลซ 
ค. นายแฉลม 
ง. จอมพล ป. 
จ. พระยากระสาปนกิจโกศล 

18. ใครคือผูดําเนินกิจการบริษัทไฟฟาสยาม 
ก. นายฉลาด 
ข. นายโฮลซ 
ค. นายแฉลม 
ง. จอมพล ป. 
จ. พระยากระสาปนกิจโกศล 

19. กิจการใดเกิดข้ึนเปนกิจการแรก 
ก. ไฟฟาสยาม 
ข. รถรางบางกอก 
ค. โรงไฟฟาวัดเลียบ 
ง. โรงไฟฟาฝายผลิต 
จ. Bangkok Electric Light Syndicate 

20. ช่ือเดิมของบริษัทไฟฟาไทยคอรปอเรช่ันคือ 
ก. ไฟฟาสยาม 
ข. รถรางบางกอก 
ค. โรงไฟฟาวัดเลียง 
ง. โรงไฟฟาฝายผลิต 
จ. Bangkok Electric Light Syndicat 
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บทความชุดท่ี 1 ใหนักเรียนอานเรื่อง ประเพณีทําบุญกลางบานของชาวไทยเบ้ิง ใหเวลา 3 นาที 
พรอมท้ังตอบคําถามขอ 1-6 โดยใชเวลา 2 นาที 
 
             ประเพณีทําบุญกลางบาน เปนประเพณีของชาวไทยเบ้ิงและชาวไทยในเขตลุมแมน้ําปาสัก 
ผูเฒาผูแกเลาวาประเพณีนี้แตเดิมมามิไดทําทุกป จะทําเฉพาะปท่ีฝนฟาไมตก ฝนแลงทํากลางเดือน 6 
เดือน 7 หรือ เดือน 8 คํ่าเดือน 6 วัตถุประสงคในการทําเพื่อเปนการทําบุญบูชาผี ใหคนในหมูบานอยู
กันอยางรมเย็นเปนสุข ไมมีโรคภัยรายแรง นาไรไดผลอุดมดี ข้ันตอนในการทําบุญกลางบาน เริ่มต้ังแต
ตอนเชาชาวบานจะนํากระดานหรือเส่ือมาปูกลางลานบานนิมนตพระสงฆมาฉันภัตตาหาร นิมนตพระ 
9 รูป หรือนิมนตท้ังวัด ชาวบานแตละบานท่ีมารวมงานจะนําอาหารไปทําบุญเล้ียงพระรวมกันท่ีลาน
บาน หลังจากทําบุญเล้ียงพระแลวจะกลับบานมาทํา “กระแตะหรือกะแตะ” กะแตะ เปนภาชนะท่ีทํา
จากกาบกลวยคลายกระทงแตทําเปนรูปสามเหล่ียม ใตกระทงจะใชกนกระจาดมาตัดเปนรูป
สามเหล่ียม เรียกกันวา “กระทงหนาวัว” ขนาดของกระทงมีความยาวดานละประมาณ 25-30 
เซนติเมตร อาจจะทําขนาดเล็กหรือใหญตางกันบางตามความพอใจของผูทําในแตละบานจากนั้นก็นํา
ดินเหนียวมาปนเปนรูปคน ขนาดเล็ก ๆ เทานิ้วหัวแมมือ สมมติวาเปนตัวแทนของคนในบาน ใหมี
จํานวนเทาคนในแตละบานวางลงในกระทง แลวปนดินเหนียวเปนรูปวัว-ควาย ตัวเล็ก ๆ วางลงใน
กระทง ใสอาหาร “ขาวดําขาวแดง” ลงในกระทง ขาวดําก็ทํางาย ๆ โดยใชขาวสุกมายอมสีดํา หรือนํา
ขาวสุกมาคลุกกับเขมาดินหมอใหเปนสีดํา สวนขาวแดงไมใสสีก็นําขาวสุกมาคลุกกับปูนแดง ปนเปน
กอนขนาดพอคําวางลงในกระทงอาจจะใสอาหารอื่น เชน พริก เกลือ มะเขือ ปลารา เพื่อใหผีกิน นํา
น้ําใสกระบอกทุกอยางวางลงในกระทงจนเต็มกระทง บางบานอาจใชดินปนเปนเงิน 12 ทอง 15 ใสลง
ในกระทงดวยก็ได จากนั้นนํากระทงไปวางตามทางสามแพรง ตามบานตางก็นําไปวาง หามทักหามพูด
ถาเห็นใครทํากระทงและนําไปวาง เช่ือวาถาใครไปทักเมื่อผีเห็นจะทําใหคนนั้นเจ็บไขไดปวย ขณะ
นําไปวางจะพูดบอกผีวาขอใหผีเอาหมูนี้ไป เอามาแทนคนและสัตวในบานใหแลว สวนคนและสัตวท่ี
อยูท่ีบานใหอยูดีมีสุข พูดแตส่ิงท่ีดีงามท่ีอยากไดแลววางกระทงท้ิงไวจึงกลับบาน หามหันกลับไปมอง
กระทงอีก ประเพณีนี้ดูคลายกับคนพยายามหลอกใหผีเช่ือเพื่อเปนการเอาตัวรอดใหพนทุกขพนภัย
อยางหนึ่ง 
 
บทความชุดท่ี 2 ใหนักเรียนอานเรื่อง กลุมแมบานประโคนชัย ใหเวลา 2 นาที  พรอมท้ังตอบคําถาม
ขอ 7-15 โดยใชเวลา 3 นาที 
 
            กลุมแมบานประโคนชัยเปนหมูบานอยูในจังหวัดบุรีรัมย ไดบอกวิธีทํากระยาสารทมาฝาก 
ซึ่งนิยมทํากันในเดือนสิบ โดยเริ่มท่ีสวนผสม ( สําหรับกวน 4 กระทะใหญ ๆ ) ใชถ่ัวลิสง 28 กิโลกรัม 
งาขาว 16 กิโลกรัม น้ําตาลปบ 28 กิโลกรัม แบะแซ 8 กิโลกรัม ขาวเมา 10 กิโลกรัม (ถาไมตองการ
แข็งมากใหลดปริมาณแบะแซลง) มะพราว 24 ลูก ข้ันตอนแรกใหนําถ่ัวลิสง งา ขาวเมา มาคัดเมล็ด 
เอาเมล็ดท่ีเสีย ๆ ออกไป จากนั้นนํามาค่ัว สวนขาวตอกจะซื้อแบบท่ีค่ัวมาเสร็จเรียบรอยแลว เมื่อค่ัว
ทุกอยาวงแลว ใหมาผสมรวมกันแลวใสภาชนะปดฝาไวแลวเอามะพราวมาค้ันกะทิต้ังไฟเค่ียวกับ
น้ําตาลปบ น้ํากะทิลดเหลือครึ่งหนึ่งใสแบะแซลงไปเค่ียวใหไดความนิ่มตามตองการ ถาตองการแข็งให
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เค่ียวใหนาน ๆ ไดท่ีแลวน้ําลงจากเตานําสวนผสมท่ีเค่ียวไว เทลงไปคลุกเคลาใหท่ัวตักใสถาด เย็นแลว
ตัดเปนแผน ๆ เก็บไวโดยไมใสในตูเย็นนานถึง 2 เดือน ถาใสตูเย็นเก็บไดนาน 6 เดือน 
 
บทความชุดท่ี 3 ใหนักเรียนอานเรื่อง ไฟฟาราษฎร ใหเวลา 3  นาที พรอมท้ังตอบคําถามขอ 16-20 
โดยใชเวลา 3 นาที 
  
  ป พ. ศ. 2440 นายแฉลม บุตรของพระยากระสาปนกิจโกศล ไดต้ังบริษัท Bangkok 
Electric Light Syndicat โดยเชาท่ีดินบริเวณวัดเลียบสรางโรงงานติดต้ังเครื่องจักรผลิตไฟฟาเรียกวา 
“โรงไฟฟาวัดเลียบ” จําหนายไฟฟาใหกับประชาชนแตดําเนินกิจการอยูไมนานก็เลิกเพราะรายไดกับ
รายจายไมคุมกัน และไดโอนกิจการใหนายเวนเดน โฮลซ ชาวเดนมารค  ผูซึ่งดําเนินกิจการบริษัท 
ไฟฟาสยาม จํากัด รับไปดําเนินงานตอกิจกรกาวหนาถึงป พ. ศ. 2451 ไดรวมกิจการของบริษัท 
รถรางบางกอก จํากัด มาไวดวย ทําใหกิจการใหญโตมากข้ึน หลัง 24 มิถุนายน พ.ศ. 2482 จอมพล 
ป. พิบูลสงคราม ไดเปล่ียน “ เปน “ประเทศไทย” ในปเดียวกันนี้ บริษัทไฟฟาสยาม จํากัด ได
เปล่ียนเปน “บริษัท ไฟฟาไทยคอรปอเรช่ัน จํากัด” 
 

…………………………………. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



74 

แบบทดสอบสมรรถภาพทางสมองดานการใชคํา 
คําช้ีแจง  1. แบบทดสอบเปนแบบเลือกตอบ 5 ตัวเลือก จํานวน 20 ขอ ใชเวลา 20 นาที 

2. ใหนักเรียนเลือกตอบคําถามท่ีถูกตองท่ีสุดเพียงคําตอบเดียว แลวกาเครื่องหมาย 
x ตรงกับขอ ท่ีเลือกลงในกระดาษคําตอบ 

              3. ใหนักเรียนเขียนช่ือ-นามสกุล เลขประจําตัว ลงในกระดาษคําตอบใหชัดเจน 
                   4. หามขีดเขียนขอความใด ๆ ลงในแบบทดสอบนี้ 
 
คําช้ีแจง  จงเติมคําลงในชองวางแลวทําใหประโยคมีความหมายสมบูรณ 
1. สหรัฐอเมริกาเปนขาว................ในเรื่องท่ีจะถลมประเทศอิรัค 

ก. อึกทึก 
ข. ฉาวโฉ 
ค. อื้อฉาว 
ง. ดุเดือด 
จ. เกรียวกราว 

2. ขาวการเผาสถานทูตไทยในกัมพูชาทําใหประชาชนชาวไทย............... 
ก. เสียขวัญ 
ข. โกรธแคน 
ค. เสียรู 
ง. แคนเคือง 
จ. เศราหมอง 

3. สมศรีเปนผูหญิงท่ีมีคุณสมบัติของกุลสตรีไทยอยาง............. 
ก. เต็มท่ี 
ข. พรั่งพรอม 
ค. เต็มเปยม 
ง. เพียบพรอม 
จ. ครบครัน 

4. ชาวพุทธชอบทํา................... 
ก. ทําทาน 
ข. กุศล 
ค. ใหทาน 
ง. สุนทาน 
จ. บริจาคทาน 

5. บานของฉันมีเกวียน 2 ................ 
ก. เลม 
ข. คัน 
ค. อัน 
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ง. หลัง 
จ. ลํา 

6. คนดียอมมีความเอื้อเฟอ............แกผูอื่น 
ก. แบงปน 
ข. ชวยเหลือ  
ค. เผ่ือแผ 
ง. เกื้อกูล 
จ. เจือจุน  

7. เขาใจคอ.........ราวกับ.............. 
ก. โหดเห้ียม,สัตวปา 
ข. รายกาจ,ยักษ 
ค. โหดราย,มหาโจร 
ง. ดุราย,เสือ 
จ. กราดเกรี้ยว องคุลีมาร 

8. รัฐบาล............ใหประชาชน............ธงชาติตามอาคารบานเรือนในวันสําคัญของชาติ 
ก. เรียกรอง,ประดับ 
ข. ขอรอง, ติด 
ค. ประกาศ, ติด 
ง. เชิญชวน, ประดับ 
จ. ออกคําส่ัง, ปก 

9. คนดี............มีความ............ตอผูมีพระคุณ 
ก. ยอม, กตัญู 
ข. ยอม, เมตตา 
ค. ตอง, กตัญู 
ง. ตอง, เมตตา 
จ. ตอง, รัก 

10 ถึง..............ฉัน..............รักเธอ 
ก. แมวา, จึง 
ข. แมวา, ก็ยัง 
ค. อยางไร, ก็ยัง 
ง. อยางไร, จึง 
จ. ยังไง, จะ 
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คําช้ีแจง ใหจัดเรียงขอความใหไดใจความสมบูรณ   
11 .    1. เพราะเธอยิ้มทีไร 

    2. แมคนยิ้มแปน 
     3. โลกสวางไสว 
     4. ฉันรัก 
ก.  1-2-3-4 
ข.  1-3-4-2 
ค.  4-1-2-3 
ง.  2-3-4-1 
จ.  4-2-1-3 

    12.      1. นายลีกวนยู 
              2. เรียกรองใหประชาชน 
              3. เอาไวเปนเวลา 2 ป 
              4. เพื่อการพัฒนาเศรษฐกิจ 
              5. ตรึงราคาคาจางแรงงาน 
           ก.  5-3-4-1-2 
           ข.  2-4-3-1-5 
           ค.  1-2-5-3-4 
           ง.   2-1-5-3-4  
           จ.   4-3-1-2-5 
   13.      1. การพัฒนาผูเรียนใหมีคุณลักษณะ 
             2. ในการปฎิรูปการศึกษาคือ 
             3. เปาหมายหลักของกรมสามัญศึกษา  
             4. และทักษะท่ีจําเปน 
             5. ในยุคโลกาภิวัฒน 
           ก.  4-3-2-1-5 
           ข.  3-1-4-2-5 
           ค.  3-2-1-4-5 
           ง.  1-4-3-2-5 
           จ.  1-4-2-5-3 
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     14.      1. เคล็ดรับของการกาวหนา 
               2. อยางกลาหาญ 

     3. คือ การยอมรับขอผิดพลาดของตัวเอง 
     4. แลวรีบปรับปรุงแกไขใหทันทวงที 
   ก.  2-3-4-1 
   ข.  2-4-3-1 
   ค.  1-2-4-3 
   ง.  2-1-3-4 
   จ.  1-3-2-4 

15.      1. ผูท่ี 
          2. นักเรียน 
          3. สอบไดท่ี 1 
          4. จะไดเลือกแผนการเรียนกอน 
    ก.  2-3-1-4 
    ข.  1-3-2-4 
    ค.  2-1-3-4 
    ง.  3-1-2-4 
    จ.  1-3-4-1 

16.       1. เกิดมาแลว 
2. ตองตาย 
3. เปนสัจธรรมขอหนึ่ง 
4. มนุษยหรือสัตว 

ก.  4-1-2-3 
ข.  4-2-1-3 
ค.  2-1-4-3 
ง.  3-1-4-2 
จ.  3-2-4-1 

       17.       1. เปน 175 เขต 
                  2. เขตพื้นท่ีการศึกษา 
                  3. ไดแบง 
                  4. ประเทศไทย 

ก.  4-1-2-3 
ข.  4-2-1-3 
ค.  2-1-4-3 
ง.  3-1-4-2 
จ.  3-2-4-1 
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        18.       1.ขวัญใจ 
                   2. เปนนักกีฬา 
                3. ชาวไทย 

  4. ภราดร 
              5. เทนนิส 

ก.  2-4-5-1-3 
ข.  4-2-5-1-3 
ค.  3-1-4-2-5 
ง.  1-4-5-2-3 
จ.  4-5-2-3-1 

19.    1. คือ พ.ต.ท ทักษิณ ชิณวัตร 
          2. คือปจจุบัน 
          3. ของประเทศไทย 
          4. นายกรัฐมนตรี 

ก.  3-4-2-1 
ข.  4-2-3-1 
ค.  4-3-2-1 
ง.  3-2-4-1 
จ.  2-3-4-1 

20.     1.ไมใช 
       2.ความพยายาม 

3. ความสําเร็จ อยูท่ี 
        4. อยูท่ีความหวัง 

ก.  2-1-3-4 
ข.  3-4-1-2 
ค.  3-2-1-4 
ง.  2-3-4-1 
จ.  1-2-3-4 

.................................................. 



 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ข 
แบบวัดลักษณะนิสัยของนักเรียน 
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แบบวัดลักษณะนิสัยของนักเรียน 
คําช้ีแจง ใหนักเรียนเลือกคําตอบท่ีตรงกับลักษณะนิสัยของตนเองมากท่ีสุดเพียงคําตอบเดียวแลวกา
เครื่องหมาย x ตรงกับขอท่ีเลือกลงในกระดาษคําตอบ 

1. ปรีชาเปนนักเรียนช้ัน ม.4 มีภาระในการชวยผูปกครองเตรียมของไปขายท่ีตลาดในตอนเชา

ของทุกวันและตองมาเขาแถวในเวลา 8.00 น. นักเรียนคิดวาปรีชาจะปฎิบัติอยางไร 

ก. รีบทํางานใหเสร็จเร็วข้ึนเพื่อจะไดมาเขาแถวไดทันเวลา   

ข. บอกอาจารยผูควบคุมเขาแถววาขออนุญาตเขาแถวชา เพราะตองชวยผูปกครอง

ทํางาน 

ค. วันไหนทํางานเสร็จเร็วก็มาเขาแถว วันไหนทํางานไมเสร็จก็ไมมาเขาแถว 

2.  โรงเรียนไดออกระเบียบใหนักเรียนหญิงทุกคนตัดผมส้ันเพื่อความเรียบรอย สมศรีเปนคนผม
หยิก  และ  ฟู  ปกติไวผมยาวแลวรวบจะดูสวยกวา นักเรียนคิดวาสมศรีจะปฏิบัติอยางไร 

ก. ยอมตัดผมเพื่อความเรียบรอย 
ข. ยอมตัดผมเพราะกลัวถูกลงโทษ 
ค. ไปขออนุญาตอาจารยเปนกรณีพิเศษขอไวผมยาว 

 3. ในการเรียนวิชาคอมพิวเตอร ครูใหนักเรียนมาทําการติดต้ังระบบเครือขายคอมพิวเตอรใน
หองเรียนในวันเสารโดยไมบังคับ ทองพูนเปนสมาชิกในหองปกติจะนอนต่ืนสายในวันเสาร
นักเรียนคิดวาทองพูนจะทําอยางไร 

ก. ต่ืนใหเชากวาปกติเพื่อจะไดไปรวมกิจกรรมใหทันเวลา 
ข. ต่ืนไปตามปกติแลวไปรวมกิจกรรม เพราะไปสายก็ไดอาจารยไมบังคับ 
ค. ไมไปรวมกิจกรรมเพราะอาจารยไมไดบังคับไมมีผลตอคะแนน 

4. นิด หนอย และนอย กําลังทําการบานและรับประทานลูกช้ินอยูท่ีมาหินออน เหลือเวลาอีก 
2 นาที จะถึงเวลาเรียนคาบแรก แตมีขยะอยูบนโตะและถังขยะอยูไกลมาก นักเรียนคิดวา
นิด หนอย และนอย จะทําอยางไร 

ก. รีบเอาขยะไปท้ิงแลวรีบเขาหองเรียน 
ข. แอบวางขยะไวใตโตะแลวรีบไปเขาหองเรียน 
ค. วางขยะไวอยางนั้นแหละเพราะรีบเรียนเสร็จแลวคอยมาเก็บ 

5. วันหนึ่งศรรามข้ึนรถเมลไปโรงเรียนและหยิบลูกอมออกมารับประทานระหวางเดินทาง ถา
เรียนเปนศรราม จะทําอยางไรกับเศษกระดาษหอขนมลูกอม 

ก. เก็บเศษกระดาหอไวในกระเปาเส้ือตนเอง 
ข. ท้ิงเศษกระดาษหอไวในกระเปารถเมล 
ค. โยนเศษกระดาษหอออกนอกหนาตางรถเมล 
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6. ในชวงเปล่ียนคาบเรียนต๊ิกเดินผานหองน้ําชายแลวน้ําเปดท้ิงเอาไวจึงเขาไปปดปรากฎวาปด
ไมไดเพราะกอกน้ําเสีย นักเรียนคิดวาต๊ิกจะทําอยางไร 

ก. ยอมเขาหองเรียนชาเพื่อไปบอกผูท่ีรับผิดชอบมาแกไข 
ข. มองหาคนรบัผิดชอบถาไมเจอก็ไปเรียนเลย 
ค. รีบไปเรียนเลยเพราะทําดีท่ีสุดแลว  

7. ในวิชาโครงงานคอมพิวเตอร นักเรียนทุกคนจะตองทําโครงงานการพัฒนาระบบสารสนเทศ 
โดยมีอาจารยท่ีปรึกษาของแตละโครงงาน สมหมายไดอาจารยสมคิดเปนอาจารยท่ีปรึกษา
แตอาจารยสมคิดไมคอยมีเวลาวางใหคําปรึกษาเทาไร ลาสุดสมหมายสงโครงงานใหอาจารย
ดูผานไป 1 เดือน อาจารยยังไมไดดูให ถานักเรียนเปนสมหมายจะทําอยางไร 

ก. พยายามเขาพบอาจารยแลวขอรองใหอาจารยชวยดูให 
ข. ไปตอวาอาจารยวาขาดความรับผิดชอบ 
ค. ขอเปล่ียนอาจารยท่ีปรึกษาโครงงาน 

8. ในกิจกรรมกีฬาสีประจําป ขนิษฐาเปนนักกีฬาวิ่ง 400 เมตร ในขณะท่ีกําลังแขงขัน กอนถึง
เสนชัย 20 เมตร มีฝุนปลิวเขาตาของขนิษฐาทําใหมองอะไรไมชัด นักเรียนคิดวาขนิษฐาจะ
ทําอยางไร 

ก. วิ่งตอไปจนถึงเสนชัย 
ข. หยุดวิ่งจนมองอะไรไดชัดเจนคอยวิ่งตอไป 
ค. หยุดและออกจากการแขงขัน 

9. ในโรงเรียนแหงหนึ่งมีโทรศัพทสาธารณะอยู 1 เครื่อง วันหนึ่งเบญจวรรณมีธุระดวนท่ีจะตอง
ใชโทรศัพทจึงไปใชบริการแตขณะนั้น พนิดากําลังใชโทรศัพทพูดคุยอยางมีความสุขไมมีที
ทาวาจะวางสายเลย ถานักเรียนเปนเบญจวรรณจะทําอยางไร 

ก. รออีก 3 นาทีถายังไมวางสายคอยบอกพนิดาวาธุระดวนใหพนิดาวางสายแลวขอ
ใชโทรศัพทกอน 

ข. บอกพนิดาวาธุระดวนมากขอใชโทรศัพทกอน 
ค. ตอวาพนิดาวาไมมีมารยาทในการใชโทรศัพทสาธารณะ 

10.ในขณะท่ีโศจิรัตน กําลังเดินกลับบานหลังเลิกเรียน เธอเห็นผูหญิงคนหนึ่งถูกคนรายเอามีดจ้ี
เพื่อปลดสรอยคอ ถานักเรียนเปนโศจิรัตน จะทําอยางไร 

ก. ทําตัวไมใหคนรายเห็นแลววิ่งไปบอกใหคนมาชวย 
ข. รีบวิ่งหนีใหพนจากบริเวณนั้น 
ค. สงเสียงรองดวยความตกใจ 
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11.ประยุทธกําลังทํารายงานวิชาวิทยาศาสตรเพื่อท่ีจะสงในวันพรุงนี้ แตประยุทธรูสึกงวงมาก 
เพราะอดนอนมาหลายคืนแลว ถานักเรียนเปนประยทุธจะทําอยางไร 

ก. เดินใหหายงวงและกลับมาทํารายงานตอ 
ข. นอนกอนแลวคอยต่ืนมาทําตอ 
ค. นอนกอนพรุงนี้คอยไปลอกเพื่อนสง 

12.ธิดาเปนกลัวจ้ิงจกมาก มีอยูวันหนึ่งจ้ิงจกเขาไปอยูในกระเปาเส้ือของเขา นักเรียนคิดวาเขา
จะทําอยางไร 

ก. ต้ังสติแลวคอย ๆ ไลจ้ิงจกออกไป 
ข. ตามคนมาชวยไลจ้ิงจกออกไป 
ค. วิ่งหนี และไมใชเส้ือตัวนั้นแลว 

13.ในวิชาคอมพิวเตอร อาจารยผูสอนไดกลาวถึงนาย Bill Gates วาเปนบุคคลสําคัญในวงการ
คอมพิวเตอรท่ีมีประวัติท่ีนาสนใจ ถามีเวลาจะเลาใหฟง ถานักเรียนเปนสมาชิกในหอง
ดังกลาวจะทําอยางไร 

ก.ไปหาขอมูลของนาย Bill Gates วาจะนาสนใจเหมือนท่ีอาจารยพูดไหม 
ข. รอใหอาจารยเลาใหฟง  
ค. ไมสนใจเพราะอาจารยไมไดเอามาออกขอสอบ 

14.วิชาหลักการเขียนโปรแกรมคอมพิวเตอร อาจารยผูสอนแจววาขอมูลท่ีจะใชในการเรียนจะ
มาจากอินเทอรเนต โดยใหช่ือเว็บไซดไปแลว ถานักเรียนเรียนวิชาดังกลาวจะทําอยางไร 

ก. รีบเขาไปในเว็บไซดดาวโหลดเอาขอมูลมาแลวส่ังพิมพเก็บไว 
ข. เขาไปดูในเว็บไซดวามีอะไรบาง แลวคอยส่ังพิมพตอนท่ีจะใช 
ค. รอถายเอกสารจากเพื่อน 

15.แกว ไดรับมอบหมายใหไปสัมภาษณเกษตรกรท่ีทํานากุง เพื่อมาเลาใหเพื่อนฟงในวันจันทร 
นักเรียนคิดวา แกว จะทําอยางไร 

ก. หลังเลิกเรียนแลวรีบไปสัมภาษณ 
ข. สัมภาษณในวันอาทิตยตอนเย็น ๆ 
ค. สัมภาษณเชาวันจันทรกอนไปโรงเรียน 

16.หลังรับประทานอาหารเย็นวันหนึ่ง กอยไดรับมอบหมายใหไปลางจานแตวันนั้นกอยรูสึกอิ่ม
มาก นักเรียนคิดวากอยจะทําอยางไร 

ก. รับประทานอาหารเสร็จแลวลางเลย 
ข. นั่งพักใหรูสึกสบายกอนคอยลาง 
ค. เก็บเอาไวลางในวันรุงข้ึน 
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17.ในคาบเรียนวิชาวิทยาศาสตรหลังจากท่ีครูอธิบายเรื่องการเคล่ือนท่ีของโมเลกุลจบลงไดเปด
โอกาสใหทุกคนซักถาม ธงชัยยังไมทราบเลยวาโมเลกุลคืออะไรนักเรียนคิดวาธงชัยจะทํา
อยางไร 

ก. ยกมือถามวาโมเลกุลคืออะไร 
ข. ไมถามแตจะกลับไปอานดูวาโมเลกุลคืออะไร 
ค. ไมถามและต้ังใจวาเรื่องตอไปท่ีอาจารยสอนจะตองต้ังใจมากกวานี้และจะตอง

เขาใจ 

18.ในสัปดาหวิทยาศาสตร โรงเรียนไดเชิญวิทยากรมาบรรยายเรื่อง ยาบา ภราดรเขารวมฟง
การบรรยายต้ังแตตน และสงสัยวา ยาบาทํามาจากอะไร แตผูเปนวิทยากรไมไดกลวถึงเลย 
ถานักเรยีนเปนภราดรจะทําอยางไร 

ก. ยกมือถาม 
ข. ไมถามคอยกลับไปหาหนังสืออาน 
ค. ไมถามไมทราบก็ไมเปนไร เพราะเราไมไดเสพ 

19.นภาวรรณ มีหนาท่ีจะตองบันทึกปญหาในการเรียนของเพื่อน ๆ ในหอง เพื่อนําเสนอตอ
อาจารยท่ีปรึกษาทุกวันศุกร นักเรียนคิดวานภาวรรณจะมีวิธีการทําอยางไร 

ก. บันทึกทุกครั้งท่ีมีปญหาในหอง 
ข. บันทึกสัปดาหละครั้ง 
ค. บันทึกเฉพาะเรื่องท่ีเห็นวาสําคัญ 

20.ในการทดลองวิทยาศาสตร วัฒนชัยไดรับมอบหมายใหสังเกตการเปล่ียนแปลงทุกวันแตเขา
ไมคอยมีเวลาเพราะตองชวยผูปกครองทํางาน นักเรียนคิดวาวัฒนชัยจะมีวิธีปฎิบัติงาน
อยางไร 

ก. สังเกตและบันทึกทุกวัน 
ข. สังเกตทุกวันแลวคอยบันทึกวันท่ีจะสง 
ค. สังเกตและบันทึกวันเวนวัน 

21.ในสัปดาหนี้ ออดจะตองสงรายงาน 3 วิชาถานักเรียนเปนออดจะมีวิธีการปฎิบัติงานอยางไร 
ก. ทํารายงานใหเสร็จวันละ 1 วิชา 
ข. ทําทีละวิชาเสร็จวิชาไหนก็สง ท่ีเหลือคอยหาทาง แกปญหา 
ค. ทําไปเรื่อย ๆ เสร็จก็สงไมเสร็จก็คอยลอกเพื่อน 
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22.อีก 1 เดือนเตยจะสอบปลายภาค ถานักเรียนเปนเตยจะมีวิธีการเตรียมสอบอยางไร 
ก. ทําตารางการอานหนังสือและปฎิบัติตาม 
ข. อานหนังสือไปเรื่อย ๆ ทุกวิชา 
ค. ปฎิบัติตัวตามปกติ 

23.สุดใจไดรับมอบหมายใหเก็บเงินของหองเพื่อเปนคาใชจายของกิจกรรมตาง ๆ ภายในหอง
ถานักเรียนเปนสุดใจ จะมีวิธีการปฎิบัติงานอยางไร 

ก. บันทึกรายการรับและรายการจายแยกเปนแตละกิจกรรม 
ข. ทําบันทึกรวม ๆ กันไปทุกกิจกรรม 
ค. บันทึกเฉพาะยอดเงินท่ีรับและยอดเงินคงเหลือ 

24.บุญนาคไดรับมอบหมายใหรวบรวมขอมูลและรูปถายสงงานทะเบียนเพื่ออกบัตรประจําตัว
นักเรียน นักเรียนคิดวาบุญนาคจะมีวิธีการปฎิบัติงานอยางไร 

ก. รวบรวมแลวเรียงตามเลขประจําตัวพรอมเขียนสรุปวาหองไหนจํานวนท้ังหมดกี่
คน 

ข. รวบรวมและเขียนสรุปวาเปนนักเรียนหองไหนจํานวนกี่คน 
ค. รวบรวมเสร็จแลวรีบนําสงทันที 

25.ในวิชาวิทยาศาสตร อาจารยมีชัย ไดมอบหมายใหแบงกลุมทําการทดลองแลวใหตัวแทน
กลุมออกมารายการผลการทดลองหนาหองเรียน ศิริพรไดรับมอบหมายใหเปนตัวแทนกลุม
ออกรายงาน แตวันนี้ศิริพรไมไดเตรียมตัวมาเลย ถานักเรียนเปนศิริพรจะทําอยางไร 

ก. เขาหองเรียนและออกไปรายงานตามท่ีไดรับมอบหมาย 
ข. เขาหองเรียนแตบอกใหเพื่อนในกลุมออกไปรายงานแทน 
ค. ขาดเรียนในคาบนั้นแลวมาอธิบายใหเพื่อนฟงทีหลัง 

26.วันนี้อาจารยนัดสงงาน แตวัฒนชัยทํางานยังไมเสร็จ จึงไมมีงานท่ีจะสงเพราะสัปดาหท่ีแลว
ไมสบายตองนอนโรงพยาบาล นักเรียนคิดวาวัฒนชัยจะทําอยางไร 

ก. ไปเรียนและขออนุญาตอาจารยสงงานชา พรอมกับบอกเหตุผล 
ข. ไปเรียนและขออนุญาตไมสงงานเพราะไมทราบวาตองสงงาน 
ค. ไมไปเรียนเพราะไมมีงานท่ีจะสงอายเพื่อน ๆ 

27.ในคาบเรียนวิชาพลศึกษา สุชิลา โยนลูกบอลไปโดนกระจกรถอาจารยสมบัติท่ีจอดอยูขาง
สนามแตก สุชิลามองซายมองขวาไมมีใครเห็น นักเรียนคิดวาสุชิลาจะทําอยางไร 

ก. บอกอาจารยผูสอนวาตัวเองทําลูกบอลโดนกระจกรถแตก 
ข. บอกอาจารยผูสอนวาไมทราบวาใครทํากระจกรถแตก 
ค. ทําไมรูไมเห็นอะไร 
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28.ในคาบเรียนวิชาภาษาไทย อาจารยมอบหมายใหแบงกลุมกันทํารายงาน หลังจากทํางาน
เสร็จ ในกลุมไดมอบหมายใหจตุพรเก็บไวเพื่อท่ีจะนํามาสงในคาบตอไป แตปรากฎวาจตุพร
ลืมไวในหองทําใหรายงานหาย นักเรียนคิดวาจตุพรจะทําอยางไร 

ก. รีบไปทํารายงานเองท้ังหมดเพื่อใหทันสงในคาบตอไป 
ข. บอกเพื่อน ๆ วาตัวเองทํารายงานหายใหมาชวยกันทําใหม 
ค. บอกเพื่อน ๆ วารายงานถูกขโมยใหไปขออนุญาตสงรายงานชากวากลุมอื่น ๆ 

29.ในคาบเรียนวิชาหลักการเขียนโปรแกรมคอมพิวเตอร ขณะท่ีอดุลยกําลังใชเครื่อง
คอมพิวเตอรทํางานตามท่ีไดรับมอบหมายปรากฎวามีเสียงดังผิดปกติข้ึนมาในเครื่อง
นักเรียน คิดวาอดุลยจะทําอยางไร 

ก. รีบปดเครื่องและบอกผูควบคุมหองใหรีบแกไข 
ข. ปดเครื่องแลวบอกเพื่อน ๆ วาอยาใชอันตราย 
ค. ปดเครื่องแลวเปล่ียนไปใชเครื่องตัวอื่น 

30.ในคาบเรียนวิชาวิทยาศาสตร คําดีกําลังสาธิตการผสมสารเคมี เขาทราบวาสารเคมีท่ีใช
อันตรายมากและเขาก็ไดเรียนรูวิธีการปองกันแลว แตเพื่อน ๆ ไมมีใครทราบวาอันตราย
มากก็เลยเขามามุงดูกันใกล ๆ เต็มไปหมด ถานักเรียนเปนคําดีจะทําอยางไร 

ก. บอกเพื่อน ๆ วามันอันตรายมากใหออกไปดูหาง ๆ 
ข. บอกเพื่อน ๆวามันอันตรายมากถาไมกลัวก็ดูใกล ๆ ได 
ค. ทํางานตอไปเพราะถาบอกวาอันตรายจะทําใหเพื่อนตกใจ                

……………………………………….. 
 



 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ค 
แบบวัดการรับรูความสามารถของตนเองในการเรียนวิชาคอมพิวเตอรกราฟกส 
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แบบวัดการรับรูความสามารถของตนเองในการเรียนวิชาคอมพิวเตอร

กราฟกส 
คําช้ีแจง  

1. แบบวัดฉบับนี้มีจํานวน 25 ขอ ใหนักศึกษาอานและพิจารณาขอความ แลวทํา

เครื่องหมาย  ลงในชองทางขวามือชองใดชองหนึ่งท่ีตรงกับการประเมินตนเองของ

นักศึกษา โดยมีความหมายดังนี้ 

จริงมาก  หมายถึง การรับรูความสามารถของตนเองอยูในระดับมาก 

จริงเปนสวนใหญ หมายถึง การรับรูความสามารถของตนเองอยูในระดับคอนขางมาก 

จริงนอย  หมายถึง การรับรูความสามารถของตนเองอยูในระดับคอนขางนอย 

ไมจริง  หมายถึง ไมสามารถรับรูของตนเอง 

2. แบบวัดฉบับนี้จัดทําข้ึนเพื่อใชในการเก็บรวบรวมขอมูลเพื่อการทําวิจัย ซึ่งไมมีขอใดหรือ

ผิด ดังนั้นคําตอบท่ีไดจะไมมีผลกระทบตอผลการเรียนของนักศึกษา จึงขอใหนักศึกษา

ตอบตามความเปนจริงและตอบใหครบทุกขอ 

ขอ ขอความ จริงมาก 
จริงเปน
สวนใหญ 

จริง
นอย 

ไมจริง 

1. ขาพเจาเรียนวิชาคอมพิวเตอรกราฟกสได
คะแนนดี 

    

2. ขาพเจาเกงวิชาคอมพิวเตอรกราฟกส     
3. ขาพเจาเรียนวิชาคอมพิวเตอรกราฟกสได

ดีกวาวิชาอื่น 
    

4. ขาพเจาตอบคําถามเกี่ยวกับคอมพิวเตอร
กราฟกสท่ีอาจารยถามในช้ันเรียนได 

    

5. วิชาคอมพิวเตอรกราฟกสเปนวิชาท่ีงาย
สําหรับขาพเจา 

    

6. ขาพเจาวิเคราะหปญหาท่ีจะนําขอมูลมาใชใน
การประยุกตใชคอมพิวเตอรกราฟกสไดอยาง
ถูกตอง 

    

7. ขาพเจาวิเคราะหปญหาเกี่ยวกับการเขียน
ภาษาในคอมพิวเตอรกราฟกสท่ีซับซอนได
อยางถูกตอง 

    

8. ขาพเจาจําหลักการในการเขียนภาษาใน
คอมพิวเตอรกราฟกสไดอยางถูกตอง 
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ขอ ขอความ จริงมาก 
จริงเปน
สวนใหญ 

จริง
นอย 

ไมจริง 

9. ขาพเจาเขียนอัลกอริทึมจากการวิเคราะห
ปญหาเพื่อใชในการเขียนภาษาคอมพิวเตอร
กราฟกสไดถูกตอง 

    

10. ขาพเจาเขียนผังงานจากอัลกอริทึมไดถูกตอง     
11. ขาพเจาเลือกใชคําส่ังในภาษาคอมพิวเตอร

สําหรับเขียนคอมพิวเตอรกราฟกสไดอยาง
เหมาะสม 

    

12. ขาพเจาสามารถสรุปประเด็นสําคัญจากการ
วิเคราะหปญหาได 

    

13. ขาพเจาสามารถอธิบายข้ันตอนการทํางาน
ตาง ๆ ของโปรแกรมท่ีสรางข้ึนไดชัดเจน 

    

14. ขาพเจาสามารถจําคําส่ังตาง ๆ ท่ีใชใน
คอมพิวเตอรกราฟกสได 

    

15. ขาพเจาสามารถจดจําสาระสําคัญท่ีอาจารย
สอนในช้ันเรียนวิชาคอมพิวเตอรกราฟกสได
อยางครบถวน 

    

16. ขาพเจาสามารถเช่ือมโยงสาระสําคัญท่ีไดจาก
การเรียนและการปฏิบัติจริงในวิชา
คอมพิวเตอรกราฟกสไดเปนอยางดี 

    

17. ขาพเจาสามารถเรียนวิชาคอมพิวเตอร
กราฟกสไดอยางถูกตองและไมมีขอผิดพลาด 

    

18. แบบฝกหัดของวิชาคอมพิวเตอรกราฟกสท่ี
อาจารยใหทําเปนส่ิงท่ีงายสําหรับขาพเจา 
 

    

19. ขาพเจาสามารถเขียนคําอธิบายข้ันตอนการใช
งานของกราฟกสท่ีสรางข้ึนไดเปนอยางดีและ
อานเขาใจไดงาย 

    

20. ขาพเจาสามารถแนะนําการใชงาน
คอมพิวเตอรกราฟกสใหกับเพื่อนในหองเรียน
ไดเสมอ 

    

21. ขาพเจาสามารถนําความรูจากวิชา
คอมพิวเตอรกราฟกสไปประยุกตใชในวิชา
อื่นๆ ได 
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ขอ ขอความ จริงมาก 
จริงเปน
สวนใหญ 

จริง
นอย 

ไมจริง 

22. ขาพเจาสามารถอธิบายเกี่ยวกับวิชา
คอมพิวเตอรกราฟกสใหกับเพื่อน ๆ ได 

    

23. ขาพเจาสนุกกับการเรียนวิชาคอมพิวเตอร
กราฟกส 

    

24. ขาพเจามีความสุขเมื่อเขียนกราฟกสเสร็จ
เรียบรอย 

    

25. กราฟกสท่ีขาพเจาสรางข้ึนมา สามารถใชงาน
ไดอยางไมมีขอผิดพลาด 

    

 
 

 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ง 
แบบทดสอบวัดความสามารถในการเรียนวิชาคอมพิวเตอรกราฟกส 
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แบบทดสอบวัดความสามารถในการเรยีนวิชาคอมพิวเตอรกราฟกส 
คําช้ีแจง 

1. แบบทดสอบเปนแบบปรนัย 4 ตัวเลือก จํานวน 70 ขอ ใชเวลาทํา 1 ช่ัวโมง  
2. ใหนักเรียนเลือกคําตอบท่ีถูกตองท่ีสุดเพียงคําตอบเดียว แลวกาเครื่องหมาย X ตรงกับขอท่ี

เลือกลงในกระดาษคําตอบ  
 

1.  ขอใดเขียนถูกตอง 
ก. กราฟก 
ข. กราฟฟก 
ค. กราฟกส  
ง. กราฟฟกส 
2.  Graphic มาจากภาษาใด 
ก. ภาษาอังกฤษ                     
ข. ภาษาโรมัน 
ค. ภาษาฝรั่งเศส 
ง. ภาษากรีก 
3.  ภาพกราฟกท่ีใชกับคอมพิวเตอรแบงออกเปน
กี่ประเภท 
ก. 2 ประเภท  
ข. 3 ประเภท 
ค. 4 ประเภท  
ง. 5 ประเภท 
4.  ขอใดกลาวถูกตองเกี่ยวกับหลักการทํางาน
ของกราฟกแบบ  Raster 
ก. ใชสรางภาพ แกไขและตกแตงภาพ เหมาะกับ
การสรางโลโก และออกแบบ 
ข. ภาพเกิดจากจุดสีส่ีเหล่ียมเล็กๆ หลาย ๆ  จุด
มาเรียงตอกันจนเกิดเปนรูปภาพ 
ค. ภาพเกิดจากการอางอิงความสัมพันธทาง
คณิตศาสตร หรือการคํานวณ 
ง. ภาพเกิดจากการยิงแสงของประจุไฟฟาไปยัง
แมสี  RGB และเกิดเปนภาพสีตาง ๆ 
 
 
 
 

5.  ขอใดกลาวถูกตองเกี่ยวกับหลักการทํางาน
ของกราฟกแบบ  Vector 
ก.ใชสรางภาพ แกไขและตกแตงภาพ เหมาะกับ
การสรางโลโก และออกแบบ 
ข. ภาพเกิดจากจุดสีส่ีเหล่ียมเล็ก ๆ หลาย ๆ จุด
มาเรียงตอกันจนเกิดเปนรูปภาพ 
ค. ภาพเกิดจากการอางอิงความสัมพันธทาง
คณิตศาสตร หรือการคํานวณ 
ง. ภาพเกิดจากยิงแสงของประจุไฟฟาไปยังแม
สี  RGB และเกิดเปนภาพสีตาง ๆ 
6.  ระบบสีท่ีใชกับกราฟกท่ัวไปมีกี่ระบบ 
ก. 2 ระบบ 
ข. 3 ระบบ 
ค. 4 ระบบ  
ง. 5 ระบบ 
7.  สีในโมเดล  RGB  สามารถสรางสีไดกี่สี 
ก. 14 ลานสี   
ข. 16.5  ลานสี 
ค. 16.7 ลานสี      
ง. 17.6 ลานสี 
8.   โมเดลสีระบบใดท่ีเหมาะกับงานพิมพ 
ก. RGB 
ข.  CMYK 
ค.  HSB  
ง.  LAB 
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9.  การกําหนดความละเอียดของภาพท่ีใชท่ัวไป
ควรกําหนดกี่พิกเซล 
ก. 72-75  พิกเซล   
ข.  100-150  พิกเซล 
ค. 150-300  พิกเซล   
ง.  300-350  พิกเซล 
10.  แฟมภาพนามสกุลใดท่ีเหมาะกับงานดานเว็บ
เพจ 
ก. .Tiff    
ข. .Gif 
ค. .Jpg   
ง.  ถูกท้ัง  ข  และ  ค 
11.  ขอใดคือคุณสมบัติของ
โปรแกรม  Adobe  PhotoShop 7.0 
ก.การสรางและแกไขปรับแตงภาพ                 
ข. การสรางงานมัลติมีเดีย 
ค. การสรางงานแอนิแมชัน     
ง. การสรางเว็บเพจ 
12.  สวนประกอบใดของโปรแกรม  Adobe 
PhotoShop 7.0 ท่ีปรับเปล่ียนไปตามเครื่องมือท่ี
ใช 
ก. ออปชันบาร       
ข. พาเล็ต 
ค. พาเนล  
ง. ไตเติลบาร 
13.  เครื่องพิมพแบบใดท่ีใชพิมพสําเนาได 
ก. แบบ  Ink-jet     
ข. แบบ  dot  matrix 
ค. แบบ  Laser                                     
ง.  ใชไดทุกแบบ 
14.  เครื่องพิมพแบบใดท่ีใชหลักการยิงแสง 
ก. แบบ  Ink-jet         
ข. แบบ  dot  matrix 
ค. แบบ  Laser                                     
ง.  แบบ Photo 
 

15.  เครื่องพิมพแบบใดท่ีใชหลักการพนหมึก 
ก. แบบ  Ink-jet    
ข. แบบ  dot  matrix 
ค. แบบ  Laser 
ง.  ถูกทุกขอ 
16.  เครื่องพล็อตเตอรเหมาะกับงานดานใด 
ก. ดานเว็บเพจ            
ข. ดานวิศวกรรมการออกแบบ 
ค. ดานภาพศิลป         
ง. ดานส่ิงพิมพ 
17.  ไฟลนามสกุลใดท่ีใชเก็บรหัสผลิตภัณฑ 
ก. .EXE  
ข. .DAT 
ค. .TXT  
ง. .DOC 
18.  ไฟลใดท่ีใชติดต้ังโปรแกรม  Adobe 
PhotoShop 7.0 
ก. Setup.inf  
ข. Setup.exe 
ค. Setup.txt  
ง. Install.inx 
19.  การติดต้ังฟอนตไทยจะตองคัดลอกไฟลไปไว
ท่ีโฟลเดอรใด 
ก. Common Files  
ข. Adobe 
ค. Program File      
ง. Font 
20.  ทูลบ็อกซแบงกลุมเครื่องมือออกเปนกี่กลุม 
ก.  15 กลุม  
ข.  16 กลุม 
ค. 17  กลุม  
ง.  189  กลุม 
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21.  การกําหนดมุมมองแบบทูลบ็อกซมีกี่แบบ 
ก. 2 แบบ  
ข. 3 แบบ 
ค.  4  แบบ 
ง.  5 แบบ 
22.  การกําหนดมุมมอง
แบบ Full Screen Mode With Menubar   
หมายถึง 
ก. การแสดงหนาจอแบบมาตรฐานปกติ 
ข. การแสดงแบบเต็มหนาจอโดยมีแถบไตเติลบาร
ของโปรแกรมและรูปภาพ 
ค. การแสดงแบบเต็มหนาจอโดยไมมีแถบไตเติล
บารของโปรแกรมและรูปภาพ 
ง. การแสดงแบบเต็มหนาจอโดยไมมีไตเติลบาร
และเมนูบาร พื้นท่ีบริเวณรอบนอกเปนสีดํา 
23.  การกําหนดมุมมอง
แบบ  Full  Screen  Mode หมายถึง 
ก. การแสดงหนาจอแบบมาตรฐานปกติ 
ข. การแสดงแบบเต็มหนาจอโดยมีแถบไตเติลบาร
ของโปรแกรมและรูปภาพ 
ค. การแสดงแบบเต็มหนาจอโดยไมมีแถบไตเติล
บารของโปรแกรมและรูปภาพ 
ง. การแสดงแบบเต็มหนาจอโดยไมมีไตเติลบาร
และเมนูบาร พื้นท่ีบริเวณรอบนอกเปนสีดํา 
24.  การจัดเรียงไฟลรูปภาพมีกี่แบบ 
ก. 2 แบบ     
ข. 3 แบบ 
ค. 4 แบบ  
ง. 5 แบบ 
25.  คําส่ังใดใชเปดไฟลรูปภาพแบบรวดเร็วโดย
แสดงช่ือไฟลรูปภาพท่ีเคยเปดกอหนา 10 ไฟล 
ก. Open  Recent  
 ข. Open 
ค. File Browse  
ง. Open  Fast 

26.  คําส่ังใดใชเปดไฟลรูปภาพโดยแสดงรูปภาพ
ท้ังหมดในโฟลเดอรท่ีเลือก 
ก. Open  Recent 
ข. Open 
ค. File Browse  
ง. Open  Fast 
27.  มุมมองในหนาตาง Save for Web  มีกี่
มุมมอง 
ก. 3 มุมมอง   
ข. 4 มุมมอง 
ค. 5 มุมมอง 
ง. 6 มุมมอง 
28.  คําส่ังใดท่ีใชสรางอัลบ้ัมภาพบนเว็บเพจ 
ก. File -> Automatic -> Web Photo Gallery 
ข. File -> Automation -> Web Photo 
Gallery 
ค. File -> Auto -> Web Photo Gallery 
ง. File -> Automate -> Web Photo Gallery 
29.  คําส่ังใดท่ีใชพิมพรูปภาพออกทางเครื่องพิมพ
แบบสติกเกอร 
ก. File -> Automatic -> Print With Sticker 
ข. File ->  Automatic -> Photo Sticker 
ค. File -> Auto -> Photo Package 
ง. File -> Automate -> Picture Package 
30.  ขอใดใชเลือกรูปแบบของการพิมพแบบสติก
เกอร 
ก. Layout       
ข. Format 
ค. Document  
ง. Style Picture 
31.  พาเล็ต  Layer  มีหนาท่ีอยางไร 
ก. ชวยในการแกไขรูปภาพ   
ข. ใชจัดเรียงรูปภาพ 
ค. ลําดับข้ันตอนการทํางาน  
ง. เปนเครื่องมือชวยในการตกแตงรูปภาพ 
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32.  การ Selection  ภาพหมายถึง 
ก. การเลือกพื้นท่ีท่ีตองการจากรูปภาพ 
ข. การระบุตําแหนงของรูปภาพ 
ค. การปรับรูปทรงของรูปภาพ 
ง. การจัดการเพื่อคัดลอกรูปภาพ 
33.  Rectangular  Marquee Tool  เปน
เครื่องมือ  Selection  ภาพแบบใด 
ก. แบบส่ีเหล่ียม      
ข. แบบวงกลม 
ค. แบบอิสระ     
ง. แบบตามสี 
34.  Elliptical  Marquee Tool  เปน
เครื่องมือ  Selection  ภาพแบบใด 
ก. แบบส่ีเหล่ียม     
ข. แบบวงกลม 
ค. แบบอิสระ            
ง. แบบตามสี 
35.  Lasso  Tool  เปน
เครื่องมือ  Selection  ภาพแบบใด 
ก. แบบส่ีเหล่ียม    
ข. แบบวงกลม 
ค. แบบอิสระ       
ง. แบบตามสี 
36.  คําส่ังใดท่ีใชแยกภาพออกจากพื้นหลัง 
ก. Extract                     
ข. Cut 
ค. Erase                                      
ง. Clear 
37.  เครื่องมือใดท่ีใชปรับเสนขอบของภาพให
คมชัด 
ก.  Edge  Touchup  
ข.  Eraser 
ค. Cleanup                       
ง.  Edge  Highlighter 
 
 

38.  การคัดลอกรูปภาพใชคําส่ังใด 
ก. File -> copy   
ข. Edit -> Copy 
ค. กดปุม  Alt + Move Tool       
ง. ถูกท้ังขอ  ก และ ค 
39.  คําส่ังใดท่ีใชยอขยายรูปภาพ 
ก. Edit ->  Free Transform               
ข. Edit -> Transform 
ค. กดปุม  Ctrl + T           
ง. ถูกท้ัง  ก และ ค 
40.  คําส่ังใดทําใหภาพกลับจากบนลงลางหรือ
จากลางข้ึนบน 
ก. Rotate                                  
ข. Flip  Horizontal 
ค. Flip  Vertical 
ง. Perspective 
41.  Horizontal  Type  Tool  คือ 
ก.การสรางตัวอักษรปกติ                       
ข. การสรางตัวอักษรในแนวนอนปกติ 
ค. การสรางตัวอักษรแนวปกติ              
ง. การสรางตัวอักษรแบบ  Seletion 
42.  Vertical Type Tool คือ 
ก. การสรางตัวอักษรปกติ                         
ข. การสรางตัวอักษรในแนวนอนปกติ 
ค. การสรางตัวอักษรแนวต้ังปกติ  
ง. การสรางตัวอักษรแบบ Selection 
43.  Horizontal Type  Mask  Tool 
ก. การสรางตัวอักษรปกติ   
ข. การสรางตัวอักษรในแนวนอนปกติ 
ค. การสรางตัวอักษรแนวต้ังปกติ    
ง. การสรางตัวอักษรแบบ  Selection 
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44.  การใสสไตลแบบสรางเงาใหตกลงพื้น คือขอ
ใด 
ก. Drop Shadow                            
ข.  Inner  Shadow 
ค. Outer  Glow                  
ง. Inner Glow 
45.  การใสสไตลแบบสรางเงาบริเวณพื้นท่ีภายใน
ของวัตถุคือ ขอใด 
ก. Drop Shadow            
ข.  Inner  Shadow 
ค. Outer  Glow             
ง. Inner Glow 
46.  การใสสไตลแบบสรางขอบวัตถุใหฟุงกระจาย
คือ ขอใด 
ก. Drop Shadow 
ข.  Inner  Shadow 
ค. Outer  Glow    
ง. Inner Glow 
47.  คําส่ังใดท่ีใชใสสีเสนใหกับขอความ
ท่ี  Selection 
ก. Edit -> Stroke               
ข. File ->  Stroke 
ค. Edit -> Line      
ง. File -> Line 
48. Color  Overlay  คืออะไร 
ก. การแตงสี 
ข. การพนสี 
ค. การเติมสีใหวัตถุ 
ง. ถูกทุกขอ 
49. Gradient  Overlay  คืออะไร 
ก.การเติมสีแบบไลเฉดสีใหกับวัตถุ 
ข.การเติมตัวอักษร 
ค.การเปล่ียนภาพ 
ง.การเทสีของพื้นหลัง 
 
 

50.Pattern  Overlay  คืออะไร 
ก.การเติมรูปภาพ 
ข.การเติมลวดลายใหกับวัตถุ 
ค.การแปลงรูปภาพ 
ง.การสรางภาพใหดูสวยงาม 
51.  ตัวเลือกใดท่ีใชกําหนดขนาดของหัวพูกัน 
ก. Brush  Size       
ข. Master  Diameter 
ค. Size                      
ง. Edit  Size 
52.  Auto  Eraser  ในออปชันบารของ
เครื่องมือ  Pencil  มีหนาท่ีอะไร 
ก. ใชลบสวนท่ีไมตองการออก 
ข. การลบแบบอัตโนมัติ 
ค. การเปล่ียนจากการวาดดวยดินสอเปนการลบ
โดยครั้งแรกจะเปนสี  Foreground  ตอไปจะ
สลับเปนสี Background  เพื่อใชลบ 
ง. การเปล่ียนจากการวาดดวยดินสอเปนการลบ
โดยครั้งแรกจะเปนสี  Background  ตอไปจะ
สลับเปนสี Foreground  เพื่อใชลบ 
53.  การสรางหัวพูกันใชคําส่ังใด 
ก. Edit -> Define  Brush    
ข. File -> Define Brush 
ค. Edit -> Create Brush  
ง. File -> Create Brush 
54.  เครื่องมือใดท่ีใชสรางรูปดาว 
ก. Rectangle Tool              
ข. Ellipse Tool 
ค. Polygon  Tool                           
ง. Custom  Tool 
55.  เครื่องมือใดในกลุม  Shape  Tool  ไมใช
สรางรูปทรงเลขาคณิต 
ก. Rectangle  Tool                            
ข. Ellipse  Tool 
ค. Polygon  Tool 
ง. Custom  Tool 
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56.  เครื่องมือใดใชสรางเปนเสน  Path 
ก. Pen Tool                              
ข. Freeform  Pen 
ค. Add  Anchor  Point 
ง. Convert  Point 
57.  ขอใดความหมายของแองเคอร 
ก. เสนทางท่ีลากเพื่อสรางรูปทรง 
ข. จุดยอยท่ีอยูตามแนวเสน  Path 
ค. จุดส่ีเหล่ียมลอมรูปภาพ     
ง. แขนและขาของรูปภาพ 
58.  เครื่องมือใดท่ีใชแปลงรูปแบบของเสนและ
มุมของเสน Path 
ก. Pen  Tool                  
ข. Freeform Pen 
ค. Convert  Point                             
ง. Convert Point 
59.  การเคล่ือนยายเสน  Path  ใชเครื่องมือใด 
ก. Move  Tool                         
ข. Move  Path  Tool 
ค. Move  Selection  Path  Tool           
ง. Path  Selection  Tool 
60.  รูปแบบการไลสีของเครื่องมือ  Gradient  มี
กี่รูปแบบ 
ก. 3  รูปแบบ                
ข. 4 รูปแบบ 
ค. 5  รูปแบบ                   
ง.  6 รูปแบบ 
61.  ขอใดคือหนาท่ีของ
เครื่องมือ  Healing  Brush 
ก. แกไขจุดบกพรองของภาพ 
ข. ใชคัดลอกภาพ 
ค. ใชตัดภาพสวนท่ีตองการนําไปปดสวนท่ีไม
ตองการ 
ง. ใชลบสวนท่ีไมตองการออกจากภาพ 
 

62. ตัวเลือก  Sampled  ในออปชันบารของ
เครื่องมือ  Healing  Brush  มีหนาท่ีใด 
ก. เลือกสีตนแบบจาก  Foreground 
ข. เลือกสีตนแบบจากสวนท่ีเลือกจากรูปภาพ 
ค. กําหนดใหสี  Foreground  ผสมกับสีภาพท่ี
เลือก 
ง. ทดลองใชสีท่ีเลือก 
63. การเลือกพื้นท่ีเพื่อปรับแตงหรือแกไขจะตอง
กดปุมใดท่ีคียบอรด 
ก. Ctrl      
ข. Shift 
ค.  Alt     
ง. Tab 
64.  ขอใดคือลักษณะการทํางานของ
เครื่องมือ  Patch 
ก. การคัดลอกสวนท่ีตองการ 
ข. การคัดลอกสวนท่ีตองการอยางเปนธรรมชาติ 
ค. การ Selection  พื้นท่ีท่ีตองการปรับเปล่ียน 
ง. ถูกทุกขอ 
65.  ขอใดคือหนาท่ีของเครื่องมือ  Clone 
Stamp 
ก. ใชตัดภาพ  
ข. ใชคัดลอกดวยคําส่ัง Copy 
ค. ใชสรางสําเนาภาพแบบรวดเร็ว 
ง. ใชคัดลอกภาพ 
66.  ตัวเลือก  Flow  ในออปชันบารมีหนาท่ีใด 
ก. กําหนดความเร็วในการระบาย             
ข. กําหนดความแรงในการระบาย 
ค. กําหนดการกระจายของสี                   
ง. กําหนดลําดับการระบายสี 
67.  เครื่องมือใดใชปรับภาพใหคมชัดข้ึน 
ก. Patch                           
ข. Healing Brush 
ค. Sharpen                       
ง. Shadow 
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68. เครื่องมือ History Brush  มีหนาท่ีคลายกับ
คําส่ังใด 
ก. Redo          
ข. Undo 
ค. Step Backward  
ง. Step Forward 
69.  เครื่องมือ Art  History  Brush  มีหนาท่ีใด 
ก. สรางหัวแปรงแบบศิลป 
ข. ยอนการทํางานกลับไปแรกเริ่ม 
ค. ระบายแบบสีน้ํา       
ง. ระบายสีภาพแบบพูกัน 
70.  คําส่ังใดสรางภาพแบบสะทอนจากน้ํา 
ก. Reflection  
ข. Turbulence 
ค. Warp Tool 
ง. Shift Pixels 

******************** 
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ประวัติผูวิจัย 
 

หัวหนาโครงการ 

1.  ช่ือ-นามสกุล (ภาษาไทย)     นางสาวอัมภาภรณ  พีรวณิชกุล 

2.  รหัสประจําตัวประชาชน      3 1002 0059 732 2 

3.  ตําแหนงปจจุบัน  ผูชวยคณบดีคณะครุศาสตรอุตสาหกรรม 

4.  หนวยงานท่ีอยูท่ีติดตอไดสะดวก พรอมโทรศัพท โทรสาร และ E-mail 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร  วิทยาเขตเทเวศร   
399  ถนนสามเสน   แขวงวัชระ    เขตดุสิต กรุงเทพมหานคร  10300       
โทร. 02 6285203 ตอ 6153   โทรสาร 02 628-5201 
E-mail :  umpaporn.p@rmutp.ac.th  

5. ประวัติการศึกษา 
ปริญญาโท จากสถาบันเทคโนโลยีพระจอมเกลาธนบุรี คณะครุศาสตรอุตสาหกรรม       

สาขาวิชา  คอมพิวเตอรและเทคโนโลยีสารสนเทศ 
ปริญญาตรี จากสถาบันเทคโนโลยีราชมงคล วิทยาเขตเทเวศร คณะวิศวกรรมศาสตร       

สาขาวิชา  วิศวกรรมไฟฟาคอมพิวเตอร 

6. สาขาวิชาการท่ีมีความชํานาญพิเศษ (แตกตางจากวุฒิการศึกษา) ระบุสาขาวิชาการ 
คอมพิวเตอร การศึกษา และการบริหารจัดการ 

7. ประสบการณท่ีเก่ียวของกับการบริหารงานวิจัย  
 7.1 หัวหนาโครงการวิจัย : การพัฒนาประสบการณตรงเกี่ยวกับการเขียนโปรแกรม
คอมพิวเตอรจากงานจริง งบประมาณผลประโยชนของคณะ ประจําป 2551  
 การพัฒนาทักษะเกี่ยวกับการสอนวิชาชีพชางอุตสาหกรรมดานไฟฟา งบประมาณ
ผลประโยชนของคณะ ประจําป 2551 

  7.2  งานวิจัยท่ีทําเสร็จแลว : การพัฒนาประสบการณตรงเกี่ยวกับการเขียนโปรแกรม
คอมพิวเตอรจากงานจริง งบประมาณผลประโยชนของสถาบัน ประจําป 2551 
  การพัฒนาทักษะเกี่ยวกับการสอนวิชาชีพชางอุตสาหกรรมดานไฟฟา งบประมาณ
ผลประโยชนของคณะ ประจําป 2551 
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